
SB+
Server®

A 4GL Tool Set for Rapid Application
Development and Guitization

Administration Manual





All rights to this publication are reserved. No part of this document may be reproduced, transmitted, tran-
scribed, stored in a retrieval system, or translated into any language, in any form or by any means, without prior 
written permission from Ardent Software, Inc. If you are a licensed user of this product, Ardent Software, Inc. 
grants you a limited, nontransferable license to reproduce this particular document. This is limited to photo-
copy reproduction of a Ardent Software-supplied master copy. Copies must include all pages contained in the 
master copy (including this page) and must be intended strictly for internal distribution and use by the licensee, 
its employees, and assigns. Reproduced copies may not be transferred, in whole or in part, to any party outside 
the licensee’s place(s) of business. The software described in this document is furnished under a license agree-
ment. The software may be used or copied only in accordance with the terms of the agreement. It is against the 
law to copy this software on magnetic tape, disk, or any other medium for any purpose other than the licensee's 
personal use.

Copyright © 2000 Ardent Software, Inc.
All Rights Reserved
SB+ Server Release 5
Documentation DSB-5003
Rev. 02072000

Ardent Software, Inc., reserves the right to make changes to this document and the software described herein at 
any time and without notice. Ardent Software, Inc. makes no warranty, express or implied, other than those 
contained in the terms and conditions of sale, and in no case is Ardent Software, Inc. liable for more than the 
license fee or purchase price of this product. 

Ardent Software, Inc.
50 Washington Street

Westboro, Massachusetts USA 01581-1021
Telephone: (508) 366-3888
Facsimile: (508) 366-3669

World Wide Web: www.ardentsoftware.com

Principal Technical Writer
Tony Watkin

Contributors and Technical Reviewers
Tim Berry, Mario Delas, Ken Lin, John McPharlin, Mark Shannon

Ardent Software is a trademark of Ardent Software Inc. uniVerse, UniData, SB+, SBOPEN, SBClient, DATA/C++, TERMULATOR, 

SBDesktop, ObjectCall, EasyX, DataStage, ESL, UniVerse Call Interface, UniVerse Objects, uV/Net, RetrieVe, PI/open and Prime 

INFORMATION are trademarks of Ardent Software, Inc. TERMiTE is a trademark of Pixel Innovations, Ltd. Pick is a registered trade-

mark of Pick Systems. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation in the United States 

and or other countries. UNIX is a registered trademark in the United States and other countries, licensed through X/Open Company. All 

other products, standards, or company names mentioned may be trademarks or registered trademarks of their respective owners.





Contents
Chapter 1 - Getting Started ...........................................................13

Logging On For the First Time .................................................................14

Creating a User Account ...........................................................................21

The System Administration Account ........................................................25

Logging On and Off ..................................................................................27

Navigation .................................................................................................28

Help ...........................................................................................................35

Using a Mouse ..........................................................................................46

Chapter 2 - Backup Menu ..............................................................51

Introduction ...............................................................................................51

Select Media .............................................................................................54

Backup Account(s) ...................................................................................58

Backup All Accounts ................................................................................60

Backup Unix File(s) ..................................................................................62

Restore Account(s) ...................................................................................63

Verify Backup OK ....................................................................................66

Detach Media ............................................................................................67
SB+ Server Administration Manual 5



Contents
Format Diskette .........................................................................................68

Power Down System .................................................................................69

Reboot System ..........................................................................................71

Logto DOS ................................................................................................73

Chapter 3 - Security Menu.............................................................75

Introduction ...............................................................................................75

Define User Macro Keys F6 ...................................................................102

Initialize Users Password ........................................................................104

List Users Logged On .............................................................................105

Security Reports ......................................................................................106

Inhibit Logons .........................................................................................109

Enable Logons Again ..............................................................................111

Chapter 4 - Admin Menu..............................................................113

Introduction .............................................................................................113

Files .........................................................................................................115

Printers & Terminals ...............................................................................159

Media Commands ...................................................................................223

SB+ Setup ...............................................................................................233

System House Keeping ...........................................................................283

Accounts .................................................................................................297

Chapter 5 - Office Menu...............................................................305

Introduction .............................................................................................305

Diary .......................................................................................................307
6 SB+ Server Administration Manual



Contents
Chapter 6 - Shell & Logto Options..............................................339

Introduction .............................................................................................339

Shell ........................................................................................................340

Logto .......................................................................................................342

Appendix A - Admin Within a User Account .............................343

Appendix B - Printer Management .............................................349

SB+ Server Printer Management ............................................................350

Printer Entity ...........................................................................................351

Print Manager .........................................................................................352

PRINTER.SELECT and AUX.SELECT Forms .....................................353

Printer Definition and Maintenance ........................................................354

Auxiliary Printing ...................................................................................371

Auxiliary Print Interface Improvements .................................................381

Appendix C - Printer Management for uniVerse........................383

Appendix D - Printer Management for UniData .........................413

Physical Printer Definition ......................................................................415
SB+ Server Administration Manual 7



Contents
8 SB+ Server Administration Manual



Preface
Introduction to Ardent Product Documentation
This preface contains useful information about Ardent’s conventions for documenting command 
syntax and system output, as well as providing explanations of the specially designed icons that 
indicate important notes, tips, and warnings in the documentation.

Note
This manual uses both the term SB+ and SB+ Server interchangeably with SB+ being the abbrevi-
ated expression.

Features of Ardent Manuals
Ardent strives to produce useful, high quality documentation while maintaining a consistent look 
and feel. It will help you to know the following conventions which are common to this and all 
Ardent manuals. This section explains the following:

• conventions

• elements of syntax statements

• notes, warnings, and tips

• screen captures
SB+ Server Administration Manual 9



   
Operating System

Conventions

All Ardent manuals depict command syntax according to industry standards. The following table 
lists the syntax conventions:

Convention Description

bold courier font Bold courier font indicates required commands that you must enter in 
the manner shown. You must enter all punctuation marks that appear in 
bold, unless otherwise indicated.

courier font Courier font indicates system output, such as prompt signs, responses 
to commands, and program code. Courier font is also used to depict 
paths to directories or files.

bold Bold font indicates the name of an element on the screen, such as a 
menu, a form, or a prompt. Also indicates the names of files or directo-
ries.

lower case italics Lower case italics is used for syntactical expression of user-supplied 
words, variables, and expressions

xx Italic lower-case xx indicates a placeholder for a system id. For exam-
ple, xxCONTROL.

> The > character separates each option in a menu hierarchy. For exam-
ple, “choose Setup > Miscellaneous”, means choose the Setup menu 
then the Miscellaneous option.

[ ] Square brackets indicate an item that is optional. You may include a 
number of items enclosed in brackets in a Unidata command or func-
tion.

{ } Braces indicate that you must choose one of the items separated by the 
vertical bar ( | ).

Conventions
10 SB+ Server Administration Manual



Elements of Syntax Statements
SB+ Server has many commands that you enter as part of paragraphs. The syntax statement 
includes the command name, required arguments, and options that you can use with the command. 
Italics represents a variable that you can replace with any valid option. The following figure illus-
trates the elements of a syntax statement:

Important Notes, Warnings, and Tips
You will notice several different icons throughout this manual. These icons draw attention to 
important information about the product.

Note
A Note icon indicates important additional information on the subject.

| Vertical bar separates option arguments from which you may choose.

. . . An ellipsis (...) after an argument indicates that you may use more than 
one argument on a single command line.

Convention Description

Conventions (continued)

COMMAND required [option] [option1 | option2]
{option1 | option2} required... "string" 

command names

no brackets or braces
indicates a required
argument

square brackets indicate
an optional argument

a vertical line indicates that
you may choose between
the given arguments

braces indicate that you
must choose between
the given arguments

an ellipsis indicates that
you may enter more than
one argument

quotation marks

appear in boldface

must enclose a
literal string
SB+ Server Administration Manual 11



   
Warning
A Warning icon alerts you to the danger of deleting or corrupting data.

Reminder
A Reminder icon marks information that is discussed in detail in another chapter or another 
Ardent manual.

Tip
A Tip icon denotes shortcuts, commands, or procedures that may help you use Ardent products 
more efficiently.
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Chapter 1 - Getting 
Started
This chapter shows you how to get started using SB+. It contains the following sections:

Logging On For The First Time describes the steps you need to take to log onto SB+ for the first time, 
including licensing SB+ for your site.

Creating a User Account shows you how to set up an SB+ user account, where applications may be 
developed.

The System Administration Account describes the system administration account which contains addi-
tional options to those available in a user account.

Logging On and Off shows you how to log onto and log off from SB+.

Navigation shows you how to find your way around the SB+ development environment. 

Help describes the various types of help provided by SB+.

Text Editor shows you how to use the SB+ full-screen text editor.

Using a Mouse describes the use of a mouse. 
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Logging On For the First Time

When you have installed SB+ for the first time, you will need to log into the system administration 
account (SB+, SB or SBPLUS depending on the platform you have installed SB+ on) so that your 
copy of SB+ may be configured for use. Refer to the documentation you received with the supplied 
media for installation instructions.

To log onto SB+ for the first time
1. Log to the SB+ administration account (SB+, SB or SBPLUS). The Logon screen is dis-

played, and you are prompted for a user id: Please Enter User Id:

2. Enter the user id SB. SB is the default user id supplied with SB+ to allow you into the system. 
It has no security restrictions initially; however, this may be modified later. You are prompted 
for a password for user SB: Please Enter Password:

3. Since there is no password initially defined for the user SB, press the Enter key. You are 
prompted for the identity of the type of terminal you are using so that information displayed on 
it is formatted correctly and function keys are correctly identified:

4. Terminal id (or ∗ for list) (DEFAULT.TERM)

5. Press ∗ to display a list of all terminal types recognized by SB+. If the desired terminal type is 
not in the displayed part of the list, press ∗ and Enter to continue the list until the desired ter-
minal type is found.

6. Enter the name from the list that matches your terminal (or the terminal it is emulating), in full. 
For instance: W60.PCKEY

If you cannot find a suitable definition, press the Enter key to accept the default terminal shown in 
brackets. The default terminal in a new installation, DEFAULT.TERM is a minimal definition com-
patible with most terminal types. With this definition you may simulate function keys by pressing 
Ctrl + F n, where n is the number of the key required.

If you are unsure of the type of terminal you have or you have problems with what appears to be 
the correct terminal type, then talk to your Systems Administrator or refer to your terminal refer-
ence manual.

Once you have successfully logged in, the License Details Entry screen is displayed. 
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Logging On For the First Time
License Details Entry Screen

The License Details Entry screen allows you to enter details required for licensing SB+ on the 
current hardware. This licence is not transferable to another machine without relicensing. 

A description of each prompt follows. Prompts marked with an asterisk are used in generating your 
licence number, so ensure you enter the correct information for these. If you make a mistake on 
any field, press the Esc key to go back a field. Press the ? key to get help on a field. 
SB+ Server Administration Manual 15



Chapter 1 - Getting Started  
Prompts

Company/User Name

The name of the company or individual to be licensed to use SB+. This name is displayed on log-
ging into SB+, in various SB+ Office Automation and Tools reports, and is used as a default com-
pany name for new applications.

Postal Address Line 1, 2 & 3

The full postal address of your organization.

Post/Zip Code

The postal code or zip code.

Contact Title, First Name & Surname

Normally the person whom the SB+ distributor would contact in your organization.

Telephone Number: Area & Number

The area code and telephone number of the above person. Include extension numbers where appli-
cable.

*SB+ Serial Number

The SB+ serial number supplied with your SB+ documentation.

American/International

Sets the date format to either A for American (mm/dd/yy) or I for International (dd/mm/yy). (This 
prompt only appears on the License Details Entry screen).

*SB+ Runtime Code

The SB+ runtime code supplied with your copy of SB+ (if you have purchased a runtime-only 
copy of SB+). Enter NONE if you have purchased a development licence.

Hardware Manufacturer

The type of hardware SB+ is being installed on. Eg IBM PC.
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Logging On For the First Time
Model Number

The model number of the hardware. Eg RS6000, 486/50.

Computer Serial #

The serial number of the hardware.

Operating Environment

The OE type. Eg UniData, uniVerse.

O/E Release

The release number of the OE.

Dealer Name

The name of your SB+ distributor.

Upgrade (Y/N)

Enter N if this is a new installation of SB+. Enter Y if this is an upgrade to an existing SB+ site.

Product Description

The descriptions of the various System Builder products you may have a licence for. (Display 
only).

*Users

The number of users licensed to use each of the listed products displayed at the previous prompt, 
as stated on your Licence Agreement.

Media Type

The media type. Eg CD.

Media Density

The media density.
SB+ Server Administration Manual 17
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Completing Your License

When you have entered your details at the prompts, check them carefully. If they are correct, select 
the Accept option at the prompt displayed at the bottom of the screen. If not, select the Change 
option, modify the entries you wish to change, and select Accept. This saves the licence details and 
displays the following message:

Press the Enter key to print the licence letter. After checking that it is correct, sign the printed copy 
and post or fax it, together with the signed licence agreement, to your SB+ distributor, who will 
then supply you with a license number authorizing SB+ for the described configuration. You need 
not do this immediately, but you must enter the licence number within 31 days of installation, oth-
erwise SB+ will become inoperative. Any details you have entered will be preserved until the 
licence is correctly re-entered.

Until a license number is entered, SB+ displays a screen when you log on which shows the number 
of days remaining before the temporary license expires.

From this screen you may press:

A to accept this message and continue the SB+ login process.

D to redisplay your license details.

L to enter your license number when it is received. Once you have entered your license num-
ber, SB+ will be correctly licensed for that machine.

P to reprint your licence details. 
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Logging On For the First Time
When you have completed the licensing procedure, the SB+ System Administration main menu is 
displayed:

It is recommended that you make backups of the SB+ and SB+.DEFN accounts as soon as possible 
(See “Chapter 2 - Backup Menu”. You should backup the SB+ account on a regular basis, as it 
contains important user and system data.
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To change your licence details, enter /LICENCE.AMEND to invoke the LICENCE.AMEND process (the 
/ character allows you to enter a process at most prompts or menus). This displays the Amend 
Licence Details screen:

The prompts on this screen are the same as those on the Licence Details Entry screen (apart from 
American/International).

Note
If you modify license details, you must reprint the details and send them to your SB+ distributor 
who will update your license number if necessary. 
20 SB+ Server Administration Manual



Creating a User Account
Creating a User Account

This section describes the creation of an SB+ user account. The account created is a full SB+ 
development environment, and will contain one or more systems. Each system is a separate entity, 
with its own control parameters and standard files.

Note
This option is not available with runtime (i.e. non-development) licenses.

To create an SB+ user account (Unix Only)
1. Select Admin from the main menu (press the A key or use the arrow keys) to display the 

Admin submenu.

2. Select Accounts to display the Accounts submenu.

3. Select Create An Account to display the Create An Account screen:

The account name and system ids you choose should reflect the purpose for which the account and 
its systems are used.
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4. Complete these details and accept them using the F2 key. The account and systems are created 
and you are prompted for your user id, password and terminal type (if these are not specified 
for your port in Admin > Printers & Terminals > Printer Management > Port Configure).

5. Enter your user id, password and terminal type. The default user account main menu 
(SBMENU) is now displayed:

Each system has its own copy of the default menu, which you may modify (to suit the application 
being developed) using the Tools > Menu Definitions tool. See your SB+ Server Reference Man-
ual for a full discussion of the SB+ development environment.

To create an SB+ account (UniData on NT)
1. Create a directory where you wish the account to reside.

2. Execute newacct from the DOS shell to make it a UniData account.

3. Use the Update Account option in the SB+ Admin account to convert the account for use by 
SB+ Server.
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Creating a User Account
To create an SB+ account (uniVerse on NT)
1. Create a uniVerse account using UV Admin.

2. Use the Update Account option in the SB+ Admin account to conver the account for use by 
SB+ Server.

Note
If the Create Account option is unavailable on either UniData or uniVerse, SB+ can be activated in 
a non-SB+ account by creating a VOC pointer to the DM file (in the SB+.DEFN account) and then 
running the SB.INITIATE program.

Default User Account Main Menu Options

Tools

This displays a menu of tools for creating and maintaining applications. Tools is the primary menu 
used by an application developer, and is described in your SB+ Reference Manual.

Note
These tools are not available in a runtime-only environment.

Runtime

This provides a skeleton menu which a developer may use as a basis for an application structure. 
The menu may be amended as required.

Admin

This provides a menu of account administration options. The Admin menu in a user account ( 

See “Appendix A - Admin Within a User Account”) is similar to that in the system administration 
account. 
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Office

This provides a menu of standard office automation facilities.

Shell

This invokes the SB+ shell command line. User access to the shell may be controlled by the Sys-
tems Administrator.

Logto

This provides an option to log to another account, or to log off.
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The System Administration Account
The System Administration Account

SB+ provides a system administration account (called SB+, SB or SBPLUS, depending on plat-
form) specifically for the use of system administrators. This account would not normally be avail-
able in a runtime-only version of SB+. A subset of the options provided by the system 
administration account are available in the default development account environment. 
See “Appendix A - Admin Within a User Account” for details of the options available in user 
accounts.

The options on the system administration account main menu are as follows (these are described in 
detail in the remaining chapters of this manual):

System Administration Account Main Menu 
Options
These are described in detail in the remaining chapters of this manual and are summarized below.

Backup

This allows you to backup and restore accounts, and to control media. On some platforms addi-
tional system management commands are provided.

Note
This menu option is not available on Windows NT based installations.

Security

This allows you to define users and groups of users. 

Admin

This provides an interface to the OE. Users can perform many of the more common administrative 
options without accessing the OE.
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Note
This menu option is not available on Windows NT based installations.

Shell

This invokes the SB+ shell command line prompt, allowing you to enter any OE command or SB+ 
process (subject to security restrictions).

Logto

This allows you to log into other accounts without having to re-enter your user id and password for 
each account accessed.
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Logging On and Off
Logging On and Off

In order to access SB+ you must have a unique user id and password. 

Your user id (for instance JS) is associated with a user group (for instance, CLERKS). This user 
group determines your level of access within the SB+ environment and to SB+ applications. Your 
password is associated with your user id, and you must enter both correctly to gain access to SB+. 
You are responsible for your own password.

To Log Onto SB+
1. Enter an SB+ account name at the Log On prompt.

2. Enter your user id and your password. 

If your user id and password are valid you are accepted into the SB+ environment. The main menu 
(or process defined for you) is then displayed. If your user id or password is invalid, an error mes-
sage appears and you are prompted to enter your user id and password again. If you do not enter a 
valid user id and password after three attempts, you are logged off. (Instead of entering your user 
id and password, you may enter HELP to display SB+ help). 

To log Off
You may use any of the following methods to log off from SB+:

• choose the Logto option from the main menu (if available), and enter OFF.

• choose the Shell option from the main menu (if available), and enter OFF at the shell com-
mand line.

• enter /OFF anywhere that accepts process calls. Ensure you first save (using the F2 key) 
any unsaved data in input screens or tools, otherwise the data is lost.

• press the Esc key repeatedly to move back through the menu hierarchy. Pressing Esc from 
the main menu (the first menu displayed when you logged on), displays the Logon screen. 
Pressing Esc here logs you off.
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Navigation

Menus
You may use any of the following methods to choose a menu option:

• type the highlighted letter of the option.

• move the selection highlight bar, using the up arrow key and down arrow keys (or Page 
Down and Page Up keys, where applicable) to the required option and press Enter or Spa-
cebar.

• click on the option if you are using a mouse.

To exit a menu, press Esc key. This returns you to the previous menu or, if you are at the main 
menu, to the SB+ Logon screen. Pressing the Esc key at this screen logs you off.

Entering 0 (zero) at any menu takes you (depending on your security level) to a command line 
shell. This is either the OE shell or SB+ shell (also depends on your security level).

Screens
Screens are made up of input fields and prompts (a prompt being a label for a field). Generally in 
this manual we refer to entering data at a prompt rather than into a field. 

When you are prompted for input, enter the required response or press the Enter key to accept the 
displayed default value. Edit your input using the edit keys defined for your terminal. Use upper-
case characters for process names etc. You may use lowercase for straight text (descriptions for 
instance).

The following edit keys cause the contents of a field to be accepted (after any validation) before the 
edit key itself is processed:

• function keys other than the F1 key and the defined intuitive help key

• up arrow or down arrow keys

• Tab key or Shift key – Tab key

• a mouse event 
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For example, pressing the F2 key after entering text acts as if the Enter key was pressed to accept 
the field, and then the F2 key was pressed. 

Screen Navigation Keys
Use the following keys to navigate through a screen (you may customize these keys in your termi-
nal definition):

Esc

The action of the Esc key depends on the edit key movement mode set at the Admin > SB+ Setup 
> SB+ Control Parameters > CUA Arrow Movement prompt. This prompt may be set to either:

Y The Common User Access (CUA) standard. Esc clears the current screen and returns the 
cursor to the key field. If there is no key field on the screen, or the key field is currently 
empty, the screen is exited. The up arrow key takes you back one input step. 

N The default SB+ action. The Esc key takes you back one input step.

Up/Down Keys

These move the cursor to the next or previous prompts. The top-of-text and bottom-of-text keys 
(defined for your terminal) move the cursor directly to the first or last prompt on the screen. 

/ Allows you to call a process (if permitted by your security level). Eg /WHO. (/ must be 
the first character entered into the field). If the process is a number, it is treated as a 
jump within the current screen.

/n Moves the cursor directly to field n (in the tab order specified for the screen) where n 
is the number of that field on the screen. (See "Screen Definitions" in the SB+ Server 
Reference Manual for more information). Eg /5 moves the cursor to the fifth field in 
tab order in the current screen. (/ must be the first character entered into the field).

/n.m Moves the cursor directly to a value m within a multivalued field n on a screen. Eg /5.7 
moves the cursor to the seventh value in the fifth field in tab order in the current 
screen, with the cursor positioned in the controlling multivalued field. (/ must be the 
first character entered into the field).
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Note
\ Clears a field (makes it null). You may also use the Delete key repeatedly, or the clear-to-end-of-
line key (defined for your terminal). (\ must be the first character entered into the field).

You may move the cursor to a value within the current multivalued field without knowing the field 
number. Instead of specifying a field number for n, use 0 (zero). Eg /0.999 jumps to the last value 
plus one in the window, with the cursor positioned in the controlling multivalued field. /0.5 jumps 
to the fifth value in the current multivalued field, with the cursor positioned in the controlling mul-
tivalued field.

Keyboard Problems

If your keyboard does not function as expected (eg edit keys or function keys do not perform as 
required) then either:

• your terminal has lost its internal setup and needs to be reinitialized. Turning the terminal 
off and on is usually sufficient if the current setup has been saved as the default power-on 
configuration.

• the SB+ terminal definition for your port does not match the device actually connected, or 
the definition is incorrect.

A list of predefined terminal types is provided by SB+, and these should work in most cases. You 
may copy and modify one of the existing terminal definitions if you need to customize keys for 
your terminal or terminal emulation, or you may create your own.

See “Terminal Definitions Screen 1” on page 193 for information on setting up or modifying SB+ 
terminal definitions.

/KEYS displays the list of current edit keys. The keys displayed depend on the terminal definition 
currently in use for the terminal. Use the Page Up and Page Down keys defined for your terminal 
to view the whole list.

Screen Display

In character mode, SB+ uses a screen stacking system for screen display and refresh. When a pro-
cess is invoked that displays a screen or menu overlaying the previous screen, the previous screen 
is saved onto a stack before the new screen or menu is displayed. On return from the process that 
displayed the new screen or menu, the previous screen is restored from the stack and redisplayed.
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Note
Because of memory constraints on some systems, the number of levels of stacking may be limited.

There are three screen refresh modes:

• Refresh the original screen. Redraws only the screen stacked prior to the current screen.

• Full screen refresh. Redraws all saved screens in the order they were stacked.

• Smart refresh. Saves and restores only that part of the original screen that was overlaid by 
the current screen.

The screen refresh mode is defined in a user’s security definition, or via the /USER.FLAGS process. 
(see “Full Refresh Of Screen” on page 99).

Function Keys

SB+ makes extensive use of the function keys available on most terminals. Function keys are usu-
ally assigned the most frequently used functions, such as saving a record, deleting a record, getting 
help, and invoking related processes. Function keys available for a particular screen are displayed 
on the function key status line for that screen.

SB+ Function Key Default Configuration

F1 The F1 key displays textual help related to the current input prompt. The F1 key may 
not appear on the status line, but it is always available. See Help later in this chapter.

F2 In general, pressing the F2 key accepts the current data in the screen and exits the 
screen. In most cases, the data is saved; however, some screens do not physically save 
data on disk, but return the data to the calling process.

You may use the F2 key to accept a screen at any time, but only if you have completed 
all mandatory fields. If you press the F2 key and a mandatory field has not been com-
pleted, the cursor is positioned at each uncompleted field in turn, where you are 
prompted for input.

The availability of the F2 key is indicated on the status line of the screen. If F2 does 
not appear on the status line it may not be available.
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F3 This calls intuitive help, if available for the current prompt. Intuitive help provides 
intelligent assistance in completing screen prompts. The F3 key may not appear on the 
status line. Its availability may be indicated in F1 textual help by the appearance of (F3) 
at the end of the help message. See Help later in this chapter.

Note
The key that invokes intuitive help is defined in the terminal definition. The default is the F3 key. 
All subsequent references to the F3 key in this guide and within F1 textual help refer to the intui-
tive help key. You may, however, define a different key (not necessarily a function key) to invoke 
intuitive help.

F4 This deletes records. You are usually prompted to confirm deletions, but may not be in 
a user application. If F4 does not appear on the status line it is not available.

F10 This displays the action bar, where available. The action bar shows additional com-
mands that may be invoked for a screen. You may access the action bar from most 
SB+ tools, and an action bar may be defined for any of your application screens. Func-
tion keys are available while the action bar is active.

Note
All other function keys and all action bar options are defined on a per-screen basis. See "Screen 
Definitions" in your SB+ Server Reference Manual for information on defining function keys and 
action bars in your input screens.

Process Calls

SB+ is built from, and is used to build, functional units called processes. A process performs a 
function of a predefined process type, with the specific action defined by the developer. A process 
may use data passed to it from other processes, and return data either to the calling process, or to 
another process called by the current process. See your SB+ Server Reference Manual for more 
details on processes.

In the SB+ environment you may call a process from any system prompt (including the SB+ shell 
prompt), menu or action bar defined for an input screen, by entering /processname, where process-
name is the name of a process. Eg /FD invokes the Field Definitions tool.
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Alternatively, entering / at a menu or action bar displays the Process Id prompt, where you may 
enter the name of the process (F3 is available here).

/T? displays a selection list of all processes supplied with SB+ (depending on security).

Escape Sequences

You may enter escape sequence characters either as the printable character (where the character is 
printable) or as the ASCII equivalent of the character (where the character is not printable), 
enclosed in parenthesis. Eg the following sequences both represent Esc A.

(27)A

(27)(65)

System Prompts and Messages

System Prompts

SB+ may prompt you for a choice of actions. For example when printing reports you are prompted 
for the destination of the output:

Output to Screen,Printer,AuX (S/P/X) S

A prompt may alternatively require a Yes or No answer:

Do you wish to Continue (Y/N) Y

In most cases a default value is supplied (S and Y in the examples above). The F1 textual help and 
F3 intuitive help keys are generally available if you require help in answering a prompt. A prompt 
may be in the form of a multi-option dialog box. In this case you select an option by moving the 
highlight cursor to the option using the Down arrow, Up arrow, Left arrow, Right arrow, Page 
Down and Page Up keys, or by pressing the highlighted letter for the option.

Error messages

SB+ validates your input wherever possible. If your input is invalid, an error message is displayed. 
Press the Enter key to clear the message and return to the prompt. Error messages are self explana-
tory and specific to the type of error encountered. They are displayed either on the prompt line, or 
as a dialog box with a Continue option.
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Note
Error messages that appear elsewhere on the screen, or in a different format from SB+ error mes-
sages (perhaps prefixed with a number), are probably being displayed by the underlying OE and 
not SB+. Refer to your OE documentation for a description of the error and the action to be taken.

Informative messages

SB+ displays informative messages indicating the current state of the system or of a process. Infor-
mative messages do not usually require you to do anything. Messages may be displayed on the 
prompt line, in a cleared space in the lower third of the screen, full screen or via a dialog box (in 
which case press the Enter key to proceed). 
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Help

SB+ provides two types of help:

• Textual

• Intuitive

Textual Help
Up to five levels of context-sensitive textual help are available using the F1 key.

Note
One or two levels of help are usually sufficient.
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Level 1

(Reminder) In character mode press the F1 key to display a short one or two line help message at 
the bottom of the screen:

In this example, the mouse cursor was over the Default Value prompt.

If additional textual help is available, it is indicated by <F1-More> at the end of the message. <F3> 
means that F3 intuitive help is also available for this prompt. The message remains on the screen 
until the current field data is accepted or the cursor is moved to another field.
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In GUI mode, SB+ Server uses the status line of the MinWin to display the first level help. How-
ever, if the status line is part of the form, the first level help will be displayed in ToolTip style while 
the mouse cursor is over the active field or the status line. Otherwise, SB+ Server will treat F1 help 
as if the ’Disable 1st level help’ user flag has been set to Y and when the F1 key is pressed for the 
first time, the level 2 help will be displayed.

Level 2

Press the F1 key again to display a window containing additional help (if available):

The help window remains on the screen until the current field data is accepted or the cursor is 
moved to another field.
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Level 3

Press the F1 key again to display a full page of help (if available):

The presence of more than one page of help text is indicated by the current page number and total 
page count in the bottom right corner. To print a page of help text press the P key and the Enter key.

Level 4

Press the F1 key again to display a help menu specific to the current screen:

Options on this menu display help on SB+ topics depending on context.
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Level 5

The General Help menu provides help on various general SB+ topics.
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Intuitive Help

Intuitive help provides you with intelligent and structured assistance when you are entering infor-
mation into a field. Intuitive help is available throughout the SB+ toolset, and may be included in 
applications developed using SB+ (See the SB+ Server Reference Manual for information on 
building intuitive help into your applications). An intuitive help process may be any valid SB+ pro-
cess, including user subroutines.

The availability of intuitive help is indicated by the text (F3) appearing in the F1 help message. 
Intuitive help is normally invoked using the F3 key; however, this key may be redefined for a par-
ticular terminal type (See “Terminal Definitions Screen 1” on page 193).

The example screen above shows intuitive help called from the Conversion prompt (selecting an 
appropriate conversion from the list of valid responses returns it to the Conversion field).
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Text Editor

SB+ provides a full screen, modeless text editor.

To invoke the editor, enter either:

• SE at the SB+ shell prompt (or the OE command line prompt, if accessed from a current 
SB+ session), or

• /SE (anywhere that accepts process calls)

SE uses a general subroutine, called SB.TEXT.EDITOR, which also provides modeless editing within 
multi-line text fields in SB+ input screens. The SB.TEXT.EDITOR subroutine may be called from 
user OE language subroutines to provide similar multi-line text field editing. See “Appendix F - 
General Subroutines” in your SB+ Server Reference Manual.

Editor Function Keys

F2 - Save

This saves the record currently in the editor window.
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F4 - Delete

This deletes the record currently in the editor window.

F5 - Block

This marks a block of text for moving, copying and deletion. You may only mark whole lines.

To mark a block, move the cursor to the line where the block starts and press the F5 key, then move 
the cursor to the line where the block ends, and press the F5 again. The block is now marked.

To move the marked block press the M key, or the Enter key (M is the default), and move the cur-
sor to the line where you wish the text to start. Press the F5 key. The block is moved to start at this 
line, before the line that was at the destination line number.

To copy the block, press the C key and move the cursor to the line where you wish the text to start. 
Press the F5 key. The block is copied to start at this line, before the line that was at the destination 
line number.To delete the block, press the D key. To unmark the block, press the Esc key.

F6 - Find

Find is a case-sensitive search & replace facility

To perform just a search, enter the required search string and press the Enter key at the Replace 
With prompt without entering text. The cursor is then positioned at the next instance of the string 
(if any). If the search string is not found, an error message is displayed. Press the Enter key to 
resume editing.

Note
Pressing the extend length key (defined for your terminal) will find the next occurrence of the 
search string, without the need to press the F6 key again.

To perform a perform a search and replace operation, enter the required search string and replace 
string. To confirm each replacement (this is advisable) enter Y at the Confirm prompt. To replace 
all occurrences without prompting, enter N. The Esc key exits replacement mode. If the search 
string is not found, an error message is displayed. Press the Enter key to resume editing.
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You may search for and/or replace text with real attribute-, value- and subvalue-marks (ie ASCII 
characters 254, 253 and 252), and replace text with a null string. Use the following at the Search 
String and Replace With prompts: @@AM (attribute-mark), @@VM (value-mark), @@SVM (sub-
value-mark) and @@NULL (null string).

F7 - Goto Line Number

Positions the cursor on a specified line.

F8 - Compile

Attempts to compile any text in the editor window, and catalogs the text record if no compile errors 
are found.

F9 - Process

This allows you to run a process from within the editor session. Enter the process name at the 
prompt. The default is SHELL.

F10 - Action Bar

Displays the action bar.

Line Nos

Toggles the display of line numbers on and off.

Merge

Displays the Merge Item screen, allowing you to merge a block of text from a specified file and 
record.

The prompts are:

File Name

This is the name of the file from which the record is to be read.
SB+ Server Administration Manual 43



Chapter 1 - Getting Started  
Item Id

The record from which the block is to be merged.

Start Line, End Line

The start and end line, comma delimited. Pressing the F3 key displays the record as a selection 
window. Select the required start line in the selection window. repeat for the end line.

Info

Displays the file and record name, the number of lines and the size of the file in bytes. Press the 
Enter or Esc key to close the display.

Print

This allows you to print the record or a block from the record to a system or auxiliary printer. Enter 
the block as startline, endline. The entire record is the default.

Skeleton

When writing a subroutine to work with SB+, the code should:

• be written as a subroutine

• use the SB+ COMMON block

• have certain equate statements

• have a documentation header

This option automatically loads a skeleton header (from DMCONT SKEL.SUB) that provides 
these basic requirements.

Note
The skeleton code is only loaded if the record is empty.

File

Saves the record without exiting you from the editor (F2 exits you from the editor).
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Tabs

Allows you to set the tab value after the initial tab. The default is 3 spaces.

Compress

Toggles between compressed display mode (usually 132 columns) and normal display mode (usu-
ally 80 columns). This is only valid if supported by the current terminal device.

Help

Displays the Help Options menu.
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Using a Mouse

This section covers the use of a mouse in SBClient in character emulation mode.

Note
SBClient in GUI mode is also mouse driven, but the behavior of the mouse is different, conform-
ing to Windows standards. In some cases the actions are similar. It is assumed that users of the 
GUI-based versions of SB+ Server are familiar with using a mouse.

Menus

Left-Button

Selects the option the pointer is positioned on (the cursor may be anywhere in the description text).
If the pointer is not positioned on a menu option, the currently highlighted option is selected. If the 
mouse is dragged (with button depressed) the menu highlight follows the pointer; the option high-
lighted when the button is finally released being the one selected.

Right-Button

Exits the menu.

Input Screens

Left-Button

If the pointer is anywhere within a field other than the field currently prompted for, input is trans-
ferred to that field (as with /n goto field). Clicking on either a controlling or dependent multivalued 
field activates that field. If the pointer is on position 1 in the current field, it invokes Enter. If it is 
not on position 1, it moves the cursor to the position that the pointer is on. If the pointer is on any 
function key or action bar description, it invokes that function.

Right-Button

Invokes intuitive help (F3) for the current field. The pointer may be anywhere on the screen.
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Screen/Report Definitions

Left-Button

Moves the cursor to the position of the pointer.

If the pointer is already at that position, it invokes Enter Field F5. Double-click to place a new field 
at a new position.

If the pointer is at the cursor and on the field, you may hold the left-button down and drag the cur-
sor to a new position. When you release the button the field is moved to that position.

In the Report Definition tool, if you drag the pointer outside the current display area, the next page 
in the direction of the mouse movement is displayed. Eg dragging the mouse to the right of the cur-
rent display area displays the next horizontal page.

If you place the pointer on any function key or action bar description, it invokes that function.

Right-Button

Invokes intuitive help, displays fields in a file for selection, or selects a report line type if it is on 
column 0 of a report definition.

Selection Window

Left-Button Within the Selection Window

Selects the option on which the pointer is placed. In a multi-select window, if the option is already 
selected, it is deselected. In a multi-select window you may hold the mouse button down and drag 
the pointer through all options to select or deselect. The action is determined by whether the option 
under the pointer was initially highlighted or tagged.

Left-Button Outside of the Selection Window or on the Window 
Border

If the pointer is positioned at the:

• top-left corner of the window border, the first page of selections is displayed with the high-
light on the first option.
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• bottom-right corner of the window, the last page of selections is displayed with the high-
light on the last option.

• left of center of the window, the previous page of selection options is displayed.

• right side and above the center depth of window, the previous page of selection options is 
displayed. If it is below this point the next page of selection options is displayed.

Right-Button

If pressed within the selection window it invokes Enter.

Running Report to Screen

Left-Button Below or on Highlighted Status/Prompt Line

Left of center of prompt, scrolls screen left.

Right of center of prompt, scrolls screen right.

Left-Button Above Status/Prompt Line

Above center of screen, scrolls back a report page.

Below center of screen, scrolls forward a report page.

Right-Button

Invokes Enter.

Defining Window Coordinates

Left-Button

First click is for top-left corner and second is for bottom-right corner. Alternatively, you may hold 
the button down at the top-left corner and drag the mouse to the bottom-right corner, then release.
48 SB+ Server Administration Manual



Using a Mouse
Right-Button

If amending existing coordinates, it moves the window to the pointer position. If there are no exist-
ing coordinates, it acts the same as the left-button.

Dialog Boxes

Left-Button

Selects response.

Right-Button

Selects response.

Calendar Lookup Box

Left-Button Within Calendar Days Display

Highlights the day, or the logical day of the previous or next month if the position is blank.

Double click to accept the date.

Left of month text, decrements date by one month.

Right of month text, advances date by one month.

Right side of year text, advances one year.

Left of year text, decrements one year.

If the pointer is on any function key description, it invokes that function.

Right-Button

Selects the highlighted day.
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Popup Calculator

Left-Button

Click on numbers or functions on the calculator to use them. If the pointer is placed on any func-
tion key description, it invokes that function 

Right-Button

Invokes Enter.

Screen Editor

Left-Button

Moves the cursor to the selected point. If the cursor is on any function key or action bar descrip-
tion, it invokes that function. Furthermore, if the mouse is clicked on INS/REP on the function key 
description, the insert/replace state is toggled.
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Menu
Introduction

The Backup menu provides options for saving (backing up) and restoring accounts onto media 
(diskette or tape) on a selected media device (tape or disk drive). Additional system management 
commands are provided for some platforms.

Note
This menu is not available on Windows NT based installations.
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Backing up your system ensures that your programs and data can be recovered in the event of data 
corruption or hardware failure. You should keep a series of backups, and rotate them on a periodic 
basis (for instance, daily, weekly, monthly and year-end), depending on the type and size of your 
environment and system. The more frequently you backup, the less time it will take you to recover 
from loss of data.

Backup Menu Options

Select Media

This allows you to specify the media to be used for the backup or restore.

Rewind Media UniData/uniVerse

This allows you rewind the selected media.

Backup Account(s)

This allows you to save nominated accounts to the selected media.

Backup Unix File(s) UniData/uniVerse

This allows you to save nominated accounts on a Unix system to the selected media.

Backup All Accounts - Pick

This allows you to save the entire contents of your system, including all accounts, data files and 
programs to the selected media.

Restore Account(s)

This allows you to restore accounts previously saved on the selected media.

Verify Backup OK

This checks data saved on the selected media for any data or media corruption. This is available on 
platforms where Tape Verify is supported.
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Detach Media

This detaches the selected media, making it available to other users.

Format Diskette - Pick

This formats a diskette so it may be used with SB+ (PC platforms).

Power Down System - Pick

Provides options allowing you to shut down the system in an orderly manner. You may enter 
countdown and warning messages.

Reboot System - Pick

Provides options allowing you to shut down and reboot the system (where supported).

Logto DOS - Pick

Allows you to broadcast warning messages to users logged on prior to shutting down and reboot-
ing the system into DOS. This only applies where DOS co-resides on the machine on which SB+ is 
installed. (PC platforms).
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Select Media

Select Media allows you to specify the media (diskette or tape) to be used for the backup or 
restore. You should run this prior to doing a backup or restore, to ensure the correct media is con-
nected. On some platforms, the backup and restore options prompt for a media selection if not 
already performed.

Note
Media options differ across different operating environments and hardware configurations.

Pick

Prompts

Std/High Diskette/Tape (S/H/T)

Options are:

S Standard density diskette.

H High density diskette.

T Tape drive.

Diskette Drive (A/B)

This is only applicable if a diskette is to be used. Options are:
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A selects drive A.

B selects drive B.

Block Size

The block size used when writing to the media. Leave null to accept the default for the media type. 
For some media types, the value in this field may not be changed.

Retension

This applies only to cartridge tapes. Options are:

Y retensions the tape. This reduces the likelihood of parity errors.

N does not retension the tape.

uniVerse

Prompts

Device Name

The name of a media device specified in the &DEVICE& file. Devices are defined in the Admin > 
Media Commands > Define Media Device screen. See “Media Commands” on page 223.

Device Description

The description of the media device as entered in the Define Media Device screen. (Display only).
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Block size

The block size in bytes of the media device as entered in the Define Media Device screen. (Dis-
play only).

Correct Device (Y/N)

Options are:

Y selects the media device specified at the Device Name prompt above.

N exits from this screen without selecting a media device.

UniData

Prompts

Device Number

The number of the media device defined in the Admin > Media Commands > Define Media 
Device screen. See “Media Commands” on page 223.

Device Description

The description of the media device as entered in the Define Media Device screen. (Display only).

Block Size

The block size in bytes of the media device as entered in the Define Media Device screen. (Dis-
play only).
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Operation Mode

The conversion method (ie EBCDIC, ASCII, swap bytes etc) as entered in the Define Media 
Device screen. (Display only).

Correct Device (Y/N)

Options are:

Y selects the media device specified at the Device Number prompt above.

N exits from this screen without selecting a media device.

Note
Both uniVerse and UniData have a Rewind Media option in the Backup menu.
SB+ Server Administration Manual 57



Chapter 2 - Backup Menu  
Backup Account(s)

Pick

This allows you to save one or several nominated accounts onto the selected media. A media must 
be selected prior to running the backup.

Function Key

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Account Names

The names of the accounts to be saved onto the selected media. Separate account names with 
spaces. Backups are done in the order in which the names are entered. 

Verify Backup With Dummy SEL-RESTORE (Y/N)

Options are:

Y verifies the backup of all saved accounts using a dummy SEL-RESTORE. The entire 
backup is reread, during which any recording errors are detected. 

N does not verify the backup.
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UniData and uniVerse

Function Key

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Account Names

The names of the accounts to be saved onto the selected media. Separate account names with 
spaces. The accounts are saved in the order in which the names are entered. 

Continue With Backup (Y/N)

Options are:

Y performs the backup. 

N exits this screen without backing up selected files.
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Backup All Accounts

Pick

This allows you to save the entire contents (accounts, data files and programs) of the system.

Function Key

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Enter start Time Of Save (00:00=Now)

The time to start the backup, in 24 hour format (ie hh:mm:ss). Press the Enter key to accept the 
default and start the save now. 

Log Off At Completion Of File Save (Y/N)

Options are:

Y logs off the port on completion of the file-save. 
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N does not log off the port on completion of the file-save.

Tape Label

A meaningful tape label. This label is stored in the header on the tape. 

List Files Saved to Screen or Printer (S/P)

Options are:

S echoes output from the file-save to the Screen. 

P dumps output from the file-save to the current default Printer.

Send Stat-File Report To Printer (Y/N)

The file-save generates a Stat-File (statistics file) report that may be dumped to the current default 
printer. Options are:

Y dumps the Stat-File report to the printer. 

N does not dump the Stat-File report to the printer.

T-Dump Stat-File To End Of Tape (Y/N)

The file-save generates a Stat-File (statistics file) report that may be T-dumped to the tape at the 
end of the file-save, from where it may be loaded if required for statistical or troubleshooting pur-
poses.

Options are:

Y T-dumps the Stat-File report to the tape. 

N does not T-dump the Stat-File report to the tape.

Verify Save With Dummy SEL-RESTORE (Y/N)

Options are:

Y verifies the backup of all saved accounts using a dummy SEL-RESTORE. The entire 
backup is reread, during which any recording errors are detected. 

N does not verify the backup.
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Backup Unix File(s)

uniVerse and UniData

This saves all files in the specified Unix directories. The command used to backup the files is that 
specified in the Admin > Media Commands > Define Media Device screen for the selected 
media. See “Media Commands” on page 223. 

Function Keys

F2 - Accept

This accepts the screen details and initiates the file-save process.

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Directory

The full pathnames to the directories you wish to back up. The first pathname should be preceded 
with a \ to prevent SB+ from treating the entered text as a process call.
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Restore Account(s)

This allows you to restore accounts from any backup. An account can be restored to a different 
name to that it was saved as. If the accounts being restored exist on the system, SB+ prompts for 
the deletion of these accounts before they are restored. On Unix platforms, the command used to 
restore the files is that specified in the Admin > Media Commands > Define Media Device 
screen for the selected media. See “Media Commands” on page 223. 

Pick

Function Keys

F2 - Accept

This accepts the screen details and initiates the restore process.

F5 - Attach Media

Allows you to specify the media to be used by this process.
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Prompts

Name(s) To Restore As

The names to restore the saved accounts as, separated by spaces. On Pick platforms, if the accounts 
exist, you are prompted for deletion of the accounts prior to the restore.

Name(s) On Backup

The names of the accounts as they were saved on the backup, separated by spaces. 

Rewind Media First (Y/N)

Options are:

Y rewinds the selected media prior to the restore. 

N starts the restore at the current media position.

Ignore Tape Label (Y/N)

Options are:

Y ignores a tape label if one is present.

N reads the tape label.

Original Frame Size

This is the frame size of the source environment which created the media. If the same leave blank.
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UniData or uniVerse

Function Keys

F2 - Accept

This accepts the screen details and initiates the restore process.

F5 - Attach Media

This allows you to specify the media to be used by this process.

Prompts

Name(s) To Restore As

The names you wish the saved accounts to be restored as, separated by spaces.

Name(s) on Backup

The names of the accounts as they were saved on the backup, separated by spaces.
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Verify Backup OK

Pick
This option displays the Select Media screen (See “Select Media” on page 54):

This checks data saved on the selected media for any data corruption or media errors by rereading 
all the data saved. Use this for important backups. 

Once the appropriate media has been selected, the data is verified. The process uses a dummy SEL-
RESTORE to verify the recorded data.

You may use T-VERIFY for backup verification on platforms that support it (eg, AP). To use this 
feature you have to modify attribute 35 of the SB.CONTROL record in DMCONT. To use the default 
options, set attribute 35, value 1 (<35,1>) to 1. The default options are:

TAFN for account-saves.

TFN for file-saves.

Other options for account-saves and file-saves must be specifically entered. Put options for 
account-save in attribute 35, value 1, subvalue 1 (<35,1,1>) of the SB.CONTROL record, and options 
for file-save in attribute 35, value 1, subvalue 2 (<35,1,2>). 
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Detach Media

This detaches the selected media, making it available to other users. If detaching other ports take 
care that the media is free to be used. When logging off the system, the media is automatically 
detached.

Prompts

Detach Unconditionally (Y/N)

Options are:

Y detaches any user currently attached to the selected media.

Note
On some platforms this is not allowed.

N detaches the media from the current port. If the OE supports more than one concurrent 
media, you are asked which media to detach.
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Format Diskette

Pick

This allows you to format a diskette so it may be used with SB+. Diskettes formatted in Pick are 
not recognized by DOS. Diskettes formatted in DOS are recognized by Pick.

Prompts

Standard/High Density (S/H)

Options are:

S formats Standard density diskette.

H formats High density diskette.

Diskette Drive (A/B)

Options are:

A selects drive A.

B selects drive B.
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Power Down System

Pick

This allows you to shut down the system with minimal chance of data loss and user disruption. 
Run either this option, Logto DOS or the standard system shutdown procedure before powering 
down. On some PC OEs this option retracts the disk read/write heads, ensuring the disk surface is 
protected if the computer is moved. Power Down System may only be run from port 0.

Function Key

F2 - Accept

This accepts the screen parameters and initiates the power down process.

Prompts

Minutes To Warn Users Logged On

The number of minutes to elapse before the shutdown commences.

Warning Message

A warning message to be displayed when countdown to shutdown commences. It is displayed at 
regular intervals to all users still logged on.
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Log All Users OFF Unconditionally

Options are:

Y automatically logs off users still logged on when the countdown reaches 0 minutes. 

N aborts shutdown if users are still logged on.

Kill All Print Jobs Unconditionally

Options are:

Y deletes any currently active print jobs from the print spooler when countdown reaches 0 
minutes.

N leaves any active print jobs on the spooler. The jobs may be lost or be in an unknown state 
when the system is powered up.
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Reboot System

Pick

Allows you to reboot the system with the minimum chance of data loss and user disruption. You 
must run either this option, Power Down System, Logto DOS or the standard system shutdown 
procedure before rebooting the computer. This option reboots the computer and reloads the system 
after the shutdown is completed. Reboot System may only be run from port 0.

Function Keys

F2 - Accept

This accepts the screen details and initiates the reboot process.

Prompts

Minutes To Warn Users Logged On

The number of minutes to elapse before the shutdown commences.

Warning Message

A warning message to be displayed when countdown to shutdown commences. This is displayed at 
regular intervals to all users still logged on.
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Log All Users OFF Unconditionally

Options are:

Y automatically logs off all users still logged on when countdown reaches 0 minutes. 

N aborts shutdown if users are still logged on.

Kill All Print Jobs Unconditionally

Options are:

Y deletes any currently active print jobs from the print spooler when countdown reaches 0 
minutes.

N leaves any active print jobs on the spooler. The jobs may be lost or be in an unknown state 
when the system is powered up.
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Logto DOS

Pick

Note
This option applies to PC's with an MSDOS partition only.

This option allows you to shut down the system with the minimum chance of data loss and user 
disruption. Either this option, Power Down System, or the standard system shutdown procedure 
must be run before the computer is powered down. Logto DOS may only be run from port 0.

Logto DOS executes FDISK, which shuts down the Pick system, changes the active partition and 
reboots the computer to the MSDOS partition.

Function Key

F2 - Accept

This accepts the screen details and initiates the logto DOS process.
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Prompts

Minutes to Warn Users Logged On

The number of minutes to elapse before the shutdown commences.

Warning Message

A warning message to be displayed when countdown to shutdown commences. It is displayed at 
regular intervals to all users still logged on.

Log ALL Users OFF Unconditionally

Options are:

Y automatically logs off all users still logged on when countdown reaches 0 minutes 

N aborts shutdown if users are still logged on.

Kill All Print Jobs Unconditionally

Options are:

Y deletes any currently active print jobs from the print spooler when countdown reaches 0 
minutes.

N leaves any active print jobs on the spooler. The jobs may be lost or be in an unknown state 
when the system is powered up.
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Menu
Introduction

The SB+ security system allows you to define users and groups of users as a hierarchy of par-
ent-child relationships.

A group may have many child groups and users. A user must have a parent group, and cannot have 
any children.
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User security restrictions are determined by the restrictions specified for the user's group, as well 
as any restrictions inherited from the parent groups. Any given group inherits the restrictions from 
further up the tree, and only further restriction is possible. SB+ has one predefined group called 
Root, which has no restrictions. The Systems Administrator builds the group structure beneath 
Root. 

Every user who has access to an account must be allocated a user id and an initial password. The 
initial password may only be used once, to allow the user to enter their own password. Thereafter, 
users maintain their own password. A user (including a Systems Administrator) cannot find out 
another user’s password. If a user forgets their password, the Systems Administrator must assign a 
new password.

SB+ security allows the logon point to be tailored to individual users. A user may be assigned a 
specific account to which they will always be logged, and/or an initial menu and menu option 
within the account. If no specific account or menu is specified, the user is logged into the account 
requested at the logon prompt (subject to account restrictions specified for the user's group) and 
the default main menu specified for the account is displayed.

The following diagram shows part of a possible security hierarchy in a development environment:

Root

Administrator

Group 1 Group 2 Group 3

Project Leader

Project 3A Project 3B

Programmer 3Programmer 2Programmer 1
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Security menu options
These are discussed in summary below. The sections that follow explain these options in greater 
detail.

Group Security Setup

This allows you to define and maintain a group. You are required to enter your password before 
you can proceed.

User Security Setup

This allows you to specify and maintain security details for a user. Group details must be specified 
before user details are entered. You are required to enter your password before you can proceed.

Initialize Users Password

This allows you to change the password of a user in a lower group. The new password grants initial 
access, and from then on the user maintains their own password.

Security Reports

This provides a menu of security report options.

Inhibit Logons

This allows you to inhibit logons on all ports except those specified as exclusions, and inform 
users why they cannot log on.

Note
This option inhibits logon to SB+ accounts only. Check your OS manuals for details of disabling 
logons at the system level.

Enable Logons Again

This re-enables normal logon to SB+ accounts for all ports previously affected by the Inhibit 
Logons option.
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Group Security Setup

Group Security Setup allows you to define and maintain user groups. All users are assigned a 
group, which controls various aspects of a user's access to SB+, including access to SB+ options, 
the SB+ shell, / processes, logon times, printer and account restrictions.

The user must enter their password to access this screen. They may only maintain groups beneath 
their own group in the security hierarchy, unless they belong to the Root group.
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Changes made to a group ripple down to all subgroups (children of the current group); ie all 
groups lower in the security hierarchy have their restrictions modified to be in line with the modi-
fied parent group. Therefore, all users belonging to a particular group or its subgroups have the 
same restrictions applied to them automatically.

This option only applies to group setup in the SB+ environment; it does not allow you to set up 
groups at the OE or OS level.

Function Keys

F2 - Save

This saves the group security parameters.

F4 - Del

This deletes the current group record. 

F5 - Restr Accounts

This allows you to enter specific system restrictions for each account entered at the Accounts 
With Restrictions prompt. (See “Account Restrictions F5” on page 87).

F7 - Logon Times

This allows you to enter password rollover date details. You may also specify valid logon dates, 
days and times for this group, if required. (See “Logon Times F7” on page 90).
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F8 - Locs

This allows you to specify valid printer locations for this group, if required. These are used by the 
Printer Manager to restrict access to certain printers when printing from SB+. (See “Printer Man-
agement” on page 159).
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F9 - Children

Displays details about the immediate children of this group.

F10 - Action

Displays the action bar:
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Copy Group

This subscreen allows you to copy a group with the same parent as the original. The new group is 
added to the parent group's child list. You must enter a description for the new group.

Print Defaults

This subscreen allows you to define specific print defaults for a group. These parameters are used 
in determining the user's print defaults at logon. See “Appendix B - Printer Management” for 
details of print defaults.
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Aux Defaults

This subscreen allows you to define auxiliary printer defaults for a group. See “Appendix B - 
Printer Management” for details.

Function Keys

F2 - Accept

This accepts the Group Aux Defaults screen.

F4 - Clear Defaults

This clears the screen details.

Prompts

Group Id Code

The group id code to be created or amended. You may only access groups at a lower level (child 
groups) than your group, unless you belong to the Root group.

Group Parent Code

The id of the parent group for the group id being defined. This defaults to the group of the current 
user, and other groups at the same or higher level cannot be entered. Groups at a lower level than 
the current user's group may be entered as the parent group.

Group Description

A description for the group id being defined.
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Inhibit Break Key (Y/N)

Options are:

Y inhibits the Break key for this group. This means that users of this group are not able to 
use the Break key to access the OE.

N allows the Break key for this group. Users are able to access the OE.

Inhibit Supervisor (Y/N)

Options are:

Y prevents users in this group from maintaining subordinate groups. This entirely restricts a 
user's ability to add or modify groups.

N allows users in this group to maintain subordinate groups.

Inhibit Shell Access (Y/R/N)

Options are:

Y prevents all access to the SB+ shell and the OE shell.

R inhibits access to the OE shell; the user may still access the SB+ shell.

N allows access to the SB+ shell and the OE shell.

You may specify restricted verbs at the next prompt if you choose N or R here.

Restrict Shell Verbs (Y/N)

Options are:

Y restricts shell verbs for this group. This displays the Shell Verb Security subscreen, 
allowing you to enter a list of allowed or disallowed shell verbs:

N does not restrict shell verbs. Restricted verbs from parent groups apply to child groups.

Inhibit Process Calls (A/C/N)

SB+ processes may be called in a number of different ways. These include:
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• the /processname method, where a process definition has been created for a process. The 
process may be invoked at an input prompt or at a menu. Eg /TM invokes the Tools menu. 
Option A prevents this type of process call for users in the current group.

• the /processtype:processname method, where a process has been created, but a definition 
has not been created for it. Eg /M:MAINMENU invokes the main menu (where M is the pro-
cess type for menus and MAINMENU is the menu name). Option C prevents this type of pro-
cess call for users in the current group.

Options are:

A prevents process calls of both types, but allows either process type to be called as menu 
options.

C only prevents /processtype:processname processes from being called except as menu 
options.

N allows both types of process to be called within and outside menus. 

Keyboard Timeout Limit (Mins)

The group’s upper timeout limit (in minutes). The user must re-enter their password if they have 
not pressed a key within the timeout limit. Entering 0 disables the keyboard timeout.

Note
The initial value for the keyboard timeout is inherited from the parent group. If the parent group 
has a non-zero timeout value then the value entered here may not exceed the parent limit, or be set 
to zero. If the parent timeout limit is zero, then any value (including zero) may be entered here.

Accounts with No Restrictions

A list of SB+ accounts to which users of the current group have access, without further restrictions 
being imposed on menu and process options. Any menu and process restrictions from the parent 
groups are inherited by all accounts listed at this prompt. Users cannot access any SB+ accounts 
not listed at this or at the Accounts With Restrictions prompts.
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Accounts With Restrictions

A list of SB+ accounts to which users of the current group have access, which may have further 
restrictions imposed on menu and process options available to the user. Note that accounts entered 
at this prompt may not actually be restricted further; restrictions must be specifically entered using 
the F5 - Restrict Accounts option.

Position the cursor on the required account and press F5 to specify the restrictions for the current 
SB+ account. Any menu and process restrictions from the parent groups are inherited by all 
accounts listed at this prompt. Users cannot access any SB+ accounts not listed at this or at the 
Accounts With Restrictions prompts.

Last Maintained

Displays a list of recent changes to this screen, and the id of the person who changed it.

Diary Access Code

A diary access code for the current group. Use this option when you require a code for a large 
group of users where individual access codes are not required for all users.

Note
You can only change this for your own user id. See “Diary” on page 307 for more information on 
diary access codes.
86 SB+ Server Administration Manual



Introduction
Account Restrictions F5

Allows you to specify allowed (unrestricted) or disallowed (restricted) processes for the group 
being defined or modified.

Function Key

F2 - Save

Saves the data entered into this screen.
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Prompts

System Id

Restrictions are applied to processes and menu options on a per-system basis. The selected system 
id must exist in the specified account. 

Account

The name of the account.

Allow/Disallow

Options are:

A specifies a list of allowed processes at the next prompt. Only these processes are callable 
by the users in the current group.

D specifies a list of disallowed processes at the next prompt. All except these processes are 
callable by users in the current group

You may specify a list of allowed or disallowed processes at the next prompt (whichever is more 
convenient for you to enter). If you enter A and do not specify any processes at the next prompt, 
then allow no processes is assumed and therefore the system id is not available for this group when 
selecting from the System menu.

Processes

Process names to be either allowed (A entered at the previous prompt) or disallowed (D entered at 
the previous prompt).

Menus

The menu name to have restricted options. The next prompt specifies whether options are allowed 
or disallowed. List all menus for which you wish to specify restrictions. The user gains access to 
the menu but is allowed/denied access to options specified at the Option Letters prompt. 

To restrict access to the menu completely, no options should be allowed; enter A at the next prompt 
and leave the Option Letterss prompt blank. Restricting access to processes on a menu does not 
stop a user using /processname. To prevent this, you can globally restrict process calls at the 
Inhibit Process Calls prompt, or, if you wish to restrict a limited number of processes, specify 
those processes at the prompts in the PROCESSES section of this subscreen.
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If a restricted menu option happens to be a menu itself, then it and the menus below it in the hier-
archy are also automatically restricted.

Allow/Disallow

Options are:

A allows access to the menu options specified at the next prompt. Only these menu options 
are available to the users in the current group.

D disallows access to the menu options specified at the next prompt. All except these menu 
options are available to the users in the current group

If you enter A and no menu options are specified at the next prompt, then no options are allowed 
and the menu is not accessible to this group.

Option Letters

The option selection letters for the menu specified as allowed or disallowed at the previous prompt.
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Logon Times F7

Function Key

F2 - Accept

Accepts the data entered into this screen.

Prompts

Password Rollover Expression

An expression determining when the passwords for users in this group are to be changed. If a pass-
word is to be changed on a regular basis, enter an expression that returns a date on which the pass-
word is to be re-entered.

Note
The initial value for this field is inherited from the parent group definition.

Eg @DATE + 60 prompts for a new password every 60 days.

If a password is to be changed once, on or after a specific date, enter the date required.
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From Day

The (optional) start day of the week (or date) on which the specified group can log on. Eg MONDAY.

Upto Day

The (optional) end day of the week (or date) on which the user can log on.

From

The (optional) time of day (24 hour clock) from which the specified group can log on, on the days 
or date entered previously.

To

The (optional) time of day (24 hour clock) up to which the group can log on, on the days or date 
entered previously.
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User Security Setup

User Security Setup allows you to define and maintain individual SB+ users. An SB+ user is able 
to log onto an SB+ account and use a selected subset of SB+ options, depending on the restrictions 
placed on the user through the group that the user is assigned to. All users are assigned a group, 
which controls various aspects of a user's access to SB+ functionality. See “Group Security Setup” 
on page 78 for details of restrictions that may be applied to users.
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The user must enter their password to access this screen. A user may only maintain users belong-
ing to groups subordinate to their own group in the security hierarchy, unless the user belongs to 
the Root group. If a user's group inhibits the supervisor option, then that user is unable to modify 
other users' details.

When a user id is first defined, the Systems Administrator allocates an initial password. When the 
user first logs on to SB+, they are prompted for a new password which they must enter and vali-
date. Thereafter, the user is responsible for maintaining their password.

This option only applies to user security setup in the SB+ environment; it does not allow you to set 
up users at the OE or OS level.

Function Keys

F2 - Save

This saves the current user record.

F4 - Del

Deletes the current user record.

F5 - User Menu

Allows you to define a specific user menu that will be displayed when the user logs on. This 
invokes the Menu Definitions tool with a menu name the same as the user id.

F6 - User Keys

Allows you to specify macro keys and the strings those keys invoke. (See “Define User Macro 
Keys F6” on page 102).

F7 - Term/Print

Allows you to specify the default terminal to be used if not specified in the port configuration, and 
the default printer and auxiliary printer to be used to determine the user's print defaults at logon (in 
the absence of other print defaults being defined). See “Appendix B - Printer Management” for 
details of print defaults.

F8 - GUI Prefs

Allows users to customize the GUI environment.
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F10 - Action

Displays the action bar:

Copy User

This subscreen allows you to copy a user within the same group.

Print Defaults

This subscreen allows you to define specific print defaults for a user. See “Appendix B - Printer 
Management” for details of print defaults.

This subscreen has the following function keys:

F2 Accept

This accepts the user print default parameters.
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F4 Clear Defaults

This clears the screen details.

Aux Defaults

This subscreen allows you to define auxiliary print defaults for a user. See “Appendix B - Printer 
Management” for details of print defaults.

This subscreen has the following function keys:

F2 Accept

This accepts the User Aux Defaults screen.

F4 Clear Defaults

This clears the screen details.

Prompts

User Id Code

The user identification code. To create or amend this, the user must be in a subordinate group to 
your own, unless you are a Root group user. F3 displays users in the same and lower groups.

Alternative Id Code

An (optional) alternative code that further uniquely identifies the specified user for applications 
beyond this system. Eg Employee Number. 
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First Name

The first name of the user being specified.

Surname

The surname of the user being specified.

Short Name

A more common name to be used as an alternative means of identification for the specified user. 
This name is displayed when logging on or when other users view mail sent by this user.

Status

The status code for the user being defined. Codes are: 

A Active. The user is allowed to log on. No activity logging takes place.

D Developer. Activity is not logged.

L active and Logged. The user is allowed to log on and their presence on the system is 
recorded if the process LOG.USER is linked to the processes this user accesses. (See the 
section on LOG.USER in your SB+ Server Reference Manual).

M Miscellaneous user id for non-logon purposes.

R Resigned. The user is not allowed to log on.

N Network use only. Allows mailing across networks.

Users Group Code

The id of the group to which the user belongs. The group id determines the level of access the user 
has within the system. See “Group Security Setup” on page 78.

Start Account

An (optional) account name containing the initial menu for this user id. If an account name is 
entered, that is the only account this user may log onto. 

You may enter an expression enclosed in round brackets, evaluating to an account name. Eg 
(@PASS.DEFN<14>:".ACC").
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Start Sys, Menu, Opt

The (optional) system id and start menu to appear after logon for this user id. An option within the 
menu may also be specified using the highlight letter of the option. Eg AR,MAINTMENU,R. In this 
example, the user is presented with the process accessed by option R in MAINTMENU in system AR 
in the account logged into. In the default menu system configuration this would display the runt-
ime menu to the user after the user id and password have been entered.

The start menu is the first menu displayed after the user logs in, in preference to the account’s main 
menu. The F5 key builds the start menu for the user. When the user exits the menu, they are taken 
back to the Logon screen.

Password

The password the user uses when first logging on. From then on they will nominate and use their 
own password.

Pwd Rollover Date

A future date on which the user is required to change their password.

Diary Access Code

A code used to encrypt/decrypt diary entries, if required. This code is used as a seed for the 
encryption routine. If you leave this blank, and their group Diary Access Code is also blank, the 
user will not be able to encrypt their private diary entries.

Warning
Care should be taken in changing this code as previous entries will not be decrypted correctly.

Macro Leadin Character

The decimal ASCII value representing the keystroke that signals to SB+ that a macro follows. 
Macro keys and the strings they invoke are defined using the F6 key. If you define a character here, 
it overrides the macro leadin character defined for the current terminal definition. This allows you 
to use the same leadin character irrespective of the terminal you are using. Leave this prompt blank 
if you intend to use the macro key as defined for the terminal you are using.
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Keyboard Timeout

The number of minutes of inactivity after which the user is forced to re-enter their password before 
subsequent input is allowed. If you enter 0 (zero), keyboard timeout is disabled. The timeout value 
specified here overrides the value specified for the user's group, with the following exception: if 
the user's group timeout is not zero, the user timeout cannot be set to zero or to a value greater than 
the group timeout.

Auto Extend Field Length

Options are:

Y enables the Extend Field Length option on field entry. This means the user does not have 
to press the extend-length key (as defined for the terminal currently being used) to con-
tinue entry in the field beyond its displayed end. Continuing typing automatically activates 
the Extend Field Length option.

D Disables the Extend Field Length option on field entry. This means the user cannot press 
the extend-length key to enable entry beyond the indicated field length and they cannot 
type past the indicated end of the field.

N Normal length option control. This means the user is not able to type past the indicated 
end of a field. Attempting to do so causes a warning beep. Pressing the extend-length key 
allows the user to enter text beyond the indicated field end.

Auto Help Display

Determines whether or not help reminders are automatically displayed when a menu option is 
highlighted or a field entered. This is useful for new users. Options are:

N no auto display. The user must press F1 for help.

Y auto displays help reminders that start with ?

M auto displays Menu reminders.

A auto displays All reminders.

Error Text in Dialog Box

Determines whether or not help error messages are displayed in a dialog box, or on the prompt 
line. Options are:
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Y displays all error messages in a dialog box.

N (default) displays all errors on the prompt line.

Main Heading Justification

C Centre

L Left

R Right

Full Refresh Of Screen

The screen refresh action to be taken whenever a process that displays information on the screen is 
exited.

Screens are stored on a multi-level stack. The number of screens that may be stacked may be lim-
ited on some platforms. See “SB+ Control Parameters” on page 234.

Options are:

Y refreshes complete screen (all levels). The process starts at the oldest stacked level, and 
repaints the screen completely with each subsequent level up to the new top level.

N refreshes the new top level screen only.

S Smart refresh; only refreshes the part of the screen previously overlaid by the exited 
screen. This is the preferred option; however, system limitations such as a slow processor 
may reduce performance.

The value entered at this prompt has no effect if you are using SBClient or SBTerm for DOS, as all 
screen refreshing is handled by these programs.

Suppress Confirm On Screen Esc

Options are:

Y suppresses the verification prompt when escaping from an input process without having 
saved any changes. Selecting the mandatory [M] option at the Process On Escape prompt 
in the Screen Painter Parameters screen overrides this flag. See "Screen Definitions" in 
your SB+ Server Reference Manual.
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N displays a dialog box asking for confirmation that the changed data should be lost, if the 
data changed was not saved before the Esc key was pressed.

Command Stack per Account

SB+ provides a command stacker in the SB+ shell that allows for the recall, modification and/or 
resubmission of any commands entered at the shell command line. This flag determines whether a 
separate stack is kept in each account for this user, or if one stack is to be used across all accounts 
accessed by that user. See “Shell” on page 340 and “Logto” on page 342 for more information on 
stack usage and commands. Options are:

Y maintains a separate command stack for each account for this user. 

N maintains one global command stack for this user.

Suppress Beep On Error

Options are:

Y suppresses the beep preceding the display of SB+ error messages.

N does not suppress the beep preceding the display of SB+ error messages.

Suppress Logon Message Delay

These options apply to the Logon message (last logged on, mail, appointments):

Y suppresses delay when displaying details. Normally, there is a three-second delay to read 
messages.

N always delays.

M only delays if there is a Message.

A always solicits the Accept response.

Display Print Select Screen

Determines the display of the Printer Selection screen. Options are:

Y always.

N never.
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RO Reports Only.

Display Aux Select Screen

Y Yes.

N Never.

W Windows Print Setup dialog only.
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Define User Macro Keys F6

This allows the user to enter repetitive data strings by entering a macro leadin character (eg Ctrl Z) 
and a keyboard switch character.

In the example above, pressing the macro key followed by the letter P is equivalent to typing PHIL-
ADELPHIA.

Function Key

F2 - Accept

Accepts the data entered into the screen.

Prompts

Sw

The switch character used to recall the string defined at the next prompt.
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Macro String

The string of characters returned.

If entering a process call, a \ must be entered before the /. Eg \/FD accesses the Field Definitions 
tool.

To enter data to subsequent prompts, enter \DATA followed by the required input strings separated 
by commas. Eg:

ORDERS \DATA ORDER FILE,10,20,210

If you enter a number between 0-254 enclosed in parenthesis, SB+ converts the number to its 
equivalent ASCII character. Eg in the screen above, the letter V produces a value-mark (253). This 
facility can be used for entering non-standard characters, such as ü.

Note
This feature is only active in character mode. In GUI mode, the normal Windows cut and paste 
(Ctrl + X, Ctrl + C, and Ctrl + V) are available.
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Initialize Users Password

This allows you to change the password of a user in a lower group than your own. This password 
grants initial access, after which the user will need to maintain their own password.

Function Key

F2 - Accept

Accepts the data entered into this screen.

Prompts

User Id

The user id for which a new password is to be specified.

New Password

The new password to be used by the user when first logging in. The user is prompted for their own 
password after the initial logon.
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List Users Logged On

This provides a list of all users currently logged on.
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Security Reports

This menu provides a selection of security reports:

Breach Report

This shows details of all attempted breaches of security, including the date, time, port number, 
account, user id and the type of security breach. You may enter a selection criteria for this report. 
You are given the option of clearing breach entries in the log file.

User Activity Log

This shows historic details of all user logon activities, including details of users who have logged 
on and off the system, and when they used any process to which LOG.USER has been specified. 
You may enter a selection criteria for this report. You are given the option of clearing user activity 
entries in the log file.
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Clear User Log File

This allows you to clear all entries in the user log file including breaches and logged activities. You 
are shown details of what types of entries were cleared (breaches, activities or all), who cleared 
them, and the date and time cleared.

Group Summary Report

This provides a summary listing of all groups existing on the system.

User Report

This provides a summary listing of all users existing on the system.

System Access Summary

This provides a detailed summary of all account and process restrictions defined for all groups on 
the system.

System Restrictions

This provides a listing of all system level restrictions.

User Summary Report

This provides a summary report of users on te system. It is possible to specify sorting and selection 
criteria for this report.

User Details Report

This provides a detailed report of users on the system. It is possible to specify sorting and selection 
criteria for this report.

Group Summary Report

This provides a summary report of groups that have been created on the system. It is possible to 
specify sorting and selection criteria for this report.

Group Details Report

This provides a detailed report of groups that have been created on the system. It is possible to 
specify sorting and selection criteria for this report.
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Group Hierarchy Report

This provides a report showing the hierarchy of groups that have been defined in the system. It is 
possible to specify a particular group which will be used as the starting point of the report. It is also 
possible to select whether to include additional details about each group on the report.
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Inhibit Logons

Allows you to inhibit logons by all SB+ Server uses except those specified as exclusions, and to 
inform users why they cannot log on. This is useful when you are upgrading to a new release of 
SB+, or performing an application revision or general system maintenance.

Note
This option inhibits logon to SB+ accounts only. Check your OS manuals for details of disabling 
logons at the system level.
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Function Keys

F2 - Accept

This accepts the screen parameters and initiates the inhibit logons process.

F4 - Enable

Re-enables the normal logon routines.

Prompts

Non Inhibit Users

The users not prevented from logging on after this option has been taken.

Logon Inhibited Text Message for users

Text explaining why logons are being inhibited.
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Enable Logons Again

This option re-enables normal logon to SB+ Server accounts for all users previously affected by 
the Inhibit Logons option.
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Chapter 4 - Admin Menu
Introduction

The Admin menu provides an interface to the OE. It allows you to perform many of the more com-
mon administrative functions of the OE without having to directly access it. Options you would 
normally enter as command line parameters may be entered using an input screen or by selecting a 
menu option, without needing to know the command line syntax.

Admin menu options are:

Files provides options for maintaining files, including options for viewing, modifying, resizing 
and deleting file contents.
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Printers & Terminals provides options for maintaining printers, terminal definitions and port 
configurations. The options available vary between platforms.

Media Commands provides options for creating (on some platforms), selecting and assigning 
media devices and performing backup, restore and other file operations using the selected media. 
The options available vary between platforms.

SB+ Setup provides options for maintaining SB+ control parameters. These parameters vary 
between platforms.

System House Keeping provides options for configuring ports, maintaining date and time param-
eters, and accessing system information. The options and information available vary between plat-
forms.

Accounts provides options for creating, updating and deleting SB+ accounts.
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Files

The Files menu provides options for maintaining files and records. 

Update Processes

Update processes are those which allow you to edit, copy and delete records in your files, to create 
non-SB+ files, to clear files and access and maintain files in other accounts. Take care in using 
these tools, as indiscriminate use may lead to data integrity problems.
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Note
These tools make direct use of quoting system commands and functions and may bypass SB+/user 
update and revision control processes.

Screen Edit a File

Allows you to edit records in a file using the SB+ screen based text editor (See “Text Editor” on 
page 31 in your SB+ Server Reference Manual). See your OE documentation for details of file 
structure and usage.

Prompts

File Name To Edit

The name of the file containing the records to be edited.

Record(s) To Edit

The ids of the records to be edited, separated by spaces.
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Line Edit a File

Allows you to edit or create a record in a file using the OE editor (See your OE documentation for 
details on the editor, and on file structure and usage).

Prompts

File Name

The name of the file containing the records to be edited.

Data/Dict (0/1)

Options are:

0 edits a record in the data part of the specified file.

1 edits a record in the dictionary part of the specified file.

Record Name(s) (*all)

The ids of the records to be edited. To edit all records on the specified file enter ∗. Separate ids by 
spaces.
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Copy Records

Allows you to copy records from one file to another or to duplicate the record using a different id 
in the same file.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to copy records.

Prompts

Source File Name

The name of the source file from which the records to be copied are selected.

Data/Dict (0/1)

Options are:

0 copies from the data part of the specified file.

1 copies from the dictionary part of the specified file.
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Record(s) to Copy (*all)

The ids of the records to be copied from the specified file. Enter ∗ to copy all records. Separate ids 
by spaces.

Target File Name

The name of the file the copied records are written to. The target file may be the same as the source 
file if records are to be duplicated.

Record Name(s) (null same)

New ids must be entered if the records are to be duplicated in the source file. Leave blank if the ids 
are to be copied with the same names to another file.

Options: Overwrite, Delete (O, D)

Options (which may be combined) are:

O Overwrites records that exist on the target file. 

D Deletes records on the source file after copying. 

Clear File

Allows you to clear the contents of either the dictionary part or the data part of a file. The file itself 
is not deleted. It is advisable to backup important files before clearing them. 

Note
All records are deleted unconditionally.
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Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to clear a file.

Prompts

File Name

The name of the file to be cleared.

Data/Dict (0/1)

Options are:

0 clears records from the data part of the source file. 

1 clears records from the dictionary part of the source file.

Create File
Allows you to create non-SB+ files (ie the files created using this screen are not known to SB+). 
They do not appear in file lists in intuitive help, for example. The Create File option in the Tools 
menu creates SB+ files, but is not available for runtime licences. On some platforms, full file type 
specification is only available when creating files using this option.

Note
The prompts on this screen vary across platforms.
120 SB+ Server Administration Manual



Files
Pick

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to create a file.

Prompts

File Name

A unique name for the file to be created.

Data/Dict/Both (0/1/2)

Options are:

0 creates the data part of the file only. 

1 creates the dictionary part of the file only. 

2 creates both the dictionary and data parts of the file.

Modulo Of Dict

The modulo (number of groups) to be created for the dictionary part of the file. This should be a 
prime number.
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Modulo Of Data

The modulo (number of groups) to be created for the data part of the file. This should be a prime 
number.

uniVerse

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to create a file.

Prompts

File Name

A unique name for the file to be created.

Description

An appropriate description for the file. (Optional).

File Details – Dictionary Level Type

A number of different types of files may be created. The difference between most types relates to 
the different hashing algorithms used. You should choose the type most suited to the nature of the 
records the file will contain.
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Type 18 is the same algorithm that Pick uses. Type 1 files are used for programs or large text 
records. Each record is stored as a separate Unix file. See your uniVerse documentation.

Leave this field blank if you do not want to create the dictionary part of the file.

File Details – Dictionary Level Modulo

The number of primary groups allocated to the dictionary part of the file. See your uniVerse docu-
mentation.

File Details – Dictionary Level Separation

The number of blocks allocated per group to the dictionary part of the file. See your uniVerse doc-
umentation.

File Details – Data Level Type

A number of different types of files may be created. Most relate to the different hashing algorithms 
used. You should choose the type most suited to the nature of the records the file will contain.

Type 18 is the same algorithm that Pick uses. Type 1 files are used to contain programs or large 
text records. Each record is stored as a separate Unix file. See your uniVerse documentation.

Leave this field blank if you do not want to create the data part of the file.

File Details – Data Level Modulo

The number of primary groups allocated to the data part of the file. See your uniVerse documenta-
tion.

File Details – Data Level Separation

The number of blocks allocated per group to the data part of the file. See your uniVerse documen-
tation.
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UniData

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to create a file.

Prompts

File Name

A unique name for the file to be created.

Description

An appropriate description for the file. (Optional).

Type (0/1/2)

The type of file to be created. Options are:

0 creates the data part of the file only. 

1 creates the dictionary part of the file only.

2 creates both the data and dictionary parts of the file.
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Dynamic

Allows a dynamic file to be created. Dynamic files are self-resizing. See your UniData documenta-
tion. Options are:

Y creates a dynamic file.

N creates a normal file.

Modulo

The number of primary groups allocated to the file. See your UniData documentation.

Sep

The number of blocks allocated per group. See your UniData documentation.

DIR Type

If the file is not a dynamic file (N is entered at the Dynamic prompt), and the file type is 0 or 2, the 
data part of the file to be created may be specified as a directory type file. If the file is a dynamic 
file (Y is entered at the Dynamic prompt), this field is blank. Options are:

Y creates a directory type data part of the file.

N creates a normal data part of the file.

Hash Type

The hash type determines the way data is stored on disk. See your UniData documentation. 
Options are:

0 the default for non dynamic files.

1 the default for dynamic files.
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Delete File

Allows you to delete files created in the OE (or using the Create File tool described previously), 
completely from the system. 

If the file was created with the Tools > File Create/Delete > Create A New File option (ie it is an 
SB+ file) it should be deleted using the Tools > File Create/Delete > Delete A File option. This 
ensures that SB+ is aware that the file has been deleted. If you use Admin > Delete File to delete 
an SB+ file, the file name will continue to show up in intuitive help lookups, even though it has 
been deleted. (See “File Create/Delete” in your SB+ Server Reference Manual).

Exercise great care when deleting a file. Be aware of the impact on other files in the system, as 
well as on data integrity. We recommend you backup important files before deleting them. The 
only way to recover a file once it has been deleted is from a backup. The more recent the backup is, 
the less data is lost.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to delete a file.

Prompts

File Name

The name of the file to be deleted. Be aware that data in this file is lost when the file is deleted. 
Data can only be recovered by restoring the file from a backup.
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Delete Record

Allows you to delete one or more records from a file. You will be prompted to confirm your dele-
tion.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to delete a file.

Prompts

File Name

The name of the file containing the records to be deleted.

Data/Dict (0/1)

Options are:

0 deletes records from the data part of the file.

1 deletes records from the dictionary part of the file.

Record Name(s) (*all)

The ids of the records to be deleted from the file. Enter ∗ if all records are to be deleted. Separate 
ids by spaces.
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Access File Other Account

Records in a file in another account may be referenced from the current account using a remote file 
pointer. This option allows you to define a link to the remote file. The pointer name may be the 
same as that of the remote file name, or may be different. A file in the current account may also 
have synonym pointer; a pointer to it is created in the current account using a different name, and 
the file may be opened using the synonym or the original name. You may create multiple syn-
onyms for local and remote files.

Eg the file name BEV000-PARTA (although it may be part of a uniform file naming scheme), is 
rather cryptic. When writing user subroutines or paragraphs, clarity is improved by the use of a 
meaningful name for the file, such as CONTRACT-HEADER. This is achieved by creating a synonym 
or remote file pointer to BEV000-PARTA called CONTRACT-HEADER, dependent on the location of 
BEV000-PARTA.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to access a file in another account.

Prompts

Other Account Name

The name of the account containing the file to be accessed from the account you are currently in. If 
the file is in the current account and you wish to create a synonym, leave this prompt blank.
128 SB+ Server Administration Manual



Files
File Name In Other Account

The name of the local or remote file you wish to access.

Name For This Account

The name to be used in this account to access the file. 

Search and Replace

Allows you to find records in a file that contains the given search strings and to optionally replace 
each instance of the search string with an alternative string. You may specify multiple search and 
replace string combinations. To specify search-only, leave the Replace String field blank.

The CLEAN.SYSTEM process clears all saved search and replace setups (See your SB+ Server Ref-
erence Manual). Copy the setups you want to keep to another file before CLEAN.SYSTEM is run.
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Function Keys

F2 - Accept

Accepts the screen parameters and initiates the process to search and replace a string.

F5 - Recall a Setup

Recalls previously saved search details to be used with another file. Details are stored in the file 
xxCONTROL with a default id of $SRportno. Recalled details do not overwrite already entered 
selection criteria or options.

F6 - Save a Setup

Saves details of a search (apart from the file being searched). You may recall these details later for 
subsequent searches with different file names. Details are stored in xxCONTROL with an id of 
$SRportno.

F7 - Delete a Setup

Deletes previously saved search details if required.

Prompts

File Name

The name of the file to be searched.

Selection

Selection criteria (if required) for this search. All records are searched if no selection criteria are 
specified. You should enter selection criteria if you want to specify certain records to be searched. 
You should use standard Query syntax. Eg:

AREA = "LON" AND BALANCE > "123"

Options

Determine the way in which the string is searched, and what happens to the records found. Options 
(which may be combined) are:
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C Confirm. Prompts for confirmation each time the string is found that it is to be replaced. 
To avoid possible data integrity problems, we recommend you always specify this option.

L List. Produces a list of record ids that have been found containing the strings. The list is 
stored in xxCONTROL with an id of $filename.port.

S Select list. Returns an active select list of the ids containing the string.

U Unique. Specifies that the string searched for must be a whole word. 

Search String

The string to be searched for within the selected records.

Replace String

The string to replace the search string, if found. If a string is to be searched for but not replaced, 
leave this field blank.

View File Data

Provides options for viewing data in a file.
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List Records In File

Allows you to list records held in a file. It is a simplified version of the Query Report Definitions 
tool and may be used when the Tools menu is not available. This tool uses standard dictionary def-
initions only.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to list records in a file.

Prompts

File Name

The name of the file containing the records to be listed.

Sort Fields

The fields used to sort the records; fields should be in descending order of importance and delim-
ited by a single space.
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Fields to Print

The names of the fields to be printed in the list, delimited by a single space.

Selection Criteria

Selection criteria (if required) for this report. All records are printed if no selection criteria is 
entered. You should use standard Query syntax; for instance:

AREA = "LON" AND BALANCE > "123"

Totals Only (Y/N)

Options are:

Y prints totals only; ie no detail lines are printed. 

N prints detail and total lines.

Heading

A heading for the listing. (Optional).

Footing

A footing for the listing. (Optional).

Screen/Printer (S/P)

Options are:

S sends report output to the Screen. 

P sends report output to the Printer.

List All File Names
Allows you to list the names of all files held in this account, and files that exist in other accounts 
that may be accessed from this account.

This tool is an interface to the OE command for listing files on your platform (for instance, the 
UniData command LISTFILES or LISTF). See your OE documentation.
SB+ Server Administration Manual 133



Chapter 4 - Admin Menu  
List Entire Record

Allows you to list the contents of a record to either the screen or a printer.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to list records in a record.

Prompts

File Name

The name of the file containing the records to be listed.

Data/Dict (0/1)

Options are:

0 lists record contents from the data part of the file. 

1 lists record contents from the dictionary part of the file.

Record Id(s) (*all)

The ids of records to be listed. Enter ∗ to list all records. Separate ids by spaces.
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Screen/Printer (S/P)

Options are:

S displays records on the Screen.

P sends record listing to the Printer.

Options (I,S,F) - uniVerse and Pick

Options (which may be combined) are:

I suppresses the default id display in the list. Equivalent to the ID-SUPP Query modifier.

S suppresses line numbering.

F sends a form feed after each record. 

List Dictionary

Allows you to list records in the dictionary part of a file to the screen.

Prompts

File Name

The name of the dictionary file whose contents are to be listed.
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Count Records in File

Allows you to count the number of dictionary or data records in a file. You may enter selection cri-
teria specifying the records to be counted.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to count records.

Prompts

File Name

The name of the file whose records are to be counted.

Data/Dict (0/1)

Options are:

0 counts the records in the data part of the specified file. 

1 counts the records in the dictionary part of the file.

Selection Criteria

Selection criteria (if required) specifying the records to be counted. Leave blank to count all 
records. You should use standard Query syntax. Eg:

AREA = "LON" AND BALANCE > "123"
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Sum A Field

Allows you to total the values of a field in selected records from one file.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to sum a field.

Prompts

File Name

The name of the file containing the field whose contents are to be totalled.

Sum Field Name

The name of the field.

Selection Criteria

Selection criteria (if required) specifying the records. You should use standard Query syntax. Eg:

AREA = "LON" AND BALANCE > "123"
SB+ Server Administration Manual 137



Chapter 4 - Admin Menu  
Compare Records

Allows you to compare two records (or multiple pairs of records) held in a file or in different files.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to compare records.

Prompts

Reference File Name

The name of the file containing the initial records to be compared.

Record Name(s)

The id of the records in the reference file to be compared. ∗ selects all records in the reference file.

Compared File Name

The name of the file containing the records to be compared against. The default file name is the 
reference file name entered above.
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Record Name(s)

The id of the second records that are to be compared with records in the reference file entered. ∗ 
selects all records in the compared file. If the reference and compared files are the same, ∗ is not a 
valid response.

Output to (S/P/X/F/L)

Options are:

S outputs the results of the comparison to the Screen.

P outputs the results of the comparison to the Printer.

X outputs the results of the comparison to the auxiliary printer.

F outputs the results to xxWORK file, with an id of COMPport.

L outputs the results of the comparison to a record with the id $filename:port in xxCONTROL.

Resize Files

Provides options for resizing files.

The amount of disk space allocated to a file should be matched to the actual volume of data in the 
file. Incorrectly sized files may have a serious effect on system performance; files that are too 
small may take too long to access, while files that are unnecessarily large waste disk space.
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Note
This menu is not availabe on Windows NT based installations.

You will need to resize files from time to time as the amount of data held changes. SB+ partially 
automates this procedure, using statistical information obtained by the system, together with 
parameters maintained by the user.

Determine File Sizes

Pick

uniVerse/UniData

Provides file size statistics for the current file. A statistics file may be produced for the whole sys-
tem or for individual accounts, as follows:
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1. A statistics file is built for an account or the whole system by scanning every file within the 
accounts specified. This step may be skipped if the current statistics file is up to date.

2. The SB+ history file is updated with the current statistics. The process then calculates the sug-
gested resizing parameters. File growth history may be used in the calculations.

Function Key

F2 - Accept

Accepts the screen parameters and begins the generation of file statistics.

Prompts 

Account to do (*=All)

The account names delimited by a single space or ∗ (for all) for which resize parameters are to be 
calculated.

Last Valid Suggestions

The date on which the last valid file resizing suggestions were calculated. If no previous resizing 
calculations have been made, or the statistics file has been cleared, this field is blank. (Display 
only).

Use History Growth Factor (Y/N)

Each time a file is resized, SB+ keeps a record of previous modulos for the file. Once there are 
three or more previous sizes recorded for a file, SB+ can use this information to determine the per-
centage growth, taking this into account when working out the new file size. Options are:

Y includes growth history in resize calculations for specified accounts.

N calculates resize parameters without reference to growth history.

Use Existing System File Stats (Y/N/Q) - Pick

Options are:

Y does not rebuild the OE statistics but updates the SB+ statistics from the OE statistics file. 
Suggestions are determined from current statistics. Use this option if the OE statistics file 
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containing information on the specified accounts is fairly recent and no restore has 
occurred since statistics were last created. 

N rebuilds the OE and SB+ statistics files, as current data is too old, or a restore has occurred 
since the last time Determine File Sizes was run.

Q uses the latest available valid SB+ statistics. No new statistics files are built.

File Size Reports

Provide information generated from the most recent invocation of the Determine File Sizes pro-
cess. This assists the Systems Administrator in determining strategies for file resizing. The reports 
are:

All File Statistics by Account

This report shows a complete listing of file statistics for all accounts nominated in the last Deter-
mine File Sizes invocation. Information includes the current size, utilization and growth of the file, 
and the current and suggested modulo sizes.
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Files Suggested to Resize

This report is similar to the All File Statistics by Account report, but lists only those files that 
Determine File Sizes has determined are in need of resizing.

Files Too Small by Account

This report is similar to the All File Statistics by Account report, but lists only those files that 
Determine File Sizes has determined are in need of resizing because the modulo is too small; ie 
part of the contents of the file are being stored in overflow.
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Files Too Big by Account

This report is similar to the All File Statistics by Account report, but lists only those files that 
Determine File Sizes has determined are in need of resizing because the modulo is too large; ie too 
much disk space has been allocated for the file.

Perform File Resizing 

Updates the file records with the suggested modulo and separation.

Note
The actual resize only takes place when an account-save or file-save is done, followed by an 
account-restore or file-restore.

This option updates all files selected by Determine File Sizes. You can manually adjust the sug-
gested options in individual files if required before the account or file-save is performed.

If you wish to resize only a few files then this may not be the best option. The Manually Resize A 
File option allows you to manually resize a single file, and also allows you to resize the file imme-
diately rather than at the next restore. See “Manually Resize a File” on page 145.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Account(s) to Resize (*=All)

The account names, delimited by a single space, whose files are to be updated with the resizing 
parameters. Enter ∗ for all accounts. 

Maintain Resizing Parameters

Allows you to manage the size of your files.

Manually Resize a File
Resizing parameters may be entered manually for files in the nominated account. You should run 
Determine File Sizes first to ascertain the current file size statistics.
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Pick

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to resize a file.

Prompts

Account Name

The account name containing the file to be resized.

File Dict Name

The name of the dictionary part of the file if the dictionary or data part is to be resized. Leave blank 
if the MD is to be resized.

File Data Name

The name of the data file to be resized. Leave blank if only the dictionary part of the file is to be 
resized.
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Resize History Shows Average Growth Is %

The calculated average growth of the file. (Display only).

Growth % over period of days is %

The expected growth percentage (%) over the period shown. This figure is used in calculating the 
resize parameters.

No of Items

The number of records held in the file being resized. (Display only).

Average Size

The average size of the records in the file being resized. (Display only).

Present Modulo

The current number of frames specified as the primary allocated size. (Display only).

Util %

The percentage of the total file size being utilized. (Display only).

Growth %

The percentage growth allowed each time the file is resized. This is determined by the parameters 
specified in the Maintain Global Tuning screen. (Display only).

Since Date

The date of the last resize. (Display only).

New Size (Modulo)

The suggested new modulo for the file, which you may accept or change.

Resize File Immediately, Rather Than On Next Restore (Y/N)

Options are:

Y resizes the file immediately. This is achieved by copying the file contents to a temporary 
file, deleting the original and recreating the file being resized with the new modulo. The 
SB+ Server Administration Manual 147



Chapter 4 - Admin Menu  
file contents are then copied back from the temporary file, and the temporary file is 
deleted. Ensure other users are not accessing the file to be resized during this process.

N resizes the file when the next account or file restore is performed.

uniVerse, UniData

Note
The above screen relates to UniData. The equivalent screen for uniVerse is similar.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to resize a file.
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Prompts

Account Name

The account name containing the file to be resized.

File Dict Name

The name of the dictionary part of the file. Leave blank if the MD is to be resized.

File Data Name

The name of the data file to be resized. Leave blank if only the dictionary part of the file is to be 
resized.

Resize History Shows Average Growth Is %

The calculated average growth of the file. (Display only).

Growth % Over Period of days is %

The expected growth percentage (%) for the file over the period shown. This figure is used in cal-
culating the resize parameters. 

No of Items

The number of records held in the file being resized. (Display only).

Average Size

The average size of the records in the file being resized. (Display only).

Util %

The percentage of the total file size being utilized. (Display only).

Growth %

The percentage growth allowed each time the file is resized. This is determined by the parameters 
specified in the Maintain Global Tuning screen. (Display only).
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Since Date

The date of the last resize. (Display only).

Present Modulo

The current modulo for this file. (Display only).

Recommended Modulo

Press the Enter key to accept the new recommend modulo, or enter a new value. The value should 
be a prime number.

Present Type - uniVerse only

The current file type for this file; eg 18 for a Pick type file. (Display only).

Present Separation uniVerse only

The current separation for this file. (Display only).

Recommended Type - uniVerse only

An (optional) new file type, otherwise the current type is assumed.

Recommended Separation - uniVerse only

Press the Enter key to accept the recommended separation, or enter a new value.

Resize File Immediately (Y/N) - uniVerse only

Options are:

Y resizes the file immediately. This is achieved by exercising the uniVerse RESIZE com-
mand.

Warning
Ensure other users are not accessing the file to be resized during this process.

N resizes the file when the next account-restore or file-restore is performed.
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Fine Tune A File Resizing
Allows you to set defaults for files that may grow in a nonstandard manner.

UniData

Note
The uniVerse screen is similar to the UniData screen shown above.
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Pick

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Account Name

The account name containing the file to be manually fine-tuned.

File Dict Name

The name of the dictionary part of the file if the dictionary or data part is to be fine-tuned. Leave 
blank if the MD is to be fine-tuned.
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File Data Name

The name of the data part of the file. Leave blank if only the dictionary part of the file is to be 
resized.

No. of Items

The number of records held in the file being resized. (Display only).

Average Size

The average size of the records in the file being resized. (Display only).

Util %

The percentage of the total file size being utilized. (Display only).

Growth %

The percentage growth allowed each time the file is resized. This is determined by the parameters 
specified in the Maintain Global Tuning option. (Display only).

Since Date

The date of the last resize. (Display only).

New Size (Modulo) - Pick

The recommended new modulo for the file (Display only).

Resize History Shows Average Growth is %

The calculated average growth of the file. (Display only).

Growth % Over Period of days is %

The expected growth percentage over a period of the number of days shown. This figure is used 
within the calculation determining file size.
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Tolerance % Before Resizing is %

A tolerance level determining whether or not the file needs to have a new size suggested. The sug-
gested new modulo is compared to the current modulo and if the percentage difference between the 
two is greater than the tolerance percentage, the resize suggestion is written to the file. 

Eg if the tolerance figure is 0%, then the file is always resized, assuming the new modulo is differ-
ent from the current one. This figure overrides the default tolerance for this file, specified in the 
next menu option.

Minimum Modulo to Accept is

A minimum modulo for the file, regardless of the number of existing records.

Present Type - uniVerse

The current file type for this file; eg 18 for a Pick type file. (Display only).

Present Modulo - UniData, uniVerse

The current modulo for this file. (Display only).

Present Separation - uniVerse

The current separation for this file. (Display only).

Recommended Type - uniVerse

The new file type, if different from the current type is assumed. (Display only).

Recommended Modulo - Unidata, uniVerse

The new recommend modulo, or enter a new value. The value should be a prime number. (Display 
only).

Recommended Separation - uniVerse

The recommended separation. (Display only).
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Maintain Global Tuning

Allows you to specify global parameters used by SB+ to calculate the resize suggestions put for-
ward by the system.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Default Tolerance before resizing %

The default tolerance value to be used for all files in all accounts when determining suggested file 
resize parameters. The default tolerance value is used by SB+ to determine whether or not a file is 
to have a new size suggested. If the percentage difference between the recalculated modulo and the 
current one is less than the percentage entered here, the new modulo is ignored.

If a specific file is to have an alternative tolerance figure, you may specify one using the Fine Tune 
A File Resizing option.

Resize Growth Period Days

The default growth period (in days) within the resize calculation. This is used as a default for all 
files and all accounts.

Eg if the growth period is defined as 30 days, SB+ attempts to project what the file sizes will be 30 
days into the future based on past growth.
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Perform House Keeping

Provides options for removing redundant resize statistics and suggestions for an account or file.

Remove Resize Suggestions

Allows you to remove resize suggestions for one or more accounts.

Function Key

F2 - Accept

Accepts the screen parameters and removes the resize suggestions.

Prompts

Account Name(s) (* = All)

The names of accounts, delimited by spaces, for which resize suggestions are to be removed. Enter 
∗ for all accounts.
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Clear Redundant History

Allows you to clear a file resize history for an account no longer on the system. When an account 
is deleted from the system, its history statistics remain. You should remove these for an account 
that is no longer required. However, if you think you might restore an account in the future, then 
you should retain its history statistics.

Function Key

F2 - Accept

Accepts the screen parameters and removes the file resize history.

Prompts

History Account Name (* = All Old)

The names of accounts to have their file resize history removed.

Purge Resize History

Allows you to clear the resize history for all accounts on the system.
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Warning
Use with care.

You are prompted for confirmation before proceeding.
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Printers & Terminals

The Printers & Terminals menu provides options for accessing all printer management functions 
and terminal definitions, and for mapping terminals and printers to your system ports.

Printer Management

The Printer Management option allows you to maintain the printers on your system and to con-
trol a report’s destination printer and stationery type. See “Appendix B - Printer Management” for 
a comparative overview of the previous and present printer management systems, and a discussion 
of various features of the present system. 
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This section deals with the new printer management system in general, using Pick screens to illus-
trate the various tools. See “Appendix C - Printer Management for uniVerse” and “Appendix D - 
Printer Management for UniData”, for differences between the respective printer management sys-
tems.

Where the screen image is specific to a particular platform, the screen is marked accordingly, oth-
erwise the screens are common across all platforms (See “Introduction” on page 113).

Physical Printer Definition - Pick

Process /PHYSICAL.PRINTER

The physical printer definition record allows you to define a physical printer entity, and to specify 
the characteristics of the actual printer in use for a given system port or device. 

These characteristics are dependent on the current OE, but are generally: the printer class, the 
device/port number, the number of form feeds after a print job, the coldstart setup flag, and the 
start and stop escape sequences (used to set a printer to the emulation required for the associated 
printer class, and reset if required after the completion of a job).
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The printer name you use is independent of any system specific number, name or device, but may 
be any of these (any alphanumeric name is acceptable). Eg the physical printer SYSTEM may 
describe the entity that is the main system printer on port 0. The device defined by SYSTEM may be 
one of several different types of printer, running under different emulations on different ports or 
devices.

If you are associating a class with the physical printer record then stationery types associated with 
a printer class must have system form queues defined for them, if form queues are supported by the 
OE. You may also allocate report types to the physical printer, using the F5 key.

The physical printer definition is used, with printer class and stationery type definitions, to create 
the PRINT.DEFN COMMON variable and associated runtime records in DMSECURITY. PRINT.DEFN 
is used in conjunction with the Printer Manager throughout SB+.

Function Keys

F2 - Save

Saves the physical printer definition. If the physical printer edited is the current printer in 
PRINT.DEFN, then PRINT.DEFN is automatically updated.

F4 - Del

Deletes the physical printer definition. If the definition is in use, deletion is prevented.
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F5 - Report Type

This subscreen allows you to enter report types defined by the System Administrator in the system 
administration account (SB+), and optional stationery types used when printing with the current 
physical printer. 

F7 - Location

This subscreen allows you to maintain the current physical printer’s location.

Locations for all physical printers may be maintained from the Maintain Locations option in the 
Admin > Printers & Terminals > Printer Management menu.

F10 - Action

Displays the action bar:

Print

Prints a detailed physical printer definition report. Output may be redirected.
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Copy

Copies physical printer definitions.

Help

Displays a menu of additional help options.

Prompts

Printer Name

The name of an existing physical printer to edit, or a suitable name to define a new physical printer. 

Current Location

The physical location of this printer. (Display only). 

Description

A meaningful description. Eg:

Main System Printer (Port 0)

Printer Class

The printer class contains control sequences relating to a class of printers. Associating a printer 
class with a physical printer means that the physical printer inherits the generic characteristics of 
the class.

You may change the associated printer class at any time. This allows you to redefine a physical 
printer in terms of the actual printing hardware being used at the time, but to retain the same iden-
tity.

Stationery Type

If this field is blank, the stationery type records associated with the printer class specified at the 
Printer Class prompt are displayed. You may then edit the field. You may delete stationery types 
not required for the current physical printer. If an accidental deletion occurs or the stationery type 
list needs to be expanded, the F3 key is available. Only stationery types defined for the class spec-
ified may be selected.
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Form Queue

If the OE supports form queues, you must assign a form queue to each stationery type. You may 
assign any form queue any number of times, even if the form queue is not defined in a currently 
started printer.

The Printer Manager leaves form queue manipulation to the OE as much as possible. Eg specifying 
a form queue that is not in a started printer, and printing using that stationery type may produce a 
hold job on the spool queue, which may be manipulated as required.

Device/Port No

The default value Port used by the Maintain Printers screen. The value may be overridden there.

Coldstart

Options are:

Y enables the F6-Update Coldstart Process (where applicable) in the Maintain Printers 
screen to update the USER-COLDSTART process (usually in the SYSPROG-PL file in the 
SYSPROG account), so that the specified printer automatically starts when the system is 
cold booted.

N the printer is not automatically started when the system is cold booted.

If a printer is deleted, the USER-COLDSTART process is not changed automatically.

Eject

The number of pages ejected after a print job. The default is 0 (ie no extra pages are ejected). This 
is in addition to the form feed at the end of most SB+ reports.

Start Sequence

An escape sequence to be sent at the start of every print job. You would usually use this to set a 
printer to the emulation mode required by the printer class associated with the physical printer 
entity for that printer. See “Escape Sequences” on page 33.

Stop Sequence

An escape sequence to be sent at the end of every print job. You would usually use this to reset a 
printer to native or another emulation mode if required. 
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Printer Class Definition - Pick

Process /PRINTER.CLASS

The printer class specifies the table of escape sequences (attribute, graphic, color etc) used by a 
family or class of printers. 
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Eg you may define the class EPSON.CLASS to contain the sequences for the Epson family of dot 
matrix printers. You may attach this class to any physical printer whose current physical device is 
an Epson dot matrix printer (or a printer with Epson emulation). You can switch the emulating 
printer to the Epson emulation by entering the switching sequence at the Start Sequence prompt 
in the Physical Printer Definition screen.

You may attach an unlimited number of stationery type records to the class. For each stationery 
type, you may define specific set, reset and page orientation sequences for printers supporting 
these sequences (such as laser printers).

The use of the printer class definition, with physical printer and other stationery type definitions, 
creates the PRINT.DEFN COMMON variable, and associated runtime records in DMSECURITY. 
PRINT.DEFN is used in conjunction with the Printer Manager throughout SB+.

Press to the Page Down key to display a follow-on screen, described following this section.

Function Keys

F2 - Save

Saves the printer class definition. If the printer class edited is the current class in PRINT.DEFN, then 
PRINT.DEFN is automatically updated.

F4 - Del

Deletes the printer class definition. If the definition is in use, deletion is prevented.
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F5 - Color

Displays the Printer Class Colors subscreen, if Y is entered at the Color prompt. This subscreen 
lets you define foreground and background colors for a color printer. 

At present, the Printer Manager does not support color printing; however, the table is stored in 
PRINT.DEFN, and may be referenced in reports or user subroutines.
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F8 - Stationery Types

This subscreen allows you to maintain stationery types. See “Maintain Stationery Types” on 
page 183.
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F9 - Seq+

This subscreen allows you to enter additional printer control sequences that may be accessed by 
the user but which are not otherwise used by SB+. For convenience, physical printer type 
sequences (ie those relating to the physical device) are entered separately from stationery type 
sequences, which refer to form related sequences.

F10 - Action

Displays the action bar:

Print

Prints a detailed printer class definition report. Output may be redirected.

Copy

Copies printer class definitions.

Help

Displays a menu of additional help options.
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Prompts

Printer Class

The name of an existing printer class to edit, or a suitable name to define a new printer class. 

Description

A meaningful description. Eg Epson LQ Printers.

Graphics Description

The description of each character when displayed in graphics mode. (Display only).

Characters

Characters may be entered either as the printable character (where the character is printable) or as 
the ASCII equivalent of the character, enclosed in parenthesis.

Graphics Mode On

An escape sequence to switch on the printer’s graphics mode. Check your printer documentation to 
ascertain the correct sequence. See “Escape Sequences” on page 33.

Graphics Mode Off

An escape sequence to switch off the printer’s graphics mode. Check your printer documentation 
to ascertain the correct sequence. 

Stationery Type

A stationery type may be associated with any number of printer classes, but may be specified only 
once within the same class.

Set

An escape sequence to switch the printer to the stationery type setting. This is usually required for 
memory mapped printers such as laser or inkjet devices. Check your printer documentation to 
ascertain the correct sequence. 
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Reset

An escape sequence to reset the printer's stationery type setting. Check your printer documentation 
to ascertain the correct sequence. 

Orientation

An escape sequence to set the printer's page orientation mode. Check your printer documentation 
to ascertain the correct sequence. 

Supp FF

A flag to indicate whether automatic form feeds should be suppressed.

Options are:

Y prints every line. Form feeds are not required.

N Report Writer should send a form feed to advance to the next form.

Color

Options are:

Y allows color printer escape sequences to be defined.

N does not allow color printer escape sequences to be defined.

Standard Columns

Where a printer class has no stationery type defined (which is a valid condition), the value entered 
at this prompt is used to set the page width for printing.

Standard Rows

Where a printer class has no stationery type defined (which is a valid condition), the value entered 
at this prompt is used to set the page depth for printing.

Condensed Columns

This parameter is used in Report Writer to set the report width for condensed printing where the 
standard printer width is greater than 80 columns. The parameter is not otherwise used by SB+, but 
is available for user processes. The parameter is located in the COMMON variable 
PRINT.DEFN<5,4>.
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Condensed Rows

This parameter is not used by SB+, but is available for user processes. The parameter is located in 
the COMMON variable PRINT.DEFN<5,5>.
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Printer Class Definition (follow-on screen)

You may display this screen using the Page Down key from the previous Printer Class Definition 
screen.
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Note
Function keys are the same as the main screen, except that there is no F9 - Seq+ function key.

Prompts

Print Attributes

The printer class. (Display only).

Description

A description for each print attribute escape sequence. SB+ is shipped with predefined escape 
sequence descriptions, which the Printer Manager uses when printing Report Writer reports. You 
may enter new attribute descriptions and sequences, and refer to them in processes or subroutines. 
The on-sequences are stored value-delimited in attribute 3 and the corresponding off-sequences are 
stored value-delimited in attribute 4 of the COMMON variable PRINT.DEFN.

On Sequence

An escape sequence to select the attribute for the printer. Check your printer documentation to 
ascertain the correct sequence. See “Escape Sequences” on page 33.

Off Sequence

An escape sequence to deselect the attribute for the printer. Check your printer documentation to 
ascertain the correct sequence. 
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Maintain Printers - Pick

Process /LISTPTRS

Allows you to specify details for each printer attached to the system so that a new printer may be 
started, or an existing printer stopped.

To stop a printer, place the cursor on the first field of the required printer line and press the delete 
line edit key (defined for your terminal). On pressing the F2 key to accept the screen, the printer is 
stopped.
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Function Keys

F2 - Accept

Accepts the current screen and starts/stops printers.

F5 - Restart Printer

Restarts the printer the cursor is on. 

F6 - Update Coldstart Proc

Updates the USER-COLDSTART process. Most systems have a USER-COLDSTART process, or some-
thing similar, which allows you to automatically configure and start serial devices, such as termi-
nals and printers. Use this function to include the current printer defined by this physical printer.

F9 - Print Jobs

Invokes the Maintain Spooled Reports option.

Prompts

Printer No.

The unique number associated with the printer (ie the OE identifier).

Name

The name of the physical printer (use the F3 key or enter the name directly). Defaults defined in 
the physical printer record are displayed, and may be amended. The current location, if any, is dis-
played.

Location

The location of the printer. (Display only).

Form Queue(s)

Numbers between 0 and 255 representing the form queues that are directed to this printer.

FF Pg

The number of pages ejected (form feeds) after the print job is actually printed.
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Printer Type

Options are:

S Serial.

P Parallel.

See your printer documentation. 

Port

The port number to which the printer being defined is physically connected. A parallel printer is 
usually connected to port 0.

Start Options

Options to determine the start position of the printer at the top of the form and the number of lines 
on each page. The F3 key displays the Start Printer Options screen, which provides additional 
prompts to help determine the options required:

Prompts for the Start Printer Options subscreen:

Align Printer’s Top of Form Position

Options are:

Y sends a form feed prior to printing.

N does not send a form feed prior to printing.

Printer Support Form Feed Character (Y/N)

Options are:
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Y printer automatically skips to top of form. 

N allows you to define the number of lines on a page (at the next prompt).

Page Length as Number of Lines

The number of lines to be printed on each page. 

Ignore Initial Form Feed On Serial Printer

Options are:

Y starts printing immediately at the current position. 

N performs a form feed before printing.

Sh (AP only)

Options are:

Y starts printer as an AP shared printer. 

N starts printer as a normal printer

Status

The current status of the printer, which may be ACTIVE or INACTIVE. (Display only).
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Assign Printer to a Report

Process /PTR.TO.REPORT

The Assign Printer to a Report screen allows you to specify print parameters for Report Writer 
and Query reports that override the standard print defaults in the Printer Selection screen. These 
may be modified, subject to location restrictions, if you have access to the Printer Selection 
screen. If not, the print parameters passed are used by the Printer Manager to set up printing for the 
report. 
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You may also assign printers to a report using the Additional Report Parameters subscreen from 
the PD.R (Report Writer) and PD.E (Query) process definition screens:

This and the Assign Printer to a Report screen are functionally the same, except that the Assign 
Printer to a Report screen prompts for a Query or Report Writer process definition, whereas the 
Additional Report Parameters subscreen is called from PD.E/PD.R with the process definition 
available.

Function Keys

F2 - Accept

Accepts the screen parameters.

F4 - Delete Printer Parameters

Clears all printing options for the report process definition.
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F5 - Aux Parameters

The auxiliary output parameters can be set specifically for individual reports using the new 
PD.RD.ADDIT.AUX process. This process is accessed from the PD.R screen > F9 – Additional 
Report Parameters > F6 – Aux Parameters:

The parameters entered here overwrite any other option set using other Print Default screens and 
processes. The value of the Disp Aux Sel Screen flag in this case can be one of the following:

A - Always Display SB+ Print Selection Screen.

N - Never Display SB+ Print Selection Screen. 

W - Display Windows Print Setup Screen Only.

Prompts

Process Name

The name of a Report Writer or Query process definition. (Assign Printer to a Report only).

Description

Displays the process definition description. (Assign Printer to a Report only). (Display only). 

Phys. Printer Name

A physical printer name. You may enter an expression in parenthesis to be evaluated at runtime.
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Stationery Type

The stationery type for this report. The stationery type must be associated with the physical printer 
specified above. If a physical printer is not specified, you may select a stationery type from the cur-
rent default physical printer. As a stationery type selected in this way may not be valid when the 
report is run, a warning message is displayed. You may enter an expression in parenthesis to be 
evaluated at runtime.

Spooler Options

Use the F3 key to display a list of available options, or consult your OE documentation. You may 
enter an expression in parenthesis to be evaluated at runtime.

No. of Copies

The number of copies for this report (1 to 125). You may enter an expression in parenthesis to be 
evaluated at runtime.

Report Type

A report type for this report (The F3 key provides a list of report types). See “Maintain Report 
Types” on page 187 later in this chapter for more information on report types.

Disp Print Sel Screen

Forces the display mode for the Printer Selection screen for the current report process. Options 
are:

A forces the Printer Selection screen to be displayed, irrespective of the current user’s dis-
play flag setting in Security > User Security Setup. (See “User Security Setup” on 
page 92).

N prevents the Printer Selection screen from being displayed, irrespective of the current 
user’s display flag setting in Security > User Security Setup. 

Leave this field blank if you wish to use the user’s display flag setting.

Form Feeds At Start

The number of form feeds to be sent to the printer before the report is printed.
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Form Feeds At End

The number of form feeds to be sent to the printer at the end of the report.

All fields in PD.R and all but the first two fields in PTR.TO.REPORT are optional. Partial completion 
of the first four printer related fields will result in a partial replacement of the Printer Selection 
screen parameters (ie the displayed parameters will contain the standard default parameters where 
the equivalent report parameter is blank).

Maintain Stationery Types

Process /STATIONERY.DEFN

Allows you to define the standard columns and rows for the type of stationery you specify. You 
may define any type of stationery.

The stationery type is an entity independent of the printer class it may be associated with. Eg the 
A4 stationery type may be associated with any number of classes without the need for redefinition. 
Class specific printer sequences that configure the printer to be able to print on this stationery are 
defined separately for each class the stationery type is associated with.

SB+ uses the stationery type definition, with physical printer and printer class definitions, to create 
the PRINT.DEFN COMMON variable, and associated runtime records in DMSECURITY.

PRINT.DEFN is used in conjunction with the Printer Manager throughout SB+ generally, and may 
be used within user subroutines.
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Function Keys

F2 - Save

Saves the stationery type definition.

F4 - Del

Deletes the stationery type definition.

Prompts

Stationery Type

The name of an existing stationery type to edit, or a suitable name to define a new stationery type.

Description

A meaningful description. This is a multivalued field.

Standard Columns

Sets the page width for printing.

Standard Rows

Sets the page depth for printing.
184 SB+ Server Administration Manual



Printers & Terminals
Maintain Locations

Process /LOCATION.DEFN

Allows you to define a location, and a list of physical printers grouped in that location. A location 
does not have to contain physical printers. When a physical printer is added to a particular loca-
tion, it may not be assigned to another location without being moved from its current location 
using the F5 key.

You may use locations to limit access to printers by users in a security group. Use the F8 key in the 
Group Security Setup screen to invoke the Report Locations subscreen, allowing you to specify 
available locations for a group. If the location you specify does not exist, and you wish to create it, 
the Location Definition screen is displayed. 

At any given level, a group has available only those locations entered for its parent group. An 
empty location list in Group Security means that physical printers in all locations available to the 
parent of the current group may be specified. If the group and all parent groups have an empty list, 
all locations are available to the group.
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Function Keys

F2 - Save

Saves the location definition.

F4 - Del

Deletes the location definition.

F5 - Move Printer

Allows you to move physical printers. Pressing the F5 key at the Physical Printers prompt 
requests the location to move to. Once copied to the new location, the physical printer is removed 
from the current location.

Prompts

Location

The name of an existing location to edit, or a suitable name to define a new location.

Description

A meaningful description.

Physical Printers

The physical printers entered here are grouped in the location for security checking. A physical 
printer may only be in one location at a time.
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Maintain Report Types

Process /REPORT.TYPE.DEFN

Report types provide a method of matching Query and Report Writer reports to printers. A single 
valid report type code may be associated with a report, and a list of valid codes may be associated 
with a physical printer. You may use any code for any physical printer.

If a valid code is present in a report being printed, and a list of valid codes is present for the physi-
cal printer being selected, an attempt is made to locate the report's code in the physical printer's 
list. If not found, the report cannot be printed using the selected printer. Printing to the selected 
printer is allowed if either the report has no valid code, or the physical printer has no list.

A central list of valid report types is stored in the REPORT.TYPES record in the DMSYSDEFN file. 
This screen maintains a multivalued list of report type codes. Codes may be in any format, but 
must be unique. You may optionally enter a description for each code. This table of report types is 
used in all systems across all accounts.
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Developers should note that, as the report types table is global, you will need to consider unique-
ness when creating report types for your application. When the application is installed at a cus-
tomer site, it is necessary to manually update the report type table during installation.

Function Key

F2 - Save

Saves the report type definition.

Prompts

Report Type

A unique character string to define a report type.

Description

A meaningful description for the report type. This is used in intuitive help.
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Maintain Spooled Reports

Process /LISTJOBS

Allows you to view/maintain the print jobs currently held in the spooler queue. You may delete 
spooled entries or alter the printing parameters, such as the number of copies and whether or not 
the report is to be held in the spooler even after it has been printed.

To delete a print job from the spooler, place the cursor on the first field of the line displaying the 
print job and press the delete line edit key (defined for your terminal). On pressing the F2 key to 
accept the screen, the job is deleted from the spooler. 

Function Keys

F2 - Accept

Accepts the screen parameters.
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F5 - Preview

Displays the first 500 bytes of the current entry number.

F6 - Look

Displays the current job.

F9 - Printers

Invokes the Maintain Printers screen.

Prompts

FormQue

The form queue used when the job was sent to the spooler. Enter an alternative form queue if 
required.

Ent

The entry number of the print job in the spooler. (Display only).

Lnk

Print jobs which are ready to be output (eg which are closed and not held) are linked together in the 
order they will be sent to the printer. The link indicates the next job to be printed when this one is 
completed. (Display only).

Co

The number of copies required for this print job. 

Status

The option to determine the action to be taken on this print job. See your OE documentation.

Frames

The size of the print job in frames. (Display only).
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Ptr

The number of the printer on which this print job is printed. (Display only).

Date

The date this print job was created. (Display only).

Time

The time at which this print job was created. (Display only).

Lne

The port number on which the print job was initiated. (Display only).

Account

The account in which the user was logged on when the print job was initiated. (Display only).

Kill Current Job

Process /PTR.KILL0

Allows you to stop printing the currently spooled job. You are prompted for confirmation of this 
action.

Initialize Spooler - Pick

Process /PTR.INIT

Allows you to reinitialize (clear the spooler) and return to normal operation. Use if corruption has 
occurred in the spooler. Reports may be lost.
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Prompts

Kill All Spooler Entries (Y/N)

Options are:

Y deletes all entries in the spooler queue. These jobs are lost and cannot be recovered.

N leaves jobs in the spooler queue.

Enter ‘C’ to Confirm

Options are:

C confirms reinitialization of the spooler with the option determined at the previous prompt. 

N (the default) returns to the previous menu, with no action taken.
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Terminal Definitions Screen 1

Process /TERM.DEFN

Allows you to define and maintain terminal definitions for use with SB+. Many common terminal 
definitions are supplied with SB+ and may be amended.
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Terminal Definitions comprises this screen and two follow-on screens (i.e. tabs) which are 
described following this section. You may access the follow-on screens using the Page Down key. 
Function keys for these three screens are described below.

You may change your current terminal definition on-the-fly using the CHANGE.TERMINAL process. 
The new terminal definition is loaded into the COMMON variable TERM.DEFN, and any OE 
related terminal commands performed. For example, at logon, you may have entered the incorrect 
terminal type. If you are still able to enter text, running this process will correct the terminal defini-
tion.

Note
When changing terminal definitions, previously stacked screens may not be redisplayed correctly 
as these are stored internally with embedded cursor/video attribute sequences that may no longer 
be valid. Exiting to the OE shell, then re-entering SB+ via the MM command will correct any screen 
problems.

Function Keys

F2 - Save

Saves the current terminal definition.

F4 - Del

Deletes the current terminal definition.

F5 - Colors (if used from screen 1)

If Y is entered at the Support Color prompt this displays the Terminal Colors subscreen. This 
allows you to define the colors to use for prompts, inputs, error messages, and so forth (only if 
your terminal supports color). (See “Terminal Colors F5” on page 203).

GoTo MV (if used from screens 2 and 3)

Invokes the GOTO.MVLINE process. This allows you to move quickly around several pages of data, 
by entering:

• a line number, or
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• the letter P and a page number, or

• part of the text found under the Description or Edit Function headings.

F6 - Cursor (if used from screens 1 and 2) 

Displays the Cursor Definition Parameters subscreen, which allows cursor addressing to be spe-
cifically defined for the current terminal type. This should only be used if problems are experi-
enced with the default cursor addressing. (See “Cursor Definition Parameters F6” on page 206).

F6 - Pointer (if used from screen 3) 

Displays the Pointer Device Parameters subscreen, which allows you to define the pointer device 
if the pointer device does not work correctly, or if a nonstandard mouse or touch screen device is 
being used. (See “Pointer Device Parameters F6” on page 209).

F7 - Keys+

Allows you to enter an existing edit key function number for which you wish to specify an addi-
tional or alternative key definition. (See “Additional/Alternative Keys F7” on page 212).

F8 - Download

Specifies the character sequence or processes to be downloaded to the terminal when logging on. 
This ensures that the keyboard will work as specified in the definition. (See “Download Character 
Sequence F8” on page 214).

F9 - Seq+

Allows additional terminal characteristics to be setup. These are held in the COMMON variable 
TERM.DEFN<19>. (See “Additional Terminal Sequences F9” on page 216).

F10 - Action

Displays the action bar:

Print

Prints selected terminal definitions.

Copy

Copies a terminal definition to another name. 
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Help

Displays a menu of additional help options.

Prompts

Terminal Id

An id or name for the terminal definition. SB+ provides a number of commonly used definitions. 
Every terminal type must have a terminal definition specifying edit keys and graphics characters. 

DEFAULT.TERM works for all terminal types. This definition uses standard keys and simple graph-
ics characters, and is used if no terminal id is specified for a port in the Terminal Configuration 
screen or the user definition. This terminal definition allows you to use SB+ prior to defining a 
specific definition for your terminal type. We recommend that a terminal definition specific to your 
terminal type be defined to enable you to take advantage of your own keyboard layout while using 
SB+. This definition can then be specified for your port in the Port Configuration screen, 
described later.

Description

A description for the terminal id specified.

OE Term Type

The operating environment terminal type associated with this definition. This is used only for cor-
rect cursor addressing, and for clear screen, line and end of screen functions.

GUI Mode Enabled

Options are:

Y enables GUI mode when using this terminal definition. This only applies to terminal emu-
lators that support GUI mode.

N disables GUI mode.

Support Color (Y/N)

Options are:

Y the terminal being defined supports color. Once Y is entered, you may press the F5 key to 
define the colors.
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N the terminal being defined is monochrome.

Standard Columns

The number of columns displayed by the terminal being defined. See your terminal documentation 
for details. This is usually 80.

Standard Rows

The number of rows displayed by the terminal being defined. See your terminal documentation for 
details. This is usually 24. 

Condensed Columns

The number of columns displayed by the terminal when in condensed mode. See your terminal 
documentation for details. This is usually 132 when available.

Condensed Rows

The number of rows displayed by the terminal when in condensed mode. See your terminal docu-
mentation for details. This is usually 24, but may be 43.

Graphics Mode On

The character sequence sent to the terminal to turn on graphics mode, if supported. For control 
characters, enter the decimal ASCII value in parenthesis. This is used for drawing boxes and lines.

Many terminals are now able to draw box lines without switching to graphics mode. In this case, 
leave blank. See your terminal documentation for details.

Graphics Mode Off

The character sequence sent to the terminal to turn off graphics mode, if supported. See your ter-
minal documentation for details.

GRAPHIC BOX CHARACTERS

Description

Description for the graphics character to be defined at the next prompt. (Display Only).
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Characters

The character sent to the terminal to display the graphics character defined at the Description 
prompt. See your terminal documentation for details. These characters are used by SB+ when 
drawing windows and other graphic displays. If your terminal has a graphics character set (the 
ability to draw straight lines and corners) then these characters should be entered. Enter the deci-
mal ASCII value, enclosed in parenthesis, of the character to be used. Eg a horizontal character 
could be (113), (119) or (205).

Alternatively, if graphics mode is not supported, a normal display character to be used instead can 
be specified. Eg a vertical character might be |.

You are prompted for both single and double line characters. When defining windows in your 
application, you may specify the frame type (if you want single or double lines, or no lines).
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Terminal Definitions Screen 2

This screen is displayed by the Page Down key from the Terminal Definition screen 1. Function 
keys are as described for the Terminal Definition screen 1.
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Prompts

Terminal Id

The id or name for the terminal definition. (Display only).

Hidden Attributes

Options are:

Y the terminal being defined uses hidden video attributes that do not take up a character posi-
tion. See your terminal documentation if you are unsure of this.

N the terminal being defined does not use hidden video attributes.

Description

A description of the type of video characteristic for which a value must be entered at the next two 
prompts. (Display only).

ON Sequence

The character sequence to turn on the effect described at the Description prompt. See your termi-
nal documentation for details. The sequence required usually contains a mixture of control charac-
ters and normal characters. Enter control characters (such as ESC) by giving their decimal ASCII 
value in parenthesis. Eg the half intensity on-sequence for the Wyse60 terminal is (27)Gp.

OFF Sequence

The character sequence to turn off the effect described at the Description prompt. See your termi-
nal documentation for details. The sequence required usually contains a mixture of control charac-
ters and normal characters. Enter any control characters (such as ESC) by giving their decimal 
ASCII value in parenthesis. Eg the half intensity off-sequence for Wyse60 is (27)GO.
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Terminal Definitions Screen 3

This screen is displayed by the Page Down key from Terminal Definition screen 2. Function keys 
are as described for Terminal Definition screen 1.
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Prompts

Terminal Id

The id or name for the terminal definition. (Display only).

Edit Function

Describes the edit function for which a value must be entered at the next two prompts. (Display 
only).

Decimal ASCII Val

The decimal ASCII values generated by the key you wish to use for the edit function. To use the 
full text editing facilities that SB+ offers on all input prompts, a keyboard key (or keys) must be 
assigned to each function.

If you are defining the terminal definition for the terminal you are currently using and you do not 
know the value of the key you wish to define, press any non-numeric key. You are then prompted 
to press the key you require. SB+ returns the value of the key.

Note
By default, only keys that return a leadin character less than decimal 32 (space) may be used as an 
edit key. Use the F7-Additional/Alternative Keys > Limit Value of Displayable Characters 
prompt to change this value if required.

Key Description

The description to be displayed as part of the help for available edit keys. This is used to describe 
the keyboard key used to carry out edit functions and is shown whenever you invoke the /KEYS 
process to see what keys are defined for your terminal.
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Terminal Colors F5

This subscreen is displayed by pressing the F5 key from the Terminal Definition screen 1, if Sup-
port Color is Y.

Note
These values apply the color of character screens only. The color of GUI screens is determined by 
the appropriate GUI Default Set.
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Function Key

F2 - Accept

Accepts the terminal color parameters.

Prompts

Colors

The available colors. Each color has a number displayed beside it. Use these numbers as references 
when defining the default color combinations for Deflt Menu and Deflt Screen. (Display only).

Foreground

The character sequences for the appropriate foreground color.

Background

The character sequence for the appropriate background color.

Deflt Menu

The background, highlight letter, lowlight letter, select background, select foreground and unavail-
able foreground color numbers as a default for menus. Separate numbers with commas. Eg 8, 6, 2, 
2, 16,12.

Note
These colors may be overridden for any individual menu.

The F3 key provides a list of available colors. 

Deflt Screen

The background, foreground and prompt color numbers to be used as a default for screens. Sepa-
rate numbers with commas. These colors may be overridden for any screen.
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Help Colors

The background, highlight and lowlight color numbers for help screens. Separate numbers with 
commas.

Std Back/Fore

The standard background and foreground colors to be used by SB+. Separate numbers with com-
mas.

Lookup B/F

The background, foreground, low intensity, select background and select foreground color num-
bers to be used in the lookup windows. Separate numbers with commas.

Prompt B/F

The background and foreground numbers to be used in prompts on the prompt line. Separate num-
bers with commas.

Functkey B/F

The background and foreground color numbers to be used in displaying the function key status 
line. Separate numbers with commas.

Error B/F

The background, highlight text, lowlight text, select background and select foreground color num-
bers to be used in error message display. Separate numbers with commas.

Dialog Box

The background, highlight text, lowlight text, select background and select foreground color num-
bers to be used in dialog box display. Separate numbers with commas.
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Cursor Definition Parameters F6

This subscreen is displayed by pressing the F6 key from the Terminal Definition screens 1 & 2. It 
allows cursor addressing to be specifically defined for the current terminal type, if problems are 
experienced with the default cursor addressing.

The information in this screen is used by SB+ functions like ‘smart screen refresh’, to parse text 
and cursor directives from screen images. It does not affect the operation of the terminal device 
itself.

Function Key

F2 - Accept

Accepts the cursor definition parameters.
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Prompts

ANSI Mode (Y/N)

Options are:

Y the terminal uses ANSI cursor address sequences.

N the terminal uses ASCII type sequences.

Press F3 to generate the default information.

Leadin Sequence

The cursor leadin sequence. Eg the ANSI leadin sequence would be (27)[

Column First

Options are:

Y the column is sent first in the cursor address sequence.

N the row is sent first in the cursor address sequence.

Col and Row Separator

The column and row separator if there is one, otherwise leave blank.

Terminating Sequence

Terminating character for the cursor sequence if there is one, otherwise leave blank (ASCII 
sequences usually have one).

Col Base Offset

A numeric offset value that is to be applied to the column value. Enter 0 for none.

Row Base Offset

A numeric offset value that is to be applied to the row value. Enter 0 for none.

Col Increments in BCD

Options are:
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Y the column value increments in BCD (Binary Coded Decimal) format.

N the column value does not increment in BCD format.

Row Increments in BCD

Options are:

Y the row value increments in BCD format.

N the row value does not increment in BCD format.

Clear Screen & Home

The sequence that, when sent to the terminal, clears the screen and moves the cursor to the top left-
hand corner.

Clear to End Of Line

The sequence that, when sent to the terminal, clears the line from the current cursor location to the 
end of the current screen line.

Clear To End Of Page

The sequence that, when sent to the terminal, clears the screen from the current cursor location to 
the end of the current screen page.

Clear Screen to Pattern

The sequence that, when sent to the terminal, clears the screen to a background pattern.
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Pointer Device Parameters F6

This subscreen is displayed by pressing the F6 key from Terminal Definition screen 3. It allows 
you to define the pointer device if the pointer device does not work correctly, or if a nonstandard 
mouse or touch screen device is being used.

Function Key

F2 - Accept

Accepts the pointer device parameters.
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Prompts

Pointer Device Code

The pointer device code, if you are using a pointer device other than the default mouse type sup-
plied.

Type 1 allows use of a mouse device which returns sequences in the standard mouse format. Types 
2 and 3 allow the use of high and low resolution touch screen devices.

Type 4 allows entry of a user defined device. Type 4 parameters are entered at the following 
prompts:

Pointer Sequence Length

The number of characters in the string returned by the device if it has a fixed length, or 0 if it has a 
variable length terminated by a carriage return. (Type 4 only).

Button Delimiter Character

The delimiter character surrounding the button number, if present. This is used for field extrac-
tions. Leave blank for the position,length extraction method. (Type 4 only).

X, Y Delimiter Character

The delimiter character used to delimit the X and Y values. This is used for field extractions. Leave 
blank for the position,length extraction method. (Type 4 only).

Button Field/Pos, Len

The field extraction position of the button value or if there is no delimiter, its position,length in a 
fixed length string. (Type 4 only).

X value Field/Pos, Len

The field extraction position of the X co-ordinate or if there is no delimiter, its position,length in a 
fixed length string. (Type 4 only).

Y value Field/Pos, Len

The field extraction position of the Y co-ordinate or if there is no delimiter, its position,length in a 
fixed length string. (Type 4 only).
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ButtonBar Field/Pos, Len

The field extraction position of the ButtonBar value or if there is no delimiter, its position,length in 
a fixed length string. (Type 4 only).

X Converstion Code Method

The conversion code method to apply to the X co-ordinate. (Type 4 only).

Options are:

0 value is decimal, no conversion. 

1 Hexadecimal to decimal. 

2 sequence value SEQ().

Y Conversion Code Method

Conversion code method to apply to the Y co-ordinate. (Type 4 only).

Options are:

0 value is decimal, no conversion. 

1 Hexadecimal to decimal. 

2 sequence value SEQ().
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Additional/Alternative Keys F7

This subscreen is displayed by pressing the F7 key from any of the Terminal Definition screens.

Enter an existing edit key function number for which you wish to specify an additional or alterna-
tive key definition. Eg the delete line function may be mapped to the Shift-Del key but some users 
may prefer other standards that they are more accustomed to, such as Ctrl V.

Function Key

F2 - Accept

Accepts the additional/alternative key parameters.
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Prompts

Limit Value of Displayable Characters

The range of non-standard edit keys is from CHAR(32) up to the value of this field, which is 
assumed to be 256 if blank. Enter a value here if any edit key leadin sequences commence with a 
character greater than decimal 128 for the current terminal type.

Eg function key sequences on some terminals have a leadin character of CHAR(155). In this case, 
set the limit to 155. If the limit is set too low, some graphic and/or foreign character sets may not 
be entered from the keyboard.

Edit Key Function

The existing edit key function number for which you wish to specify an additional or alternative 
key definition.

Decimal ASCII Val

The decimal ASCII values generated by the key you wish to use for the edit function. To use the 
full text editing facilities that SB+ offers on all input prompts, a keyboard key (or keys) must be 
assigned to each function.

If you are defining the terminal definition for the terminal you are currently using and you do not 
know the value of the key you wish to define, press any non-numeric key. You are then prompted 
to press the key you require. SB+ returns the value of the key.

By default, only keys that return a leadin character less than decimal 32 (space) may be used as an 
edit key. F7-Limit Value of Displayable Characters prompt.

Key Description

The description to be displayed as part of the help for available edit keys. This is used to describe 
the keyboard key used to carry out edit functions and is shown whenever you invoke the /KEYS 
process to see what keys are defined for your terminal.
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Download Character Sequence F8

This subscreen is displayed by pressing the F8 key from any of the Terminal Definition screens.

Function Keys

F2 - Accept

Saves the download character sequence parameters.

Prompts

Download Recovery Time (Seconds)

The number of seconds delay (required for some terminals before they can accept other data) after 
downloading the download character sequence defined in the Download Sequence prompt below.

Execute DownLoad when Switching Accounts

Options are:
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Y resends the download sequence in the next field when switching to another SB+ account 
via the LOGTO process. 

N (default) does not resend the download sequence when switching to another account. 

Download Sequence

A character sequence to set the keyboard characteristics and the terminal setup. This is down-
loaded to the terminal when logging on. This ensures that a terminal will operate as required by 
setting the internal programmable functions of the terminal to the values used in SB+. Characters 
not normally entered through the keyboard may have their decimal ASCII value specified in paren-
thesis. See your terminal documentation for details of the sequences required.

A sequence may occupy as many lines on the screen as necessary. You may also enter ;∗text after a 
download sequence, where text is a comment describing the effect of the sequence. Lines com-
mencing with ;∗  are ignored. If the line commences with >: then the remainder of the line is exe-
cuted as a shell sentence. (All >: shell sentences are executed before any of the download 
sequences, irrespective of where they are defined in the download sequence).
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Additional Terminal Sequences F9

This subscreen is displayed by pressing the F9 key from any of the Terminal Definition screens. It 
allows you to define any additional data that is dependent on the type of terminal in use. Take care 
to define information in the same sequence for all terminal definitions used in your system.

Function Key

F2 - Accept

Accepts the additional terminal sequence parameters.
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Prompts

Description

A description for the terminal sequence to be entered.

Sequence

The terminal sequence required. Eg if you are defining a cash register terminal, you may want to 
define the sequence to open the cash drawer.

Details are held in attribute 19,x of the COMMON variable TERM.DEFN. This can be accessed in 
expressions and user subroutines. 

Characters not normally entered through their keyboard may have their decimal ASCII value spec-
ified in parenthesis. Eg The Esc key would be (27).
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Port Configure

Process /TERM.CONFIG

Allows you to define your system's port configuration. You can define terminals, printers, auxiliary 
printers and the baud rate of each port.

On some systems the ports are dynamically allocated at logon, and you cannot rely on the port 
setup as defined. To eliminate this problem, SB+ allows you to define ASK or ASK(name) as the 
type of terminal and/or printers. This will then prompt the user at logon to nominate the terminal 
and printer types being used.
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You may also link the terminal/printer to each user if this is more appropriate to your installation. 
See “Setting Print Defaults” on page 360.

Function Keys

F2 - Save

Saves the port configuration parameters.

F5 - Sort

Sorts entries by port number, if used at the Port prompt. The sort sequence may be specified.

F6 - Coldstart - Pick

Places the specified baud rates and printer start commands in the USER-COLDSTART process. This 
ensures that printers are started and baud rates set whenever the machine is powered up.

F7 - Terminals

Displays the Terminal Definition screen. If the cursor is at a Terminal Id prompt with an id 
entered, when the F7 key is pressed, the id is passed to the terminal definition process.

F8 - Printers

Invokes the Physical Printer Definition screen. If the cursor is at the Printer Name prompt with 
a name entered when the F8 key is pressed, the name is passed to the printer definition process.

F9 - Default

Allows you to define default values to be used by SB+ when terminal and printer id prompts for a 
port are left blank. 

Note that users may have their own list of terminal/printer ids specified in their user definition 
record, to be consulted if the defaults specified here are left blank or are multiple choice. (See 
“Default Terminal/Printer Specification F9” on page 221).

F10 - Action

Displays the action bar:
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PC Monitor

If you are using a PC monitor and terminal definition PCMON (or PCMON.COL) you need to run 
this function once initially. It assigns values to some of the keys (such as Ins, Del, Page Up, Page 
Down), otherwise these keys are undefined.

Prompts

Port

The port number that the device is connected to on the system. 

T/P

The device type. Options are:

T the port has a terminal connected.

P the port has a printer connected.

Terminal Id

The terminal id if the port is connected to a terminal. The terminal id must be defined in the Ter-
minal Definition screen, described previously (or via the F7 key). This id refers to a terminal def-
inition containing details of the edit keys and graphics characters to be used for that type of 
terminal.

If a terminal id is not specified here, SB+ will use the terminal id specified in the F10 - Default 
Terminal/Printer Specification subscreen.

If no terminal id is specified using the F10 key, SB+ uses the terminal id specified for the user as 
indicated in Security > User Security Setup (See “User Security Setup” on page 92).

If no terminal id is specified for the user, SB+ uses a default terminal id called DEFAULT.TERM.

If ASK is entered, the terminal id is prompted for at logon. ASK(xx) defaults to id xx.

Printer Name

The physical printer name for the printer usually assigned to this port. The physical printer must 
have been defined in the Physical Printer Definition screen. This screen may be displayed using 
the F8 key. 

See “Setting Print Defaults” on page 360.
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Aux Prt Name

If a terminal has a printer connected to its auxiliary output, enter an appropriate physical printer 
name for the printer. This should have a printer class attached with the appropriate set of escape 
and other sequences for the type of printer connected. This printer is commonly called a slave or 
auxiliary printer.

Baud (Pick only)

The baud rate of the port, or leave blank. This baud rate may be used by the USER-COLDSTART 
process. If a baud rate is entered here and you use F6-Coldstart, the USER-COLDSTART process is 
updated to set this baud rate whenever the machine is powered up.

If you change the baud rate here, it will not actually change the baud rate for the port when this 
screen is saved.

User Name

The name of the normal user or location for the port. This location is used by the System House 
Keeping > Port Setup > List Users Logged On option.

Default Terminal/Printer Specification F9

This subscreen is displayed by pressing the F9 key from the Port Configuration screen.
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Function Key

F2 - Accept

Accepts the default specifications.

Prompts

Terminal Id

The terminal id to use if no id is specified for a port. To prompt for the id at logon, specify ASK or 
ASK(TERMID), where TERMID is the default. If no terminal id is specified for this prompt, or multi-
ple ids are entered, SB+ consults the terminal ids specified in Security > User Security Setup 
(See “User Security Setup” on page 92) after the user has been identified. If a single terminal id is 
found here it is used, otherwise the terminal id is prompted for at logon, showing a list (if there is 
one) when ∗ is entered. If no terminal id is specified at logon, the default id DEFAULT.TERM is used.

The terminal id may be of the form filename,itemid where the contents of the record is a list of valid 
terminal ids which is displayed if ∗ is entered at the Terminal Id prompt. The default is the first 
entry in the list.

Printer Name

The physical printer name for the printer usually assigned to a user if a number of other default 
conditions are not met; usually if no other printer default parameters are specified elsewhere. The 
physical printer must have been defined in the physical printer definition, available from the F8 
key in the Port Configuration screen. See “Setting Print Defaults” on page 360.

Aux Printer Name

The physical printer name for a printer on an auxiliary port, usually assigned to a user if a number 
of other default conditions are not met; usually if no other printer default parameters are specified 
elsewhere. The physical printer must have been defined in the physical printer definition, available 
from the F8 key in the Port Configuration screen. See “Setting Print Defaults” on page 360.
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Media Commands

The Media Commands menu allows you to manage the media (eg tapes and diskettes) and media 
devices (eg tape and disk drives) on your system. You may also read records from and write 
records to the media.

Commands not requiring a lengthy description are described below (the other commands are 
described in the following pages):

Select Media Device allows you to choose a media device. Use this before any other media 
options. See “Select Media” on page 52.

Rewind Media allows you to rewind the currently attached media. Use this before reading or writ-
ing to media.

Read Tape/Diskette allows you to read a block from the currently attached media and display its 
contents on the screen.

Detach Media allows you to detach the currently attached media, making it available to other 
users. Ensure that the device is free to use if detaching it from another port. See “Detach Media” 
on page 53.

Format Diskette Pick allows you to format a diskette. You would normally do this for a new dis-
kette before writing data to it. See “Format Diskette - Pick” on page 53.
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Define Media Device - uniVerse, UniData

Note
The above screen example relates to Windows NT installations. The Unix screen is similar.

Allows you to define a media device on your system. 

Function Keys

F2 - Accept

Saves the media device parameters.

F4 - Del

Deletes the media device record.

Prompts

Device Name - uniVerse

The device name to be used whenever you select the current media.

Device Number - UniData

The device number to be used whenever you select the current media.
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Description

A meaningful description of the media device.

Device Type - uniVerse

Specifies the type of media being defined for the media device. Options are:

F Floppy disk (diskette).

T Tape.

C Cartridge.

DT Direct Tape.

DC Direct Cartridge.

Block Size

The media block size in bytes.

Operation Mode - UniData

Specifies the data conversion filter to be used when reading from or writing to this device. This 
allows for alternative storage formats such as EBCDIC. Options are:

0 no conversion. Stores all characters in ASCII format.

1 assumes data is in EBCDIC format.

2 inverts high bits.

3 swap bytes.

Rewind Path

The Unix path to a device providing full rewind after tape operations are complete.

Norewind Path

The Unix path to a device that does not rewind at the end of tape operations. If no Norewind Path 
device is specified for the media, enter the Rewind Path.
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Backup Command

The Unix command to perform the backup called from the Backup menu. The F3 key provides 
help on formatting this and the following commands.

Restore Command

The Unix command to perform the restore called from the Backup menu. 

Skip File Command

The Unix command to skip a file on the media. 

Rewind Command

The Unix command to rewind the device. 

Offline Command

The Unix command used to handle device offline errors.

Windows NT Device

The Windows NT sharename for the device. Device names are in the form:

\\.\devname, for example \\.\a: or \\.\tape0

Attach Media Device

Allows you to gain exclusive access to the selected media device and to specify the block size to be 
used. Notification is given if the media device is already in use.
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Prompts

Block Size (Null=default)

The block size to be used if different from the default used by the OE for the selected media 
device. Leave this blank to use the OE default values.

Write File To Media

Allows you to write the contents of selected records from a disk file to the currently attached 
media.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to write a file to media.

Prompts 

File Name

The name of the file to be written to the attached media.

Data/Dict (0/1)

Options are:

0 writes the contents of the data part of the file. 
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1 writes the contents of the dictionary part of the file.

Record Name(s) Or Criteria

The ids (enclosed in quotes) of the records to be selected from the file, or selection criteria. Leave 
blank for all records. Separate multiple record ids by spaces.

Load File From Media

Allows you to load the contents of a file from the currently attached media to a specified disk file.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to load a file from media.

Prompts

File Name

The name of an existing file into which data from the attached media will be loaded.

Data/Dict (0/1)

Options are:
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0 loads data from the selected media into the data part of the file. 

1 loads data into the dictionary part of the file.

Record Name(s) Or Criteria - Pick, uniVerse

The ids (enclosed in double quotes) of the records that are to be loaded, or selection criteria. Leave 
blank to load all records.

Selection Criteria - UniData only

The selection criteria to load a subset of the records from the device. If NULL, saved record names 
will be used here.

Original Frame Size - Pick only

This is the frame size of the system from which the file is being loaded. It is only required when 
loading object/binary items from another AP system (Rn optioin), otherwise it is left blank.

Overwrite Existing (Y/N)

Options are:

Y overwrites any existing records of the same id.

N ignores any record ids read from the media which already exist in the target file.

Suppress ID Listing (Y/N)

Options are:

Y prevents record id listings from appearing on the screen.

N displays each record id as it is loaded.
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Selective Restore - Pick

Allows you to perform a selective restore from the currently attached media to a file. This is used 
to return specific records from media in either account-save or full file-save format. The attached 
media is searched for the requested file (and records), which are written to any nominated file 
name. Eg to restore a record from the CUSTOMERS file from the daily backup if the record has 
been accidentally deleted from the system.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to restore from media.

Prompts

File Name to Restore to

An existing file name to which data from an account-save or file-save is to be restored. This name 
may differ from that used in the backup.
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Data/Dict (0/1)

Options are:

0 restores the data part of the file. 

1 restores the dictionary part of the file.

Item Name(s) (* all)

The record ids to be restored, separated by spaces. Enter ∗ to restore all records.

Account Name on Backup

The name of the account on the backup containing the file records to be restored.

File Name on Backup

The name of the file on the backup containing the records to be restored.

Data/Dict (0/1)

Options are:

0 records are held in the data part of the backup file. 

1 records are held in the dictionary part of the backup file.

Tape at Correct Point (Y/N)

Options are:

Y the tape/diskette is at the correct position to start the restore. 

N the account name is to be searched for before the restore starts.

Overwrite Existing Items (Y/N)

Options are:

Y overwrites any existing records in the target file that have the same id as those being 
restored. 

N does not load data into existing records.
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Skip Label Search (Y/N)

Options are:

Y skips the label search if a full file-save has been used to backup the data being restored. 

N account-save.

Full/Incrmntl/Trans Log (F/I/T) - AP

Options are:

F Full/Account.

I Incremental.

T Transaction log
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SB+ Setup

The SB+ Setup menu provides options for defining the control parameters required by SB+ before 
it can be run on your system. Normally, you would only use these options when you are initially 
setting up an account or system.
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SB+ Control Parameters

Note
The above screen example relates to Windows NT installations. The Unix screen is similar.

The SB+ Control Parameters option allows you to specify global control parameters used by 
SB+ for all accounts and system ids.
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The SB+ Control Parameters screen consists of a main screen and a number of subscreens which 
can be reached via function keys, as shown in the following diagram:

Function Keys

F2 - Save

Saves the SB+ control parameters.

F5 - Sys Defaults

Allows you to specify defaults used when setting up a new system id. See “System Defaults F5” on 
page 239.

F7 - Sys Keys

Allows you to configure certain system keys. These settings should never have to be changed. See 
“System Keys F7” on page 249.

F8 - Disp Defaults

Allows for the configuration of certain default display characteristics. See “Display Defaults F8” 
on page 250.

F9 - Logto Sub

Displays the Logon/Logto Subroutine subscreen. See “Logon/Logto Subroutine F9” on 
page 254.

SB+ Control Parameters

F5 - Sys Defaults F7 - Sys Keys F8 - Disp Defaults F9 - Logto

F5 - Additional F6 - GUI F7 - Language Table F5 - GUI Display Defaults

F6 - OE Transactions F7 - SQLator

F6 - SQLator Servers
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Prompts

Prompt Line

Defines where on the screen the prompt line will be displayed. Enter the prompt line number, or L 
n where n is the number of lines up from the last line of the terminal screen. We recommend you 
leave the default at L1.

Error Line

Defines where on the screen the error line will be displayed. Enter the error line number, or L n 
where n is the number of lines up from the last line of the terminal screen. We recommend you 
leave the default at L1.

Help Line

Defines where on the screen the first help line will be displayed. Enter the first help line number, or 
L n where n is the number of lines up from the last line of the terminal screen. We recommend you 
leave the default at L1.

Screen Accept Prompt

Options are:

Y the default for all screen accept prompts that are displayed within the Screen Definition 
tool (See your SB+ Server Reference Manual) is Yes.

N the default is to be No. 

This value may be overridden for any screen.

Other Language (Y/N)

Informs SB+ whether to use hard-coded English text for its prompts or to use a translation table. 
Options are:

Y SB+ has been translated to another language and these language definitions have been 
loaded into the relevant SB+ definition files. The prompts are taken from the PROMPT 
record in DMCONT. Translation is done via the process XLATE.DEFN.

N uses hard-coded English prompts.
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Note
This is for a single, complete transaction. See “Enable Multi-Language Support” on page 241 for 
an alternative translation function.

Field Descrip LC

Options are:

Y descriptions entered in field definitions are to be converted to mixed upper and lowercase 
letters. The result may be overridden by amending an existing field definition and overtyp-
ing the field definition or report heading. 

N leave text as entered.

Max Levels Warning

The number of nested process levels allowed before a warning is given. Accept the default in most 
circumstances.

Note
There is a limitation on some OE versions as to how many levels of process calls are possible.

Edit Key Delay

The delay value (in milliseconds) before checking the type ahead buffer to see if another key is 
pending. This is used as a time-out on function key strokes. You will only need to adjust this 
parameter if SB+ is not picking up all the characters generated by an edit key.

There are two time-out methods:

n >= 0 wait for n milliseconds or until a character is found in the input buffer (if this occurs 
first).

n <= 0 loop n times or until a character is found in the input buffer (if this occurs first).

CUA Arrow Movement

Options are:
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Y the up arrow key and Shift-Tab keys cycle backward through input fields. The Esc key 
cancels the record.

N the up arrow key, Shift-Tab and Esc keys cycle backward through input fields. 

American/Internat’nl

Determines the format for dates. Options are:

A American (mm/dd/yy).

I International (dd/mm/yy).

Operating Environment/OE Type

The type of OE to which this version of SB+ is ported. (Display only).

Frame Size

The number of characters in a disk frame. This is used for calculating file sizes. (Display only).

Unix Delimiter/Windows NT delimiter

The path delimiter. (Display only).

Unix Name - uniVerse, UniData

The Unix system name obtained from the uname command. (Display only).

PathName - uniVerse, UniData

The home directory. (Display only).

SB+ Unix Group - uniVerse, UniData

The group used when SB+ was installed. (Display only).

File Creation Umask - uniVerse, UniData

The umask value for the current session. This is usually 007. (Display only).

Max Unix Filename Len - uniVerse, UniData

The maximum filename length, OE dependent. (Display only).
238 SB+ Server Administration Manual



SB+ Setup
System Defaults F5

This subscreen is displayed by pressing the F5 key from the SB+ Control Parameters screen. It 
allows you to specify default system control parameters for all accounts and ids.

Function Keys

F2 - Accept

Accepts the screen parameters. The changes are not made permanent until the SB+ Control Param-
eters screen is saved.

F5 - Additional Defaults

Allows you to specify additional system defaults. See “Additional System Defaults F5” on 
page 242.

F6 - GUI

Presents the GUI subscreen. See “GUI System Defaults F6” on page 245.

F7 - Language Table

Presents the Language Table subscreen. See “Language Table F7” on page 248.
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Prompts

Default Date Conversion

A default date conversion.

This conversion is used as a default by the Field Definitions tool (See your SB+ Server Reference 
Manual) when creating a field of type D (Date). It may be overridden for specific fields if required.

Changing this default conversion will not affect preexisting field definitions, screens or reports.

Default Money Conversion

A default money conversion.

This is used by the Field Definitions tool when creating a field of type M.

Changing this default conversion will not affect preexisting field definitions, screens or reports.

Proc At Set Common

A process to be called whenever SB.SET.COMMON is called.

Any values to be stored in COMMON specific to your system may be set up in this process. Eg 
you may wish to store the current company code you are working with in COMMON variable 
PARAMS(1). Whenever you go to the OE shell or CHAIN any program, the contents of COMMON 
are lost. To ensure that PARAMS(1) is reset, enter a process here which assigns the relevant value to 
PARAMS(1).

Proc At OE Return

A process to be called whenever a user leaves SB+ to return to the OE.

This may be used to check whether it is legal for the user to go to the OE shell. If the process sets 
RTN.FLAG to X or 1, the attempt to go to the OE shell is cancelled.

Proc Before CHAINing

A process to be called whenever CHAINing to external software.

COMMON variables specific to your system may be saved by this process. If you use the C or W 
type in menus, the process is effectively CHAINed. This means that the  COMMON variables you 
have set up are lost. You may wish to save these variables in a process called from this slot.
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Note
This complements the process specified at the Proc At Set Common prompt, in providing a user 
exit point on entry to, and exit from SB+.

Field Template Dict

The field template file to be used by this system.

This name may be the same as used in other systems. In other words, the field template file can be 
shared by different system ids and across accounts. 

Global Dict Name

The global dictionary to be used by this system.

If this file was not created in this account, a file pointer must be defined for it.

Enable Multi-Language Support

Enter the setting for multi-language support to use as the default for each system id when it is initi-
ated.
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Additional System Defaults F5

This subscreen is invoked by pressing the F5 key from the System Defaults screen. It allows you 
to specify additional system defaults, to be used as the defaults when a new system id is created.

Function Keys

F2 - Accept

Accepts the additional system default parameters. The changes are not made permanent until the 
SB+ Control Parameters screen is saved.

F6 - OE Transactions

This displays the OE Transactions Parameters screen. See “OE Transaction Parameters” on 
page 255.

F7 - SQLator

This calls the subscreen where SQLator Servers are defined and maintained. “SQLator Servers” on 
page 257.
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Prompts

Global Process

The name of the file to be used as the global process file as a fallback from xxPROCESS. The file 
must already exist, and a file pointer to the file must exist if the file was not created locally. 

See “Global Files” in your SB+ Server Reference Manual.

Global Menu

The name of the file to be used as the global menu file as a fallback from xxMENUS. The file must 
already exist, and a file pointer to the file must exist if the file was not created locally. 

See “Global Files” in your SB+ Server Reference Manual.

Global Help

The name of the file to be used as the global help file as a fallback from xxHELP. The file must 
already exist, and a file pointer to the file must exist if the file was not created locally. 

See “Global Files” in your SB+ Server Reference Manual.

Global Defn

The name of the file to be used as the global definition file as a fallback from xxDEFN. The file 
must already exist, and a file pointer to the file must exist if the file was not created locally. 

See “Global Files” in your SB+ Server Reference Manual.

Proc Before '/proc'

A process to be executed prior to any process being invoked using the /name syntax. If RTN.FLAG 
is set to 1 or X, the process being invoked will not be executed.

Process After Tool Read

A process to be called after the read step in SB+ tools. The action of the process is entirely user 
defined. Any RTN.FLAG settings are passed back to the tool for processing.

Eg a value of X in RTN.FLAG causes the tool process to terminate. A value of 1 in RTN.FLAG causes 
the cursor to return to the key field of the tool.
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The COMMON variables KEY, ACTION, MAINFILE and RECORD contain data relevant to the read 
just performed. You may use this process to control SB+ tool usage or to implement version con-
trol for application development

DDE Timeout

This is used to specify the number of seconds to allow for a DDE action to complete before report-
ing an error. The default value is ten seconds.

Form Defns to Store

This is used to specify the number of previous versions of a form to store (maximum of 9) during 
development. Previous versions may then be accessed with the Restore function key.
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GUI System Defaults F6

This subscreen contains the default values for some of the GUI parameters. The values entered 
here are used only as the default when creating new accounts or modules. They do not affect those 
that have already been created.

Prompts

GUI Mode Enabled

Enter Y if GUI mode is to be enabled for each module when it is initiated.

GUI Screen Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating screens.
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GUI Menu Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating menus.

GUI Help Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating help items.

GUI Dialog Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating dialog boxes.

GUI Error Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating error displays.

GUI Lookup Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating lookup displays.

GUI Prompt Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating prompt screens.

GUI CEO Defaults

Enter the control name to be used as the default for each module when it is initiated. This entry 
defines the default characteristics used for creating character emulation objects.

Add Scrollbars to Multivalued Fields

Enter Y if scrollbars are to be added by default to multivalued fields in GUI mode.

Use Tabfolders in GUI Screens

Enter Y if tabfolders are to be used by default for linked screens in GUI mode.
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Use Grids for Multivalued Fields

Enter Y if grid controls are to be used by default for multi-valued fields in GUI mode.

Navigation Method

Enter the default method by which users will navigate around the system and invoke SB+ pro-
cesses. The possible values are:

M  - Menus on MainWin

EM - Explorer with MainWin

EN - Explorer without MainWin

N  - No MainWin

Self-Contained Forms

Enter Y if the action bar, toolbar and status line are to be part of the GUI form by default.
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Language Table F7

This subscreen allows the system wide language table to be maintained. This table defines the lan-
guages that will be supported in multi-language applications.

Function Keys

F2 - Save

Saves the language table.

F4 - Del

Deletes the language table. The language files specified for the languages will not be deleted.

Prompts

Code

This is a code used to denote a language supported in the system.
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Description

The full description of the language.

Language File

This is the file used to store most of the translated text for the language. The default is 'DMLAN-
GUAGE.xx' where xx is the language code, but any valid filename can be used. If the file does not 
exist it will be created.

System Keys F7

This subscreen is displayed by pressing the F7 key from the SB+ Control Parameters screen. It 
allows you to change certain default system key characteristics used by SB+.

Prompts

Decimal Value For <Enter> key

The decimal value to be returned by the pressing the Enter key.

Decimal Value For <Backspace> Key

The decimal value to be returned by the Backspace key.

Call Process Character

The character to be used to call a process.
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Call Help Character

The character to be used to call help.

Alternative Delete Character

The character to be used to delete a field.

Display Defaults F8

This subscreen is displayed by pressing the F8 key from the SB+ Control Parameters screen. It 
allows you to change certain default display characteristics used by SB+.

Function Keys

F2 - Accept

Accepts the screen parameters.

F5 - GUI Display Defaults

Displays the GUI Display Defaults subscreen. See “GUI Display Defaults F5” on page 252
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Prompts

Action Bar Option Spacing Method

This parameter governs how option spacing in action bars is determined. Options are:

0 gives a constant number of spaces between options; the number of spaces being deter-
mined by the number and length of options.

1 gives a uniform number of characters per option; shorter option descriptions are padded 
with spaces.

2 options are fitted (as near as possible) to the full width of the screen. This is a combination 
of 0 and 1.

n a number greater than 2 uses the type 0 spacing method but reserves at least n number of 
spaces from the start of the last option to the screen width. This allows menus to be pulled 
down under the last option in the menu bar.

-n same as for n but uses the type 1 spacing method.

Action Bar Highlight Effect Number

The display effect number from the terminal definition (See “Terminal Definitions Screen 1” on 
page 193) for displaying the highlighted letter in an action bar (this is normally reverse video).

Action Bar Display Line

The line (1 or 0) on which the action bar is displayed. 

Default Window Frame Type

The window frame (border) type for drawing window frames that do not have the frame type spec-
ified in their window co-ordinates. Options are:

0 no frame.

1 single line frame.

2 double line frame.
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Default Window Style Code

The window style code to be used on terminals capable of using these codes, where no style code 
is given in their window co-ordinates. Options are:

0 no shadow or exploding windows.

1 shadow.

2 exploding window.

3 shadow and exploding windows.

Style codes other than 0 are only applicable when using SBTerm terminal emulation products in 
Character mode. 

Mouse Double Click Interval

The timing interval (in milliseconds) between the first and second mouse click to cause a double-
click action to take place.

GUI Display Defaults F5
This screen holds the system wide control flags which relate to GUI mode. Some of these fields 
were previously on other screens, while other fields are new or were not previously generally 
accessible to users. This new screen is called GUI Display Defaults and can be reached by per-
forming the following steps:

1. enter "/SB.PARMS",

2. press the F8 key to go to the Display Defaults subscreen,

3. press F5.

This screen should not be confused with the GUI System Defaults subscreen.
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The GUI System Defaults subscreen contains information which is applied to new modules when 
they are created, while the GUI Display Defaults subscreen affects the behaviour of all modules at 
run time, not just when they are being created.

Prompts

SB+ Host Name

This name will be used as a prefix for all downloaded GUI definitions and allows a distinction to 
be made between identical forms from different hosts. An entry is only required in this field if 
there are users who will be running in GUI mode and accessing SB+ Server on more than one host 
machine.

Disable Previous Menu

If set to Y, the previous menu will be disabled when a screen does not have an action bar. If set to N, 
the previous menu will be accessible as an action bar.

Enable 'No Refresh' Feature

If set to Y, a subscreen with the N (no refresh) option will not be destroyed on exit. It will be dis-
abled, but will persist until the main screen is destroyed.
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Exclude HELP_STRING from Driver

If set to Y, ToolTip style help will be disabled, by preventing the help string from being included in 
the driver.

Use new LFK Style Buttons

If set to Y, the LFK process will replace any existing buttons on the form instead of attaching the 
function key set to menu.

Adjust Form Size for Toolbar

If set to Y, automatic resizing of the form will be enabled in situations where a toolbar attached to a 
form is larger than the form. If set to N, the toolbar will be wrapped into as many rows or columns 
as required to fit it onto the form.

Use Flat Style Buttons on Toolbar

If set to Y, buttons on fixed toolbars will be created in the newer flat style. If set to N, the buttons 
will be created in the older raised style.

Use ListView Style Selects

Y Use ListView style select lists.

N Use traditional style select lists.

Logon/Logto Subroutine F9

Process /LOG.PROC
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This subscreen is displayed by pressing the F9 key from the SB+ Control Parameters screen. It 
allows you to call a user subroutine to perform processing at logon or logto, prior to any terminal 
or printer setup occurring. This must be a subroutine, as processes will not function at this point of 
the logon/logto process. This process is not available from system menus, as it operates on a per-
account basis.

Function Key

F2 - Save

Saves the screen parameters.

Prompts

Subroutine Name

The name of the user subroutine to be called.

OE Transaction Parameters

Function Key

F2 - Accept

This accepts the sub screen.
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Prompts

OE Transactions

Y Set to this if Transaction Processing has been enabled in the operating environment,

N Set to this if Transaction Processaing has not been enabled in the operating environment.

Warn on Error

Y A warning is to be issued when an operating environment transaction fails.

N If a warning is not to be issued when an operating environment transaction fails.

Commit Fail Process

This is used to specify the name of a process which is to be run automatically if an operating envi-
ronment transaction fails.

SQLator Parameters

Function Keys

F2 - Accept

This accepts the sub screen.

F6 - SQLator Servers

This presents the SQLator Servers detail entry screen.
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Prompts

SQLator Enabled

Y SQLator package has been installed.

N SQLator package is not available.

Extended Error Reporting

Y Extended error reporting is to be enabled for SQLator.

N Extended error reporting is not to be enabled for SQLator.

SQLator Servers

Function Key

F2 - Save

Save this screen.
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Prompts

SB+ Server Name

This is the name by which this Open File System (combination of database and repository) will be 
known to SB+ Server.

OFS

This is the database family type, such as ORA for Oracle.

TNS Name

This is the descriptor to be mapped to the service name as defined in the database client layer.

Repository

This is the name of the repository which will represent the UniData account on the database.

Reuse Details

Y Denotes that the SB+ user id and database password will be the same for all databases.

N Denotes that the SB+ user id and database password will be different for each database.

SQLator DLL Path

This is the path to the SQLator DLLs.

Note
Applies to Microsoft Windows NT based installations only.
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SB+ Configuration Options

Provides options for customising the way SB+ interfaces with the OE and options for setting up 
some SB+ global processes.
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Global Postings

Allows you to specify file pointers, program pointers and verbs to be propagated to all SB+ 
accounts.

Function Keys

F2 - Save

Saves the global postings parameters.

F4 - Del

Deletes the global postings record.
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Prompts

Last Posted By

Displays the identity of the last user to have updated this screen. (Display only).

Last Posted On

The date of the last update to this screen. (Display only).

Global Files

The name of the file (in this MD) to have a file pointer created in all other SB+ accounts.

Global Verbs

The name of the verb in this account or cataloged program to have its definition copied to all SB+ 
accounts.

Posted Processes

The name of the process (in SAPROCESS) to be copied to all other SB+ systems.

Posted Menus

The name of the menu (in SAMENUS) to be copied to all other SB+ systems.

Posted Defns

The name of the definition (in SADEFN) to be copied to all other SB+ systems.
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Global Print Defaults

Allows several global print defaults to be specified. These defaults affect all systems in an installa-
tion that do not have print defaults. See “Setting Print Defaults” on page 360, and “System Control 
Record” on page 491 in your SB+ Server Reference Manual.

Function Keys

F2 - Save

Saves the global printer default record.

F4 - Del

Deletes the global printer defaults record.
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Prompts

Physical Printer Name

The name of existing defined physical printer definition. If the physical printer has not been 
started, a warning message is displayed. You may enter an expression in parenthesis to be evalu-
ated at runtime.

Stationery Type

A valid stationery type for this physical printer. The stationery type may only be selected from the 
list currently associated with the selected printer. You may enter an expression in parenthesis to be 
evaluated at runtime.

Assign Options

Any printer assign options required. These differ slightly from platform to platform. However, the 
following list is common to all:

P (default) prints to printer or output device. 

H holds the print job on the queue and prints to the printer or output device.

HS holds the print job on the queue without printing.

UniData and uniVerse have different options for handling the use of the ‘hold’ file. See your OE 
documentation and “Appendix C - Printer Management for uniVerse” and “Appendix D - Printer 
Management for UniData”.

You may enter an expression in parenthesis to be evaluated at runtime.

No of Copies

The number of copies to be produced in a single print request. You may enter an expression in 
parenthesis to be evaluated at runtime.
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Global Print Mngr Proc

The process name entered here is used to invoke a process implemented by the user to add addi-
tional functionality to print management in SB+ for all systems which do not have a process nom-
inated in the local System Control Record (See “System Control Record” on page 491 in your SB+ 
Server Reference Manual). This prompt is only checked if there is no local process defined. If a 
process is not entered here, standard SB+ Print Management is used.

Setting @RTN.FLAG in the process makes possible a number of options. Options are:

0 continues with the standard SB+ Printer Manager setup.

1 ignores the SB+ Printer Manager. The user process must provide all print set/reset func-
tions.

X causes the current print run to be aborted.

Global Prnt Redir On

The process name entered here is used to invoke a process supplied by the user that will work inde-
pendently of, or in conjunction with, the normal SB+ print redirection functionality (such as the 
Screen/Printer/Aux prompt in Report Writer). This process applies globally where a local redi-
rection process has not been specified in the local System Control Record.

If no process name is entered here or in the local System Control Record, then normal SB+ output 
redirection is used. If a process name is present, SB+ does not prompt but leaves this to the user 
process.

@RTN.FLAG and @VALUE are tested on return from the process. If @RTN.FLAG is X, the current run 
is aborted. Any other value will fall through to the @VALUE check. 

@VALUE is tested for any one of the enabling key letters for SB+ redirection, ie S, P, X etc. If 
@VALUE contains one of these letters, SB+ will perform the normal SB+ functions associated with 
that letter.

The user process will have to supply all redirection functionality if SB+ redirection is bypassed.
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Global Prnt Redir Off

A process name here is used to invoke a process supplied by the user that will work independently 
of, or in conjunction with, the normal SB+ print redirection reset functionality. This process is 
used to restore the environment that existed prior to that created by the redirection-on process 
and/or SB+ redirection-on routines.

This process applies globally where a local redirection process has not been specified in the local 
System Control Record.

If no process name is entered here or in the local System Control Record, then normal SB+ redi-
rection-off is used. We highly recommend that redirection-on and redirection-off processes are cre-
ated as a pair. This ensures that user routines, especially those which bypass SB+ output 
redirection altogether, correctly set and reset the environment.

OH Process Scope Control

Provides additional security on the /OH and /MP processes so that end users of applications cannot 
readily modify certain definitions.
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Function Keys

F2 - Save

Saves the screen parameters.

F4 - Del

Deletes this record.

Prompts

Can use /OH or /MP

The id’s of users allowed to use the /OH process or /MP process even if these processes are copied 
and run under another name. If this is blank then all users who gain access to /OH or /MP will not 
have further security applied to their actions.

Can use /OH on Tool Processes

The ids of users allowed to use the /OH process on tool or flagged processes (where the process 
type is suffixed) even if the /OH process is renamed.

A flagged process is one which has an additional character added to the process type letter in 
attribute 1 of the process definition record. All SB+ tool processes have a T appended. You may 
flag a process by manually adding an additional letter to attribute 1 of the process definition.

If this is blank then all users that gain access to /OH will have no further security applied to their 
actions.
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OE Setup Commands

Allows for the execution of OE commands before control is handed over to SB+. Eg to release the 
backspace character via the PTERM command.

Function Keys

F2 - Save

Saves the OE setup command parameters.

F4 - Del

Deletes this record.

Prompts

Statements To Be Executed

Commands to be executed line by line. 
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OE Reset Commands

Allows OE commands to be executed prior to SB+ terminating. Eg to reverse the effects of com-
mands executed in the OE Setup Commands screen.

Function Keys

F2 - Save

Saves the OE Reset Command parameters.

F4 - Del

Deletes this record.

Prompts

Statements To Be Executed

Commands to be executed line by line, when leaving SB+ and returning to the OE. 
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Wrapping OFF Verb

Allows you to rename the OE OFF verb so that SB+ can change the original to call its own verb 
that does additional housekeeping.

Function Keys

F2 - Save

Saves the screen parameters.

F4 - Del

Deletes this record.
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Prompts

New Name

A new name for the real OFF verb. If no name is given or this record is deleted then the OFF verb is 
not wrapped.

Replace Original With

Optional replacement text for the record to replace the OFF verb. You should leave the call to 
SH.OFF but you may want to add something extra.

Wrapping LOGTO Verb

Allows you to rename the OE LOGTO verb so that SB+ can change the original to call its own verb 
that does extra housekeeping.
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Function Keys

F2 - Save

Saves the screen parameters.

F4 - Del

Deletes this record.

Prompts

New Name

A new name for the real LOGTO verb. If no name is given or this record is deleted, the LOGTO verb 
is not wrapped.

Replace Original With

The optional replacement text for the record to replace the LOGTO verb. 
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Upgrade SB+ MD from SYSPROG - Pick

Allows you to upgrade the SB+ account MD from the SYSPROG account MD. Use this only if your 
OE has been upgraded.

Function Keys

F2 - Accept

Accepts the screen parameters and initiates the process to copy items to the local MD.

F5 - Rebuild

Automatically sets up standard Pick files. Use the F5 key if an upgrade to your OE has been 
installed to ensure this administration account is up to date. 
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Prompts

Files

The names of any traditional file pointers that may need to be accessed from this account. File 
names must exist in SYSPROG.

QFiles

The names of any file pointers existing in SYSPROG as pointers to files in another account, that 
may need to be accessed from this account. The F5 key automatically sets up standard Pick files. 
Use the F5 key if an upgrade to your OE has been installed to ensure this Admin account is up to 
date. 

Verbs

The name of any verb in SYSPROG that needs to be accessed from the Admin account. The F5 key 
automatically sets up standard Pick verbs. Use the F5 key if an upgrade to your OE has been 
installed to ensure this Admin account is up to date.

Install PC Monitor Type - Pick

Pick allows you to install the keyboard definition for a PC monitor so full keyboard functionality is 
available. Normally, the keyboard does not return a value for certain edit keys. Eg The Ins and Del 
key. Ensure this option is run so that the PCMON terminal definition works correctly.
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Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to install a keyboard definition.

Prompts

Keyboard Size (101/84)

The number of keys on the keyboard. Options are:

101 extended keyboard.

84 standard keyboard.

Color Or Monochrome (C/M)

Options are:

C Color monitor. Installs terminal id PCMON.COL.

M Monochrome. Installs PCMON.

Install At Power On (Y/N)

Y includes the options above within the procedures run when the system is powered on 
(USER-COLDSTART).

N not included in USER-COLDSTART process.
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SB+ Patching System

The SB+ Patching System option allows you to load, view and unload patches. A patch is a modi-
fication to the existing SB+ software.

The patching system is implemented in a similar way to revision control (See your SB+ Server 
Reference Manual). You use revision control functions to create media and format records. Action 
codes (eg item copy, item delete etc) are the same as those used in revision control.

A patch is normally created by System Builder and distributed as either a file or on media (eg tape 
or diskette). If the patch contains object code (programs), the patch cannot be distributed as a file 
for certain platforms (eg AP and R83). Media must be used in these instances. A patch may be dis-
tributed as a file for platforms such as UniData, uniVerse and Pi/Open where the object is encoded 
first (using the Unix uuencode command) and then decoded when the patch is applied. If the patch 
does not contain object code, it can be distributed as a file for all platforms.
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Patch Definition Enquiry

Allows you to view patch definition records.

Patches are identified by their patch number and, when necessary, a sub-patch code. The patch 
number relates to all platforms of SB+, whereas the sub-patch code is used for OE dependent 
patches.

Function Key 

F5 - Readme

Invokes the PATCH.README process, which displays the patch readme screen. This contains addi-
tional information related to the patch, including details of changes.
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Prompts 

SB+ Release

The current SB+ release number. (Display only).

OE Type

The platform to which the patch applies. (Display only).

Obj/Source

The type of SB program the patch has been created for. Options are:

O Object.

S Source.

This is normally set to 0.

Patch No

The sequential number allocated by System Builder when the patch is created.

Sub Patch

Identifies OE specific patches.

Reversible

Determines if the patch is reversible or not. (Display only). Options are:

Y the patch is reversible.

N the patch is not reversible.

If the Reversible prompt is set to Y, all the items affected by the patch will be saved prior to load-
ing the patch. If the patch is being loaded from diskette, you will be prompted to insert a new dis-
kette for the reverse definitions, and then to re-insert the patch diskette. If a file is used, a new file 
will be created with the name filename.patchnumber and used to store the reverse definitions.

If the Reversible prompt is set to N, we strongly recommend you backup the SB+ and SB+.DEFN 
accounts prior to loading the patch.
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Dependent On

A list of any related patches (comma-delimited) which need to be applied first. (Display only).

Description

A description of the patch. (Display only).

Action

The action to be performed (item copy, file load, etc). (Display only).

Filename

The file on which the action is to be performed. (Display only).

Item

The item name (if applicable). (Display only).

Parameters

The parameters (file type, modulo, sysid, etc) required, depending on the action. (Display only).

Load the Patch

Allows you to load a patch.

You must apply patches from your SB+ account. On Unix systems you need to be logged in as 
superuser.
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Function Keys

F2 - Accept

Accepts the screen parameters, and proceeds with the loading of the patch. Patch details are 
retrieved from the specified media/file and the Patch Selection screen displayed:

This allows you to load patches selectively. Enter Y at the Apply prompt to apply a particular 
patch. The Apply prompt defaults to N if the current SB+ patch level is higher than the one being 
applied, otherwise it defaults to Y.

The function keys on the Patch Selection subscreen are:

F2 - Accept

Accepts the Patch Selection subscreen details.

F4 - Quit

This enables you to exit this screen without saving details.

F5 - README

Displays the README for the current batch.
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Prompts 

(M)edia/(F)ile

Indicates whether the patch is to be loaded from a file or from media. Options are:

M loads patch from Media.

F loads patch from a File.

Filename

The filename of the patch, if the F (File) option was selected at the previous prompt.

Unload the Patch

In some cases you may want to reverse the patch. If the patch was flagged as reversible at the time 
of creation, a media/file was created with the reverse patch definitions when the patch was loaded. 
This process will load the reverse definitions, effectively resetting the system to its state prior to 
the loading of the patch.

Only the most recent patch can be 'unloaded'.

Function Key

F2 - Accept

Accepts the data entered into this screen, and unloads the most recent patch.
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Prompts 

Patch

The current SB+ patch level. (Display only).

Sub Patch

The sub-patch number, if applicable. (Display only).

(M)edia/(F)ile

Indicates whether the patch was loaded from a file or from media. Options are:

M Media.

F File.

Filename

The name of the patch file if the F (File) option was selected at the previous prompt.
SB+ Server Administration Manual 281



Chapter 4 - Admin Menu  
SB+ Release Info

Displays the SB+ release number, the current patch number and details of patches applied.
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System House Keeping

The System House Keeping menu allows you to interrogate and manipulate various OE details.

Port Setup

Provides menus for maintaining and reviewing various port-related details. 
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Your Terminal Settings (OE)

Allows you to view and amend the display format and some terminal parameters for the current 
port and logon session only. This option relates to the OE TERM command.

Function Key

F2 - Accept

Accepts the screen parameters and updates the terminal settings.

Prompts

Terminal Line Width in Horizontal Print Positions

The number of columns available on the terminal.

Terminal Lines Depth

The number of rows available on the terminal.
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Number Of Blank Lines At Bottom Of Screen - Pick, uniVerse

The number of blank lines to appear at the bottom of every screen.

Number Of Delay Characters Output After Linefeed - Pick, uniVerse

The number of delay characters output after a line feed. This is used for terminal timing and syn-
chronization.

Number Of Delay Characters After Top-Of-Form - Pick, uniVerse

The number of delay characters after a top-of-form. This is used for terminal timing and synchro-
nization.

Backspace Character - Pick, uniVerse

The decimal ASCII character that represents the Backspace key. Usually 8.

Printer Line Width

The number of columns to be printed when output is assigned to a printer.

Printer Lines Depth

The number of rows to be printed per page when output is assigned to a printer.

Term-Type Code For Terminal Code Definitions - Pick, uniVerse

The OE term-type specific to the terminal. Eg in the Pick environment a W signifies a Wyse type 
terminal. In uniVerse, vt340 signifies a DEC VT340 terminal. 

List Users Logged On
Displays details of all users currently logged on the system. See “List Users Logged On” on 
page 105.
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Log-Off a Port - Pick, uniVerse

Allows you to log off a specified port. In Pick, the port is directly logged off using the Pick logoff 
command. In uniVerse, the process id of the uniVerse session is used to log off the port. 

Function Key

F2 - Accept

Accepts the screen parameters and logs off the specified port.

Prompts

Port To Log-Off

The port number to be logged off.

Unconditionally (Y/N) - Pick

Options are:

N logs the port off without cleaning up terminal work space.

Y cleans up terminal work space before logging the port off.
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Log-On a Port - Pick

Allows you to log on a currently inactive port and specify the account to be logged into. 

Function Key

F2 - Accept

Accepts the screen parameters and logs the port into the account specified.

Prompts

Port To Log-On

The port number to be logged on.

UserId - AP

The identity of the user.

Password (if any) - AP

Any password required to log on this user-id.

Account to Log Into

The name of the account the port is to be logged into.
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Password (if any) - AP

Any password required to log into this account.

Set Baud Rate of a Port - Pick

Allows you to determine and amend the baud rate for a port. When you accept the screen, the baud 
rate is set.

Function Key

F2 - Accept

This accepts the screen parameters and sets the baud rate for the port.

Prompts

Port to Set Baud On

This is the port number for which the baud rate is to be set. The default shows the current port.

Baud Rate to Set

This is the baud rate required for the port.
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Set Port Comms Details

The baud rate required for the port.

Function Key

F2 - Accept

Accepts the screen parameters and sets the port communication details.

Prompts

Port Number To Set

The port number whose communications details are to be displayed or amended. 

Baud Rate

Amend or accept the baud rate displayed here for the port.

Parity (N/E/O)

Options are:

N No parity.

E Even parity.

O Odd parity.
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Stop Bits (1/2)

Options are:

1 one stop bit.

2 two stop bits.

Word Length (7/8)

Options are:

7 a word length of 7 bits.

8 a word length of 8 bits.

List Port Setups - Pick
Displays the current communication details for each port defined for the system.

System Default Term Def - Pick, uniVerse
Sets the default terminal settings of the OE which take effect whenever you log to a new account. It 
has the same parameters as the Port Setup:Your Terminal Settings (OE) submenu, but uses the SET-
TERM command rather than TERM. See “Your Terminal Settings (OE)” on page 284.
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Date and Time Setup

Provides a menu allowing you to maintain the system date and time.

Display System Date & Time
Displays the current date and time for the system.

Set System Time - Pick, UniData

Allows you to set the system time. Enter the time in the 24 hour format (hh:mm). Eg 15:10 (ten 
minutes after three in the afternoon).
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Set System Date - Pick

Allows you to amend the current system date. Enter the date in either the International dd/mm/yy or 
American mm/dd/yy format, as appropriate to your system.

Set International Date Format
Sets the system date format to International: dd/mm/yy

This option affects the entire system, and should only require setting once.

Set American Date Format
Sets the system date format to American: mm/dd/yy

This option affects the entire system, and should only require setting once.
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List Available Disk Space

Displays details of available space on your system, determined at the moment the option is 
selected.
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Verify System Object - Pick

Checks that the code for the Pick OE matches the check sums expected. If it does not then you may 
need to reload the Pick OE software. See your Pick documentation.

Prompts

Overwrite And Regenerate Checksums (Y/N)

Options are:

Y updates the checksum list with any mismatched checksums. 

N reports mismatches without updating.

Display Where Table - Pick
Displays system information on terminals currently logged onto the system. See your Pick docu-
mentation.
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Detailed System Usage - Pick

Prints or displays system details such as the Lock or Where table, and disk space usage. See your 
Pick documentation.

Function Key

F2 - Accept

Accepts the screen parameters and displays detailed system usage.

Prompts

Print Output Via Spooler (Y/N)

Options are:

Y sends to printer.

N sends to screen.

Suppress Where Status (Y/N)

Options are:

Y suppresses the Where table.

N includes the Where table.
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Suppress Spooler Status (Y/N)

Options are:

Y suppresses the Spooler table.

N includes the Spooler table.

Suppress Lock Status (Y/N)

Options are:

Y suppresses the Lock table.

N includes the Lock table.

List Overflow Fragmentation - Pick
Displays details of disk space usage showing current disk fragmentation. A lot of fragmentation 
indicates that a save/restore may be required.
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Accounts

The Accounts menu allows you to list, create, update, and delete accounts. 

An account is a logical grouping of files and system ids. Your system disk is divided into one or 
more accounts. Each system must have at least one account, in which you create your applications 
(eg Accounts Receivable, Accounts Payable, and General Ledger). You may keep complementary 
applications in one account, and separate more sensitive applications (eg Payroll) into other 
accounts.

The security system allows control over access to accounts. Accounts can be saved as entities and 
can be easily transferred to other machines.

List Accounts
Lists existing accounts on the system. See your OE documentation.
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Create An Account

Allows you to create an account.

Function Keys

F2 - Accept

Accepts the screen parameters and initiates account creation.

F9 - Acc Notes

Allows you to enter a more detailed description of the account. Eg:

This account is for use by the Finance Department to process Accounts Receivable.

Prompts

Account Name

The name of the account you wish to create. The name must be unique (ie not the same as any 
existing account).
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Description

The description for the account being created. This description is used within headings if SB+ is 
installed in this account.

SB+ Account (Y/N/S)

Options are:

Y SB+ is to be installed in the account being created. 

N SB+ is not to be installed. 

S a Synonym account (if you are creating another name for an existing account). (Pick only)

Real Account Name - Pick

The name of the real account for which this name is a synonym. This only applies if S was entered 
at the previous prompt. 

Full Account Path - uniVerse, UniData

The full Unix pathname for the account.

Modulo - Pick

The modulo to be used for the MD that is created with this account.

Privilege Level - Pick

The privilege level (0, 1 or 2) affecting the types of activity allowed:

Facility Lowest privilege level required

Updating of MD ............................................................................. 1

Use of magnetic tape ...................................................................... 1

Use of DEBUG (other than P, OFF, END and G commands) ........ 2

Use of DUMP processor................................................................. 2

Use of Assembler and Loader ........................................................ 2

Use of FILE-SAVE and FILE-RESTORE processors.................... 2
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It is recommended that you use level 2.

System Id

Identifies the SB+ systems to be created in the account. Eg PO for a Purchase Orders system. Mul-
tiple system ids are allowed in an account.

System Menu Description

A description for the system id to appear in the System menu and as a heading for the main menu 
when in this account and system id.

Update An Account

Allows you to convert an existing account into an SB+ account and to change its privileges (Pick 
only) and description.

Function Keys

F2 - Accept

Accepts the screen parameters and initiates the process to upgrade an account.
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F9 - Acc Notes

Allows you to enter a more detailed description of the account. Eg: 

This account is for use by the Accounts Department to process Invoices

Prompts

Account Name

The name of the account you wish to modify or to which you want to add SB+. The account must 
have been previously created.

Description

The description of the account. This description is used within headings if SB+ is installed in this 
account.

SB+ Account (Y/N/S)

Options are:

Y SB+ is to be installed into the account being created.

N SB+ is not to be installed.

S Synonym account (if you are creating an alternative name for an existing account). (Pick 
only).

An entry of Y or N may not be changed to S, and an entry of S may not be changed to Y or N.

Real Account Name - Pick

If the account is a synonym, the name of the actual account referenced, otherwise the account 
name. (Display only).

Modulo - Pick

The modulo used when the account was created. (Display only).
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Privilege Level - Pick

The privilege level (0, 1 or 2) affecting the types of activity allowed. 

Facility Lowest privilege level required

Updating of MD ............................................................................. 1

Use of magnetic tape...................................................................... 1

Use of DEBUG (other than P, OFF, END and G commands) ....... 2

Use of DUMP processor ................................................................ 2

Use of Assembler and Loader........................................................ 2

Use of FILE-SAVE and FILE-RESTORE processors ................... 2

It is recommended that you use level 2.

Initial Sys id

The system id for the first system to be created in the account. Eg PO for a Purchase Orders sys-
tem. While multiple system ids are allowed in an account, this prompt only applies if you are 
updating from a non-SB+ account to an SB+ account.

Note
To add a new system id to an existing account, use Admin > SB+ Setup > Initiate New Sytem in 
that account.

Sys Id Menu Description

A description for the system id. This will appear in the System menu and as a heading for the main 
menu when in this account and system id.
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Delete An Account

Allows you to delete an account.

Deleting an account destroys all data held in that account. Ensure you make a backup before delet-
ing the account.

Function Key

F2 - Accept

Accepts the screen parameters and initiates the process to delete an account.

Prompts

Account(s) to Delete

The name of the accounts to be deleted, separated by spaces.

Display Files (S/P/N)

Options are:

S displays the names of files being deleted to the Screen.

P sends the names of files being deleted to the Printer.

N does not print or display the names of files being deleted.
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Chapter 5 - Office Menu
Introduction

The Office menu provides a range of office automation tools, including a diary for managing inter-
office mail, activities, contacts etc.
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Office menu options are:

Diary allows you to maintain your diary. 

Receive Message displays a summary of messages sent to you. You may read the full text of any 
message and reply to and delete messages.

Send Message allows you to compose and send a message to selected users.

Purge Messages allows you to purge read messages, either up to and including a specified date, or 
all read messages.

Activity allows you to create or amend activities. These activities may become either scheduled 
events, appointments or to-do activities.

Contacts allows you to maintain contact details (company names, contact names, addresses and 
phone numbers).

Categories and Projects allows you to enter details of categories and projects. You may then ref-
erence these in activities and use them to classify contacts.

Reports and Enquiries provides a menu of reports based on your diary, activities, categories and 
projects.

Calculator calls up the SB+ calculator.

Diary Configuration allows you to tailor the configuration of your diary.

Time Zone Maintenance allows you to maintain city time zone definitions used by the TIME pro-
cess.

Maintain Repeat Flags maintains diary repeat flags used when producing calendar summary 
reports.
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Diary

Process /DIARY
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Diary Functionality
The Diary tool allows you to maintain to-do items, scheduled appointments, contacts and mes-
sages. Any activity can be converted to any other type of activity. 

You may make the contents of the diary private to the user, or shared between a number of selected 
users (specified at the Diary Configuration > Diary Private Flag (P/E) prompt). 

Function Keys

Note
Function keys differ in the calendar section of the diary and these are defined in the Calendar 
Prompts section following.

F2 - Save

Saves the diary contents.

F4 - Del Line

Allows you to delete an appointment or to-do line. The activity is deleted only when you save the 
Diary screen, using the F2 or F8 key.

F5 - More

Allows you to view and amend details for the current activity, determined by the current cursor 
position. If the activity has a time and date associated with it, that activity becomes an appoint-
ment. If more information is available for an activity, an ∗ is displayed below the column heading 
M.

F6 - Message

Allows you to send and receive messages. You are prompted for the type of action required. Using 
the F6 key at an appointment or to-do line allows you to optionally send these details as a message.

F7 - Contacts

Displays the Contacts screen, allowing you to add or amend contacts.
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F8 - Exit

Saves details and exits the diary without prompting for another date.

F9 - Swap

Swaps from the To Do List section of the diary to the Appointments section (and vice -versa).

F10 - Action

Displays the action bar:

Calc

Displays the SB+ calculator.

Time

Accesses the SB+ world time zone display.

Owner

Allows you to access the diary of another user. Security restrictions apply.

Sort

Allows you to sort the to-do list and appointments into priority and time order.

Reports

Provides a menu of various office automation reports.

Help

Provides a menu of help options.

Calendar Prompts

Owner

The owner of this diary.
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Date

Press the F3 key to select a date. The F5 and F6 key move the calendar forward and backward one 
month, while the F7 and F8 key move it forward and backward one year. The F9 key allows you to 
specify an internal format date.

Appointment or To Do

Options are:

A moves to the Appointments section of the diary.

T moves to the To Do List section.

To Do Prompts

P

A priority level for this item in the to-do list. This value is used when sorting the to-do list. Any 
input is acceptable.

S

Assigns a status to the to-do list activity. Any input is acceptable. D means Done and removes the 
activity to the archive DMDIARY.ARCHIVE. Any other status is carried forward.

M

An ∗ indicates more text which can be viewed using the F5 key.

To Do List

The activity or summary for the to-do list. Use the F5 key to enter more detailed text. If you add a 
time, the activity becomes an appointment.

Appointment Prompts

Time

The time (in a 24-hour clock this is either hhmm or hh:mm) at which the activity is due to take 
place. Enter P and a priority number to change this to a to-do activity.
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Durn

The optional duration of the activity in hours and minutes (this is either hhmm or hh:mm). 

S

The status of the activity. D means this activity is Done, and moves the activity to the archive file 
called DMDIARY.ARCHIVE. Any input is acceptable. 

M

An ∗ indicates more text which can be viewed using the F5 key.

Scheduled Activity

A summary of this activity. Use the F5 key to enter more information. If you remove the time, the 
activity will become a to-do item.

Receive Message

Displays a summary of all messages sent to you. You may read the full text of your messages, and 
delete or reply to them as appropriate. Use the cursor keys to move to the required message.
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An N in the Prio column indicates this message is new and has not been read by you. An ∗ in the M 
column indicates more text which can be viewed using the F5 key. 

To indicate you have read your mail, press the F5 key on the message line, press the F4 key to 
delete the line or press the F6 key to reply to the message. An r beside the message id indicates you 
have replied (an r is also displayed in the Priority field of the sender’s Send Message screen). 
When you save the message the date and time the message was read will be shown at the Read 
prompt in the sender’s Send Message screen.

Function Keys

F2 - Accept

Saves the current record of messages and their status.

F4 - Del Line

Deletes the entry on the current line.

F5 - More

Accesses any additional text for the message on which the cursor is positioned. An ∗ shows there 
is more text to be read. 

F6 - Reply To

Allows you to reply to the sender of the current message.

A private message may only have a reply sent to the originator. If any non originating recipients 
are present, they are removed and the following message displayed:

YOU MAY ONLY REPLY TO THE ORIGINATOR OF A PRIVATE MSG

The reply is then sent to the originator.

F7 - Msg Outg

Displays the Send Message screen, allowing you to send a new message.

If the cursor is positioned on a private message you will receive the following message:

WARNING A PRIVATE MESSAGE MAY NOT BE FORWARDED
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You are not prevented from entering the Send Message screen from where you may send other 
messages, but you are prevented from sending the current private message. 

If you do try to send the current private message you are again warned, and returned to the Send 
Message screen.

F8 - Convert

Converts the current message into a scheduled, appointment or to-do activity.

F9 - Time

Accesses the SB+ world time clock. 

Prompts

Prio

An N indicates this message is new and has not been read by you. An r indicates the message has 
been replied to.

Note
Any value may be used by the originator of the message.

Msg Id

The message id created automatically by the send-message process.

M

An ∗ under the M column indicates more text is available. Press the F5 key to view this additional 
information.Summary/RE

Summary/RE

The summary entered by the originator of the message.

Sender

The user id of the sender.
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Sent

The date the message was sent.

Send Message

Allows you to enter and send a message to selected users, or to review a previously sent message.
314 SB+ Server Administration Manual



Diary
Function Keys

F2 - Save

Saves the message and sends it.

F4 - Del

Deletes the message.

F5 - More

Allows you to convert the message to an appointment or to-do activity.

F6 - Status

Displays a summary of outgoing messages and shows the number of people who have read each 
message.

F7 - View Reply

Allows you to view a reply.

F8 - Msg In

Allows you to access the Incoming Messages screen.

F9 - Time

Allows access to the SB+ world time clock.

Prompts

Message ID

Accept the default value NEW if entering a new message. Enter a message id if amending or viewing 
an existing message.

Sender

The user id of the sender. (Display only).
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Message/RE

A summary of the message. This will be displayed on the recipient’s Incoming Messages screen.

Full Text

The (optional) full text of the message. 

Recipient(s)

The user ids of any recipients for the message. Alternatively, enter a group id to send the message 
to all users in the specified group.

Read

If a message that was sent has been read, this shows the date and time the message was read by 
each recipient. (Display only).

Reply

If a message that was sent was replied to, this shows the date, time and message id of the reply. 
(Display only).

Private Message (P/E)

Options are:

P the message is Private and only to be read by the recipients.

E Encrypts the message using your diary access code (specified at the Security > User 
Security Setup > Diary Access Code prompt).

Priority

An (optional) priority level determining the order in which messages are displayed on the recipi-
ent’s Incoming Messages screen. 1 is the highest priority.

Alert Recipient(s) Immediately (Y/N)

Options are:

Y alerts all recipients currently logged on. A summary of the message is displayed on their 
terminals.
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N does not interrupt users, but displays the message flag when the OA.MSG process is 
invoked.

Sent Date

The date the message was sent.

Sent Time

The time the message was sent.

Purge Messages

Process /MESSAGE.PURGE

Allows you to purge messages that have been read (the status N has disappeared from the Prio col-
umn of the Incoming Messages screen).

This option does not remove messages from the diary archive file; it removes references to the 
message from the user's message list.

Prompts

Purge All Read Messages

Options are:

Y deletes all read messages for the current user. 

N (default) allows you to use the following option to specify a date up to which messages 
will be purged.
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Purge To and Including Date

Only messages read up to and including the specified date are purged.

Activity

Allows you to create or amend activities. An activity is any transaction within the office system. It 
may be an appointment, a to-do item or a message (sent or received).

Any type of activity can be converted into any other type. Eg a to-do activity can be changed to an 
appointment by adding a scheduled date and time to it. An appointment can be sent as a message 
using F6-Message while the cursor is positioned on the message in the Diary screen.
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Function Keys

F2 - Save

Saves the activity parameters.

F4 - Del

Deletes the current activity record.

F5 - More

Allows you to add or amend information, at the Contact Company, Categories and Project 
prompts, if available.

F6 - Repeat

Allows you to repeat an activity (weekly meetings, anniversaries etc). F6-Activity Repeat Defini-
tion subscreen following.

F7 - Recipients

Displays the Send Message screen.

F8 - Msg In

Allows you to access your incoming message details.

F9 - Time

Accesses the SB+ world time clock.

Prompts

Activity Key

Accept the default value NEW if entering a new activity, otherwise enter the activity code. You can 
type the first part of the summary text, followed by the F3 key, to access the activity.

Owner

The owner of the activity. (Display only).
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Appointment/ToDo/Msg

Options are:

A Appointment (scheduled activity). An appointment has a date and time allocated to it.

T To-do activity. A to-do activity has a date allocated to it, but no time.

M Message. A message has a date and list of recipients allocated to it.

You may change an appointment to a to-do item, or post it as a message. You may change a to-do 
item to an appointment, or post it as a message. You may change a message to an appointment, or 
change a to-do item.

Summary/RE

A summary of, or reference to, the activity. This will be used whenever it is displayed in a diary.

On

Either the actual date of an appointment or the date for which a to-do item is displayed in the dairy 
to-do list.

at

The time of the appointment. Leave blank if A is entered at the Appointment/ToDo/Msg prompt 
above.

for

The (optional) duration of the appointment.

Priority

The (optional) priority level for this activity. This determines the order of the display in the diary. 
Any input is acceptable. 0 is higher than 1 and 1 is higher than A.

Status

The (optional) status of the activity. D (Done) archives the activity in the DMDIARY.ARCHIVE file. 
Any input is acceptable.
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Private

Options are:

P the activity is Private and restricted to nominated users. 

E Encrypts the activity using your diary access code (specified at the Security > User Secu-
rity Setup > Diary Access Code prompt). 

If blank then activity details are accessible to all users. The default is taken from your diary config-
uration.

Full Text

The full text required for the activity. The F5 key from the Diary or Message screen recalls this 
text.

Contact Company

The company code of any company that has contact persons associated with the activity. The F3 
key accepts company names, sort ids, or contact names, to retrieve their associated company.

Name

The (optional) name of the person to contact within the company selected.

Telephone

The (optional) telephone number of the contact.

Categories

The (optional) category code associated with the activity.

Projects

The (optional) project codes associated with the activity.
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Activity Repeat Definition F6

This screen is invoked by the F6 key from the Activity screen. It allows you to specify activities 
that repeat at specific intervals (eg birthdays, anniversaries, weekly meetings etc).

Function Keys

F2 - Save

Saves the activity repeat parameters.

F9 - Repeat Flags

Displays the Repeat Flags subscreen.

Prompts

Repetition Type Flag

The letter denoting the type of repetition. This is used when reporting. The type flags are main-
tained from the Diary Configuration screen or by the F9 key.

Repeat Expression

The repeat expression determining when the activity is to be repeated within your diary. The for-
mat is:

day[,dayofweek,];[weekinmonth,];[monthinyear,]

where:
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day is an actual date if no week or month is given, otherwise it is the day of the week or the day of 
the month. Eg 1;; is the first day (Monday) of every month, since no specific month is specified.

dayof week is an optional day in the week. You may separate different days with commas. Eg 
1,2,3;1; is the first, second and third day of the first week in every month.

weekinmonth is the optional week of a month. You may separate different weeks with commas. Eg 
5;1,2,3,4,5; is the fifth day (Friday) of every week (1, 2, 3, 4 and 5) in any month.

monthinyear is the optional month in the year. You may separate different months with commas. 
Eg 25;;12 is the 25th day (Christmas Day) of month 12 (December).
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Contacts

Process /CONTACTS

Allows you to maintain company names, contact names, addresses and phone numbers for con-
tacts.

Function Keys

F2 - Save

Saves the contact parameters.
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F4 - Del

Deletes the current record.

F5 - Categories

Allows you to allocate contacts to any optional categories.

F6 - Address

Allows you to enter contact’s delivery and postal address.

F9 - Time

Accesses the SB+ world time clock. 

Prompts

Contact ID

Accept the default value NEW if entering a new contact. Otherwise, enter the required contact code. 
You can enter part of a contact name, or an alternative id (Sort & Alt), followed by the F3 key.

Owner

The owner of the contact. (Display only).

Priv

Options are:

P contact details are Private to you and the diary users nominated in your diary configura-
tion.

E Encrypts the contact details using your diary access code (specified at the Security > User 
Security Setup . Diary Access Code prompt).

If blank then contact details are accessible to all users. The default is taken from your diary config-
uration.
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Phone

The telephone number for the contact. The first number entered is used as the default for the con-
tact names entered below.

Company Name

The company (or equivalent) name for this contact. This is displayed whenever this contact is ref-
erenced within a diary activity.

Sort & All

Alternate ids for the company name. The first id entered is used for sorting. Other ids are used for 
alternative access.

Fax

The fax number for the contact being defined.

Contact Names

The names of any contacts for the company being entered.

Contact Title

The (optional) title normally used for this contact. 

Telephone

The telephone number for a contact. The default is the first number entered at Phone.

Notes

Any (optional) notes about the contact. 
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Categories & Projects

Allows you to enter details for categories and projects. These can then be referenced in activities 
and used to classify contacts. You may select and report on any activity by category and/or project. 

Function Keys

F2 - Save

Saves the categories and project parameters.

F4 - Del

Deletes the categories and project parameters.

Prompts

Category or Project ID

Accept the default value NEW if entering new details, otherwise enter an existing id. Enter part of a 
name or an alternative name, followed by the F3 key to select from existing ids.
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Category or Project Type

Options are:

C details are for a Category.

P details are for a Project.

Owner

The user id of the owner. (Display only).

Private

Options are:

P the details are Private to you and users nominated on your diary configuration record. 

E details are to be Encrypted, and may only be decrypted by users designated in your user 
record in User Security Setup.

If blank then category and project details are accessible to all users. The default is taken from your 
diary configuration.

Name for Display

The name displayed within a diary or activity, if this category or project is referenced.

Alternative Name(s)

Alternative names for this category or project. These names are used as an alternative means of 
access for these details.

Description

Text to describe in detail the category or project being defined.
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Reports & Enquiries

Provides a menu of reports based on your diary, activities, categories, and projects. For most 
reports you have the option of printing either brief summaries or full reports.

Reports may be sent to:

S the Screen (within an optional window).

P the Printer, via the spooler.

X an auxiliary port

D a DIFF format file in xxWORK or another file.

F xxWORK.

B the printer, via a Background process.
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Calculator

Process /CALC

This option displays the SB+ calculator. In addition to using the calculator as a normal calculator, 
you may enter an expression in the calculator display field, whose result is returned into the current 
input field.

To select numbers or operators, either press the appropriate character on the keyboard or use the 
cursor keys to move to the required character on the screen and press the Spacebar to accept. Press-
ing the Enter or = key performs the calculation. 

S changes the sign of a value (from negative to positive and vice-versa).

The options on the calculator are:

CLR clears the current value from the calculator display field.
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A/C clears both the current value from the calculator display field and any value in mem-
ory.

M/C clears any value in memory.

M/R recalls any value in memory to the calculator display field.

M- subtracts any value in memory from the value in the calculator display field.

M+ adds the value in the calculator display field to memory.

Pcn (or N from the keyboard) allows you to define the precision of the results of your cal-
culation. 

% (or B from the keyboard) calculates the percentage of the current value. 

Function Keys

F2 - Return Value

Returns the value in the calculator display field to the current input field. Alternatively, this value 
is automatically placed in your input paste buffer and can be subsequently recalled by pressing 
your macro key twice. 

F7 - Run Process

Allows you to run a process.

F8 - Move

Allows you to move the calculator on the screen.

F9 - Expression

Allows you to enter an SB+ expression, and display its result.
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Diary Configuration

Allows you to determine the configuration for your diary.

Function Keys

F2 - Save

Saves the configuration parameters.

F6 - Update Xrefs

Rebuilds the various cross-references (activity ids of incoming and outgoing messages etc) held in 
DMDIARY. Normally you would use this option if you had upgraded to a new release of SB+ con-
taining additional features, or you suspect loss of data integrity due to anomalies within your diary 
system.

Prompts

Activity Default Flag (P/E)

Options are:

P activity details entered are to be set to Private by default. 

E activity details entered are to be Encrypted by default. 
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Otherwise leave blank. Users who have access to P and E entries are set up in the user record within 
User Security Setup.

Morning Appointment Char

An (optional) character to signify a morning appointment in your diary when viewing the calendar. 
Eg m.

Afternoon Appointment Char

An (optional) character to signify an afternoon appointment in your diary when viewing the calen-
dar. Eg a.

Morning & Afternoon Char

An (optional) character to signify both a morning and an afternoon appointment in your diary 
when viewing the calendar. Eg b.

Default List (A/T/MA/MT)

Options are:

A defaults to the Appointments section when you enter the diary. 

T defaults to the To-Do List section. 

MA sets the Appointment or To Do prompt on the Diary screen to A (move directly to the 
Appointments section). 

MT sets the Appointment or To Do prompt to T (move directly to the To Do List section). 

Diary Private Flag (P/E)

Options are:

P the diary is to be Private. 

E the diary is to be Encrypted.

If you enter E or P and press the Enter key, the Private Users Access screen is displayed wherein 
you may specify the users that have access to your diary. Otherwise leave blank.
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Activity Default Priority

Default priority for new activities.

Time Zone Maintenance

Allows you to maintain city time zone definitions used by the /TIME process.
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Function Keys

F2 - Save

Saves the time zone definition

F5 - Goto City

Allows you to go to a particular city. You are prompted for a line number, text or a multivalued 
page number.

F6 - Time

Displays the SB+ world time clock.

Prompts

Local City Name

The name of a city (which must appear in the following City list) that is in your time zone.

City

The name of a city to have time details entered against it. It is available when viewing times in dif-
ferent cities using the /TIME process.

Offset G.M.T.

The number of hours (plus or minus) the city in the previous prompt is ahead or behind Greenwich 
Mean Time (without taking Daylight Saving into account).

w.r.t. Local

The difference ‘with respect to’ the local time. (Display only).

Std Text

An (optional) abbreviation for the normal time zone name used to display the time in the specified 
city.
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Day

The day of the month Daylight Saving or Summer Time commences. If unknown, leave blank. 
This is used to adjust the lookup time display.

Month

The month Daylight Saving or Summer Time commences.

To Day

The day Daylight Saving or Summer Time finishes.

To Month

The month Daylight Saving or Summer Time finishes.

Time Text

An optional time zone abbreviation indicating Summer Time is in effect in this city. The default is 
DLS.
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Maintain Repeat Flags

Allows you to maintain diary repeat flags. These flags are used when producing calendar summary 
reports.

F2 - Save

Saves the diary repeat flag parameters.

Prompts

F An alphabetic character used by reports to represent the type of repetition. This is the key 
letter stored on file against an activity. Eg V for Valentines Day.
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L An alphabetic character to be displayed, rather than stored on file, representing the repeti-
tion type for reports. This may be different from that entered in the prompt above if multi-
ple languages apply.

Description

A description of the type of repetition. Eg Valentines Day.
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Logto Options
Introduction

This chapter describes the two remaining options on the System Administration main menu:

Shell allows you to enter an OE command or SB+ process.

Logto allows you to log between accounts without having to re-enter your user id and password 
for every account accessed.
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Shell

Process /SHELL or /TCL

The Shell option invokes the SB+ shell command line prompt, allowing you to enter any OE com-
mand or SB+ process (subject to security restrictions).

SB+ first checks if the first word entered at the prompt is a command, and if not, checks if it's an 
SB+ process.

The shell stack stores the last 100 command lines per user, any of which may be recalled for edit-
ing or executing. You may also group command lines together and place them in a menu for quick 
access and execution.

Function Keys

F2 - Save

Selects entries from the stack and saves them with their name and description and place in the 
menu.

F4 - Del

Deletes a saved menu stack.

F5 - List

Lists the current stack.

Menu F6

Lists the available saved stacks as a menu and allows selection.

F7 - Edit

Edits the current stack (all entries).

Stack Commands
The following stack commands may be entered at the shell command line:
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Command Description

Up arrow recalls the previous entry to edit and execute.

Down arrow recalls the next entry to edit and execute.

.L lists the last 20 commands on the stack.

.Ln-n lists the commands on the stack from n to n.

. recalls the last command to edit and execute.

.n recalls the stack entry n to edit and execute.

.Xn executes the stack entry n as is, with no edit.

.n,n-n,n-n,n multiple executions separated by a comma and/or range lists (hypen-delim-
ited).

.Dn,n-n deletes the current stack entry, or specified entry.

.Dname deletes the saved stack referenced by name.

.E edits the current stack using the screen editor.

.Ename edits the saved stack referenced by name, using the screen editor.

.Un converts the next n characters to uppercase.

If you enter a command with a ? at the end, the command is not executed but is pushed onto the 
stack.

You may also create synonyms for command line strings, using the following syntax:

synonym == commandstring

Eg:

TO.FIX == LIST SBFEEDBACK WITH TYPE = "P"

To delete a synonym from the list, use the following syntax:

synonym ==
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Logto

Process /LOGTO

The logto option allows you to log between accounts without having to re-enter your user id and 
password for every account accessed.

All requests are subject to security restrictions. If you enter a prohibited account or option, the 
message ACCESS DENIED is displayed and the request is denied.

Prompt

Logto Account (or OFF)

Enter the name of the account you wish to log to. Eg LEDGERS. You are logged to the new account 
without being asked for your user id or password again.

If you want to log straight to a specific system id within the account, append the system id after the 
account name separated by a comma. Eg LEDGERS,GL.

To log straight to a menu within a system id, specify the menu name after the system id. Eg LED-
GERS,GL,REPORTMENU.

To log straight to an option within a menu, append the option number to the menu name. Eg LED-
GERS,GL,REPORTMENU,2.

To log to the SB+ Administration account, you may specify SA (System Administration). This is a 
synonym for SB+.

To log off the system, enter OFF.
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Appendix A - Admin 
Within a User Account
The Admin option in a user account is very similar to the Admin option in the SB+ account.

There are some options under Admin that can only be run from the SB+ account and these do not 
appear in the user Admin menus. There are also options that are different and options that are 
additional.
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Options in the Admin menu (within a user account) are:

Files
The options here are exactly the same as for the SB+ account.

Printers & Terminals
The options here are the same as for the SB+ account except that the Initialize Spooler option in 
the Printer Management menu is not available in the user account.

Media Commands
The options here are exactly the same as for the SB+ account.

SB+ Setup
The SB+ Configuration Options option is only available in the SB+ account. The user account has 
three extra options:

Initiate New System

This allows you to create another system id within the current account. You are prompted for the 
system id prefix and description, after which the new system is initialized. If this is the second (or 
subsequent) system id in the account, you are presented with a System menu at logon (after enter-
ing your user id and password) to select the system you require.

Delete System

This allows you to delete a system id from the current account. You are presented with the System 
menu to select the system for deletion. A lookup window displays all the files created in the sys-
tem. Tag those you wish to delete. Normally this is all the files, but there may be some files created 
in this system that are used in other systems which you will not want to delete.
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Make sure you have a backup of this account before deleting the system in case you need to restore 
data inadvertently deleted.

Logon/Logto Subroutine

This allows you to specify a user subroutine to be called at logon/logto after security and print 
setup have been performed. An SB+ process cannot be executed from here and the user subroutine 
should not contain SB+ function calls, as SB+ COMMON variables are not fully initialized at this 
point.

System Enquiries
This option has a subset of options found in the SB+ account under the System House Keeping 
option:
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Your Terminal Settings (OE)

This is the same option as described in “Port Setup” on page 283.

List Users Logged On

This is the same option as described in “Port Setup” on page 283.

Display System Date & Time

This is the same option as described in “Port Setup” on page 283.

List Available Disk Space

This is the same option as described in “System House Keeping” on page 283.

Display Where Table

This is the same option as described in “System House Keeping” on page 283.

Detailed System Usage

This is the same option as described in “System House Keeping” on page 283.

List Overflow Fragmentation

This is the same option as described in “System House Keeping” on page 283.
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Security
This has the following options:

Group Security Setup

This is the same option as described in “Chapter 3 - Security Menu”.

User Security Setup

This is the same option as described in “Chapter 3 - Security Menu”.

Edit Your Macro Keys

This option invokes the /UK (User Keys) process to define your macro keys. This is described in 
“Define User Macro Keys F6” on page 102 in this manual, and “Appendix K - Macro Keys” in the 
SB+ Reference Manual.
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Change Your Password

Allows you to change your password. You are prompted for your existing password before you can 
change it.

Change Keyboard Timeout

Allows you to change your keyboard timeout – the number of minutes of inactivity before your 
keyboard locks and requires password entry to reactivate. You are prompted for your password 
before you can change the timeout.
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Management
The current SB+ Printer Manager differs substantially from the Printer Manager provided for 
releases up to and including release 2.3.2. However, it retains a number of features in altered form 
from the old, such as stationery types and locations, the COMMON variable PRINT.DEFN and the 
Printer and Spooler Maintenance functions.

The significant differences are:

• the way printers are defined and maintained.

• the way print defaults are determined and used.

• the printer assignment process.

• the scope and availability of the Printer Manager to SB+ tools and user processes.

• user interaction in the printing process.

• the addition of new features such as report types.

The diagrams on the following pages provide a schematic representation of the new Printer Man-
ager. The Printer Definition and Maintenance section provides an outline of the new system, with 
comparative notes on the old Printer Manager. The remaining sections describe the various ele-
ments of the new system in detail.
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SB+ Server Printer Management

Logon Printing

Maintain Stationery 
Type
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Assign Printer to a 
Report

Maintain report

Request Report 
Print
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Printer Entity
Printer Entity

Start & Stop
Sequences

Physical Class Stationery

Printer Class
e.g. EPSON

Stationery
e.g. A4, 15x11

Location
e.g. Administration

Device
e.g. PRN:

Form Feeds
Before, After

e.g. 0, 1

Name
e.g. ADMIN1

MV Stationery Table
Stationery Set Reset Orientation

*A4 NULL NULL NULL
15x11 NULL NULL NULL
LABELS NULL NULL NULL

Printer Class
e.g. EPSON

Attribute/Graphic
Set/Reset Sequence

Character
Graphics Table

Standard Cols
& Rows

e.g. 80, 60

Stationery
e.g. A4

Columns
e.g. 80

Rows
e.g. 60

Report Type
e.g. 01 15x11

Condensed Cols
& Rows

e.g. 132, 60

Flags
e.g. Color N
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PRINTER.SELECT and AUX.SELECT Forms
PRINTER.SELECT and AUX.SELECT Forms

The PRINTER.SELECT and AUX.SELECT forms (printer and stationery front-end processes for 
system and auxiliary printing) have been modified to display printer and stationery description. 
Also, the intuitive help for the stationery has been extended to display stationery name too, not just 
the stationery code.

In GUI mode there is now spin button available for No of Copies prompt.

In previous releases of SB+, when the default printer presented in PRINTER.SELECT or 
AUX.SELECT process was modified, the stationery was also changed to the first stationery entry 
for the new printer. This behavior has been modified to leave stationery intact if it is a valid statio-
nery for the newly selected printer.
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Printer Definition and Maintenance

Old Printer Manager
Printers were defined and maintained using the Printer Definition screen. This screen defined a 
hardware specific printer, in a similar manner to terminal definitions. The definition also included 
hardware dependent escape sequences and a graphic character equivalence table.

In addition, form queues (which correspond to a UniData/uniVerse form of the same name in those 
environments) and current stationery types and locations were defined in the printer definition. The 
stationery was associated with the form queue, with one stationery per form queue. Each form 
queue could be associated with only one printer definition at a time. The system printer device 
number was also uniquely associated with one printer at a time.

Printers could have a location specified, which was used to prevent assignment of a printer where 
the printer name was not present in the user’s group location list.

All printer related items, such as printer and stationery definitions, were stored in the file DMSECU-
RITY.

New Printer Manager
The new Printer Manager introduces the concept of physical printers and printer classes. Instead of 
keeping all hardware specific information, such as graphics tables and attribute escape sequences, 
in each printer definition, all such information is stored in the printer class.

Stationery types are separately defined and attached to the class. Each definition is a generic type 
which may be used in any class, with all stationery type set, reset, and page orientation sequences 
defined uniquely within the class, for each class. Thus, any number of classes may have a statio-
nery type of A4, with appropriate sequences for that class.

The printer entity is created by attaching a printer class to a physical printer, and specifying other 
real world parameters. The physical printer record name is used by the system when starting and 
stopping printers, and when printing. The physical printer record allows any class of printer to be 
associated with a printer entity.

With this system, it is possible to maintain entities such as ADMIN1 or ACCOUNTS.LABELS as con-
stants, while being able to change the actual printer hardware and device/port configurations to suit 
current hardware specifications.
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This relationship is discussed in “Physical Printer Definition - Pick” on page 160 and “Printer 
Class Definition - Pick” on page 165. The Printer Entity diagram shown previously provides a 
schematic representation of the printer entity.

Locations have been redefined. See “Maintain Locations” on page 185.

All printer related items are stored in the file DMSYSDEFN, with the exception of the printer control 
items created at logon and used at runtime, which are stored in DMSECURITY.

Determining Print Defaults

Old Printer Manager

The default printer was determined using a printer name or the word ASK in one of three places:

• the Port Configure screen.

• the Defaults subscreen (F10 from the Port Configure screen).

• the Terminals and Printers subscreen (F7 from the User Security screen).

Using ASK or ASK(printername) in any of these locations, or a multiple list of printers in the latter 
two locations, forced the user to be prompted for the printer name at logon. Entering a single 
printer name in any location caused this printer to be used without prompting at logon.

The selected printer’s current stationery type was used to determine the form queue, and the printer 
assignment was performed.

New Printer Manager

The old default system has been retained for compatibility, with the following changes. The initial 
assignment uses the printer name to ascertain the stationery type. The first stationery in the list 
attached to the physical printer record is used as the default, and default Assign Options and No of 
Copies is used.

In addition, the following additional default options are available:

• Global Print Defaults

• User Print Defaults

• Group Print Defaults
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These allow a complete specification of the default, without any assumptions being made. Physical 
Printer Name, Stationery Type, Assign Options and No of Copies may be specified. See “Setting 
Print Defaults” on page 360 for a discussion of the defaults hierarchy.

Printer Assignment

Old Printer Manager

At logon, the initial print assignment was performed using the printer name as described above. 
The current stationery type for the printer definition was used to determine the form queue.

In order to reassign printers, the Assign Form Queue screen was invoked. This allowed the user to 
nominate a form queue to change to. Selection of the form queue selected the printer definition and 
stationery type with which the form queue was associated.

Users could not directly request a change in form queue from a report or other print request, with-
out invoking the /PTR.ASSIGN process at the output redirection prompt or incorporating the process 
in the report. A change in printer assignment could be effected from Query and Report Writer 
reports using the Assign Printer To A Report tool. 

This allowed a stationery type and/or location name to be entered in the process definition of the 
report. When the report was printed, the printer parameters defined in the process definition were 
used to reassign the printer for the job, with the original environment being restored on comple-
tion. This process was invisible to users.

It was possible to change the current printer definition in use (and consequently PRINT.DEFN and 
the form queue) on the fly using the CHANGE.PRINTER process.

New Printer Manager

At logon, the default print parameters described above are determined and an initial assignment is 
performed based on these defaults.

Assignment within SB+ Tools is done on a per-print request basis. That is, when a report or tool 
print is requested, the user is prompted (if authorized) to use the defaults, either the user defaults or 
report print parameters, or change the printer for the current request. If display of the prompt 
screen is not authorized, then the defaults are used without user intervention. Once the selection is 
made, the parameters are saved, and the new assignment is performed.
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Once the job is printed, the printer environment existing prior to the selection is reinstated. The 
printer stack and printer assignment may be controlled from user processes (See “Using Printer 
Manager Calls in User Subroutines and Processes” on page 362).

The Assign Printer To A Report process has been retained, with the following changes: location 
and/or stationery are no longer used to determine the printer to assign. The printer name and statio-
nery type are explicitly specified, and when printing the report, these parameters are displayed 
instead of the user defaults in the prompt screen, where they may be changed if required.

You may change the default assignment used (and consequently the default PRINT.DEFN) for the 
life of the current logon session, including logging to other accounts, using the CHANGE.PRINTER 
process (described later). Logging off and on will reset the environment to the normal defaults.

Starting & Stopping Printers

Old Printer Manager

Under uniVerse, creating a printer definition started the printer; ie created an entry in the sp.config 
file and a device in the &DEVICE& file. The printer was stopped by deleting the printer definition; ie 
the entry for the printer was removed from sp.config and the device from the &DEVICE& file.

Similarly, if UDT:Print was installed in a UniData environment, creating a printer definition 
started the printer, and deleting the Printer Definition stopped the printer.

The Maintain Printers screen was used to display currently started printers and, if the user was a 
superuser, to enable or disable the printing for the printer on the current cursor line.

New Printer Manager

The Maintain Printers screen is now used for starting and stopping all printers, and for modifying 
the parameters used to start the printer (entered via the Physical Printer Definition screen).

Printer Manager Scope and Availability

Old Printer Manager

Users were only able to use the Assign Printer To A Report tool to change the printer (without 
invoking the PTR.ASSIGN process in Query and Report Writer reports). They had no access to the 
Printer Manager from subroutines or processes. 
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New Printer Manager

All SB+ tools that have a printing option use the new Printer Manager program SH.PRINT.MAN-
AGER to control printing. Users are able to call this subroutine from their own processes, subrou-
tines and SB+ paragraphs. See “Using Printer Manager Calls in User Subroutines and Processes” 
on page 362 for examples of calling this subroutine.

User Interaction

Old Printer Manager

There was no inbuilt user interaction at print time. When printing was selected, the currently 
assigned printer was always used. Reports with print parameters attached allowed a one-time 
change of assignment, but again without user interaction.

New Printer Manager

In all SB+ tools, the user is presented with the Printer Selection screen, with either the current 
user defaults, or the report parameters displayed. The screen allows users to change the physical 
printer, stationery type, assign options and number of copies for the current print job, or accept the 
parameters presented.

The display of this screen may be controlled with a flag in User Security and/or a flag in the pro-
cess definition of a report. See “Printer Selection” on page 359 for a detailed discussion of this 
topic.

New Features
A number of new features have been added:

• Third party printer management hook point. This allows a process to be specified in the 
System Control Record, which either bypasses the SB+ Printer Manager, or operates in 
conjunction with it.

• User print redirection hook point. This allows a process to be specified in the System Con-
trol Record, which either bypasses SB+ output redirection prompts, or operates in con-
junction with them.
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• Output to print file or to DIFF format items. These options allow a Report Writer report to 
have its print output stored in a print file, or the data normally displayed in the report to be 
written out in DIFF file format for export to a DOS spreadsheet.

• Report Writer and Query reports have new printer management related hook points.

• Report types. These allows you to group reports to one or more printers, and to nominate 
appropriate stationery for all reports in the group.

Printer Selection

When printing is requested, Printer Manager may optionally display the Printer Selection screen 
(shown above), which displays the current print parameters. The option to display the Printer 
Selection screen is set for each user in the User Security Setup screen, or by using the 
/USER.FLAGS process. Depending on the value of this flag, users may have the screen displayed 
for all print tasks, for Report Writer, Query and user defined user subroutine reports only, or never 
displayed. An optional flag in Report Writer and Query reports, or optionally passed from a user 
subroutine report may be specified to override the user security flag.

You may include physical printers in a location record. You may designate valid locations for a 
given group so that a member of that group only has access to the printers in the locations speci-
fied. Subject to this restriction, you may alter the parameters in the Printer Selection screen, 
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including the Printer Name, Stationery Type (which must be a valid stationery type in the class 
attached to the physical printer), Assign Options (which vary depending on the platform), and No of 
Copies.

Relationship With Other Tools

All printing functions in SB+ use the new Printer Manager to control selection of printers. The 
CHANGE.PRINTER process changes a user's defaults for the current session only.

Function Key

F2 - Accept

Accepts the print parameters, and proceeds with printer setup and printing.

Setting Print Defaults
The following hierarchical system is used to establish the print defaults for a user at logon. These 
defaults are displayed in the Printer Selection screen when printing (where allowed), or used as the 
printing defaults when no selection is permitted:

1. Physical printer names or the word ASK present in User Security Setup > F7-Term/Print. If 
ASK is present, the user is prompted for a physical printer name. If a list is present the user is 
solicited for the printer name, and the ∗ help list contains the names specified in the list. Any 
valid physical printer name is accepted. 

2. ASK specified at the Printer Name prompt in the Port Configuration screen for the current 
port. The user is prompted for a physical printer name. Any valid physical printer name is 
accepted.

3. Multivalued list of physical printer names or the word ASK present at the Printer Name 
prompt in the Default Terminal/Printer Specification screen. If the word ASK is present, the 
user is prompted for a physical printer name. If a list is present the user is solicited for a printer 
name, and the ∗ help list contains the names specified in the list. Any valid physical printer 
name is accepted.

4. User-specific print defaults may be set up in the user security record from the User Security 
Setup screen, using the F10 key action bar Print Defaults option. In the User Print Defaults 
subscreen the Systems Administrator may specify Physical Printer Name, Stationery Type, 
Assign Options and No of Copies specifically for individual users. A cross check of locations is 
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made so that default physical printer and stationery types may not be assigned to a printer out-
side the group locations.

5. Printer name specified in Port Configuration screen for the current port if not ASK. The default 
stationery type (ie the first), is read from the physical printer definition stationery type table. A 
default assign option of P or the platform equivalent is assigned, and a default of 1 copy is 
assigned.

6. Group specific print defaults may be set up in the group security record using the Print 
Defaults option in the action bar (F10) in the Group Security Setup screen. In the Group Print 
Defaults subscreen, the Systems Administrator may specify Physical Printer Name, Stationery 
Type, Assign Options and No of Copies specifically for a group of users. A crosscheck of loca-
tions is made so that the default physical printer and stationery types may not be assigned to a 
printer outside of the locations in the group’s parents.

7. Global print defaults. These are set up in the System Administration account (SB+) from the 
Admin > SB+ Setup > SB+ Configuration Options > Global Print Defaults option. In the 
Global Print Defaults screen, the Systems Administrator may specify Physical Printer Name, 
Stationery Type, Assign Options and No of Copies.

8. Default printer name defined in Port Configure defaults if a single printer name is entered (ie 
not ASK or a multivalued list). The default stationery type (ie the first), is read from the physi-
cal printer definition stationery type table. A default assign option of P or the platform equiva-
lent is assigned, and a default of 1 copy is assigned.

9. If none of the above are present, the default physical printer record DEFAULT.PRINTER, using 
the default printer class DEFAULT.CLASS, is used. The default stationery type (ie the first) is 
read from the physical printer definition stationery type table. If no stationery type is present in 
the table, the standard column and row values in the printer class are used. If these are not 
defined, default column and row values of 80 and 60 are used. A default assign option of P or 
the platform equivalent is assigned, and a default of 1 copy is assigned.
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Using Printer Manager Calls in User Subroutines 
and Processes

User Subroutines

The program SH.PRINT.MANAGER controls all printing functions in the Printer Manager. You may 
include calls to SH.PRINT.MANAGER in user subroutines, to set report parameters, as in the follow-
ing code example:

Program Example

PARAM = "SRP,":REPORT.TYPE:",":PHYSICAL.PRINTER
PARAM = PARAM:",":STATIONERY:",":ASSIGN.OPTS
PARAM = PARAM:",":NO.OF.COPIES:",":PRINT.SEL.FLAG
CALL SH.PRINT.MANAGER

where:

REPORT.TYPE is the report type assigned to the report.

PHYSICAL PRINTER is the name of a physical printer.

STATIONERY is the name of the selected stationery type.

ASSIGN.OPTS are platform specific assign options. Check your OE manual for details of assign 
options.

NO.OF.COPIES is the number of copies to be printed.

PRINT.SEL.FLAG overrides the current state of the Printer Selection Screen display flag setting in 
the User Security Setup screen. See the discussion of this flag in “Other Features” on page 365.

The following call should be used to reset the printer to the previous environment:

PARAM = "R" ; CALL SH.PRINT.MANAGER
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Printers may be stacked on as often as required. Care should be taken to match all S type calls with 
corresponding R type calls. Note, when using S type calls, you should use the PRINTER ON state-
ment to set the environment to print mode. You should not use PRINTER OFF and PRINTER CLOSE 
as the R type call performs these statements after any physical printer and/or stationery type reset 
sequences are printed. Otherwise, you may get two jobs on the spooler instead of one.

Paragraphs

Using the EXEC command, you may call the Printer Manager from a paragraph. In this case, you 
must use the comma delimited parameter form. The following example illustrates the method:

Program Example

LOCAL I
EXEC "B:SH.PRINT.MANAGER,S"
IF @RTN.FLAG THEN EXIT
PRINTER ON
FOR I = 1 TO 10

CRT I
NEXT I
EXEC "B:SH.PRINT.MANAGER,R"

Note the use of the S parameter. This parameter displays the user defaults, if the User Security 
Setup screen display flag is set to Y. This is the non-report mode of calling SH.PRINT.MANAGER. In 
this mode, report parameters REPORT.TYPE and PRINT.SEL.FLAG are not tested. You may use 
the syntax shown above in the User Subroutine subsection, suitably translated to paragraph format.
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Processes 

You may use user subroutine processes to perform these functions from anywhere in SB+, where 
appropriate. The following two PD.B screens illustrate this method:

In this case, the SRP parameter is used so that the Printer Selection screen display may be forced 
irrespective of the user’s security flag setting.
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Other Features

Hook for Third Party Printer Management

A hook point in Printer Manager allows you to specify a third party printer management/add-in 
process, the name of which is stored in the record PARAMS in the xxCONTROL file for each system 
id. You may also specify a @RTN.FLAG value within the user process to allow the SB+ Printer 
Manager to be bypassed completely, or to function normally in addition to the user process. 
@RTN.FLAG may be:

0 use normal SB+ print functionality in addition to user process.

1 do not use any SB+ print functionality; use only the user process.

X stop print job.

User Print Redirection Prompt

You may specify print redirection processes to replace the current prompts in SB+ (ie the 
Screen,Printer,auX (S/P/X) style of prompt). This allows you to bypass SB+ functionality or use it in 
conjunction with the user process.

These processes are specified for each system at the Prnt Redir Proc On and Prnt Redir Proc Off 
prompts in the System Control Record screen in the Tools > Other Tools/Utilities > House Keep-
ing menu (see your SB+ Reference Manual for further information). 

The on-process tests @VALUE and @RTN.FLAG on return, and if @RTN.FLAG is equal to X, the pro-
cess aborts completely. If @RTN.FLAG is not equal to X, @VALUE is tested for characters corre-
sponding to the enabling keys in the SB+ prompt. If present, SB+ functionality corresponding to 
that letter is performed, otherwise no SB+ functionality is performed. 

The off-process, if present, will bypass SB+ off functionality, otherwise SB+ functionality is used.

New features added to Report Writer redirection are:

• Output to a print file.

• Output to a DIFF file.

• Background processing (where supported by the platform).
SB+ Server Administration Manual 365



 Appendix B - Printer Management 
These redirection options provide you with a number of options. In the F8-More Report Parame-
ters subscreen from the F6-Report Parameters screen in the Report Painter, you may enter the fol-
lowing options at the File/DIFF Destn: File and Item prompts:

• to prevent output to a print file or DIFF file, enter NONE at the File prompt.

• to prompt at runtime for file and item, enter ASK at the File prompt.

• to specify a file and item, enter the file and item names at the File and Item prompts.

• to use the default file and item, leave the File and Item fields blank.

In Report Writer, Query and user reports you may specify a Printer Selection flag to allow the 
report to override the current setting of the Print Screen flag in the User Security Setup screen for 
the current user, without changing it; ie the flag operates only for the current run of the report.

For Report Writer, the flag is maintained via the Report Writer Definition > Report Parameters 
> More Report Parameters > Disp Print Sel Screen prompt. (see your SB+ Reference Manual 
for further information).

For Query, the flag is maintained via the Query Report Definition > More Query Parameters > 
Disp Print Sel Screen prompt. (see your SB+ Reference Manual for further information).

See “Using Printer Manager Calls in User Subroutines and Processes” on page 362.

The available options are:

A Always display Printer Selection screen.

N Never display Printer Selection screen.

If the Disp Print Sel Screen field is left blank, the Printer Selection flag in User Security Setup is 
used by the Printer Manager.

Report Types
Report types provide a method of matching Query and Report Writer reports to printers. The sys-
tem allows a single valid report type code to be attached to a report, and a list of valid codes to be 
attached to a physical printer. You may use any code for any physical printer.
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If a valid code is present in a report being printed, and a list of valid codes is present for the physi-
cal printer being selected, an attempt is made to locate the report's code in the physical printer's 
list. If not found, the report cannot be printed using the selected printer. Printing to the selected 
printer is allowed if either the report has no valid code, or the physical printer has no list.

A central list of valid report types is stored in the record REPORT.TYPES in the DMSYSDEFN file. 
The Maintain Report Types screen (accessed from Printers & Terminals > Printer Manage-
ment) maintains a multivalued list of report type codes. Codes may be in any format, but must be 
unique. You may optionally enter a description for each code. This table of report types is used in 
all systems across all accounts.

Developers should note that, as the report types table is global, you will need to consider unique-
ness when creating report types for your application. When the application is installed at a cus-
tomer site, it will be necessary to manually update the report type table during installation.

Assigning Report Types to a Physical Printer

The Report Type Table subscreen is accessed by F5 in the Physical Printer Definition screen. 

A multivalued list of report types may be assigned to the physical printer record using the Report 
Type Table subscreen. You may enter any valid report type, and optionally attach a stationery type. 
This stationery type must be in the printer class currently attached to the physical printer record 
being edited. If a stationery type is attached to the report type, and the requested report has the 
matching code, the stationery type specified for the report type overrides any other stationery type 
selection, including any selection made in the Printer Selection screen.

Associating Report Types with Reports

Report types are associated with the process definition of a Query or Report Writer report. When 
editing a Query report using the PD.E process, or a Report Writer report using the PD.R process, 
pressing F9 will display the Additional Report Parameters subscreen.

The report type for the report may be entered at the Report Type prompt in this subscreen, as well 
as in the Assign Printer To A Report screen. See the Assign Printer To A Report section for 
details of report type entry in these screens.

Report types may also be used in user subroutines to implement user subroutine reports. See 
“Using Printer Manager Calls in User Subroutines and Processes” on page 362.
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CHANGE.PRINTER Process
This process allows you to change your current print defaults, as displayed in the Printer Selection 
screen, for the current logon session only. The Printer Selection screen is displayed irrespective of 
your Security flag, where you may change the current defaults within the location restrictions pre-
vailing.

Once selected, the new defaults are displayed in the Printer Selection screen (unless overridden by 
a report assignment) for the life of the current logon session. On next logging on, you are returned 
to your normal defaults. This process may be disallowed in Group Security if required.

Eg if your current defaults are incorrect, due perhaps to a change in the printer entity, whether it be 
printer class, stationery type or other parameter, then running this process will allow you to change 
the defaults until a more permanent change can be arranged with the Systems Administrator.

SB+ Printer Setup Guidelines
This is a suggested procedure for setting up the SB+ Printer Manager definitions in a new installa-
tion. Although the structures may seem complicated at first, they are designed for maximum flexi-
bility. System maintenance to handle changing requirements will be small. The setup can also be 
simplified by not defining features which will not be used. Eg locations and report types are 
optional.

The following steps, carried out in the order given, will simplify the task of defining the various 
components of the SB+ Printer Manager: 

• Establish how many printers will be connected to the system, and what type of printer will 
be connected to what port.

• Determine how many printer classes will be required – one for each make and model of 
printer, or for each common emulation.

• Determine how many stationery definitions will be used. A separate stationery type must 
be defined for the following groups:

1. Reports which will share the same type of stationery (form queue) – note that the same 
stationery may be available on more than one printer concurrently.

2. Reports which must only be printed on a particular type of stationery, such as invoices 
and checks.
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3. Reports which must only be printed on a particular printer (this may also require a 
particular type of stationery).

• If the installation requires the use of locations, determine which locations will be used. 
Typically, locations are used to ensure that certain reports are directed to a specific room, 
floor or building.

• If the installation requires the use of report types, determine the report types to be used. 
Typically, report types are implemented for all reports and printers, and are used to allow 
printing of a particular report on specific printers only.

• Define a stationery type for each type of output which needs to be kept separate from all 
other types. Apart from distinguishing (say) plain paper, checks and invoices, stationery 
types can also be used to segregate the same type of paper on different printers. Eg reports 
to be printed on plain stationery on the line printer in the Accounts department are not con-
fused with reports to be printed on plain paper in a warehouse. On those platforms which 
use form queues or form names, a stationery type corresponds to a form queue or form 
name.

• Define the printer classes, and include all the stationery types which may be printed on 
each class. Printer effects such as special fonts and draft mode may be defined for each 
stationery type if required – the reset sequence should return the printer to its default set-
tings for any reports which do not have specific set and reset sequences.

• If locations are to be used, define them now, and specify which user groups have access to 
them by using the F8 key in Group Security Setup.

• Define the physical printers, and for each include the appropriate stationery types, allocat-
ing a form queue if the platform requires it. If locations are to be used, use the F7 key to 
specify the location of each printer. If report types are to be used, use the F5 key to specify 
the report types which may be printed on each printer. Printer effects such as special fonts 
which apply to all reports or the majority of the reports produced on the printer can be 
defined. The definition DEFAULT.PRINTER should be amended appropriately – it will be 
used if a report is not directed specifically to any other printer.

• For those reports which must be printed on special stationery, use the Assign Printer To A 
Report option to define the relationship. This may include specification of hold files and 
number of copies.
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• If the destination of all reports is predetermined, the Display Print Select Screen prompt 
in User security Setup should be set to N for all users. Otherwise, this flag should be set to 
Y for any users who may choose a printer destination at run time.

• Global print default settings should be defined in System Administration in the Global 
Print Defaults screen (See “SB+ Configuration Options” on page 259). If any groups 
require different defaults these can be defined from the action bar in Security > Group 
Security Setup. If further individual user defaults are required, these can be defined from 
the action bar in Security > User Security Setup.

• If the DEFAULT.PRINTER setting is not suitable for all users, alternatives can be associated 
with particular ports in Admin > Printers & Terminals > Port Configure. Individual 
users can have a list of printers defined by using the F7 key in Security > User Security 
Setup. The first printer listed is their default, and they may only direct reports to the nom-
inated printers.
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Auxiliary Printing

The SB+ Print Manager was further enhanced in release 4 of SB+ to provide fully featured auxil-
iary printing, especially in situations where SBClient is used. The new functionality adds most of 
the existing 'System Printing' features to the auxiliary print interface, plus some SBClient specific.

The following functionality is available with the SB+ Print Manager:

• Comprehensive system for setting of default auxiliary printer.

• New options for Display Aux Select Screen Flag of USER.FLAGS process.

• Selection of the printer and stationery at run-time and additional print output options for 
users of SBClient version 4 and later.

• Assignment of the auxiliary print parameters to individual reports.

• Use of printer setup sequences specified on printer class and physical printer definition 
records.

• New Logical Printer Definition to provide full use of Microsoft Windows print interface.

• Setting of stationery number of rows at run-time

Setting of Default Auxiliary Printer
The setting of the default auxiliary printer for the SB+ session is very similar to the setting of the 
defaults for system printer.

On initial logon, the auxiliary printer default is checked in User Security Term/Printer Setup screen 
(F7 in SEC.USER.SETUP). If the word ASK is present,  the user is prompted for a Physical 
Printer name. If a list is present, the user is prompted and the '*' help list contains the names speci-
fied in the User Security Term/Printer Setup screen.

If the word ASK is specified in Port Configure screen (TERM.CONFIG process, F9 sub-screen - 
REFERENCE) the user is prompted for the Physical Printer name. Any valid Physical Printer is 
accepted.
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If the multi-list of Physical Printer names is present in Port Configure screen (TERM.CONFIG 
process, F9 sub-screen - REFERENCE) the user is prompted for the physical printer and the '*' 
help list contains the names specified in the list.

User specific print defaults may be set in the User Security screen (SEC.USER.SETUP process - 
REFERENCE) using the Aux Defaults option on the Action Bar (F10). This screen allows admin-
istrator to specify Physical Printer name and Stationery to be used.

Group specific print defaults may be set in the Group Security screen (SEC.GROUP.SETUP pro-
cess) using the Aux Defaults option of the Action Bar (F10). The screen allows an administrator to 
specify Physical Printer name and Stationery to be used. The details entered here apply to the 
whole group.
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Global Print Defaults can be set in the System Administration account (SB+ or SB on some plat-
forms) from the Admin > SB+ Setup > SB+ Configuration Options > Global Print Defaults 
option (process SYS.PRINT.DEFAULT). The system administrator may specify Physical Printer 
name and Stationery to be used.

If none of the above are present, then the physical printer DEFAULT.PRINTER is used. The 
default (first) stationery type is retrieved from the Physical Printer definition record.

Tip
The process CHANGE.AUX.PRINTER can be used to change the current default auxiliary printer 
for the session.

The options for 'Display Aux Select Screen' Flag of USER.FLAGS process

The SEC.USER.SETUP process now contains the new Display Aux Select prompt. The available 
settings are:

Y - Always display SB+ Print Selection Screen.

N - Never display SB+ Print Selection Screen.
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W - Display Windows Print Setup Screen only.

The first option will prompt the user for the output details every time the output is directed to aux-
iliary print device.

The second option (never display SB+ Print Selection Screen) will bypass the above screen and 
use default auxiliary output details as determined at logon time.

The third option (Display Windows Print Setup Screen) applies to SBClient sessions only. It pre-
sents the user with Windows Print Setup dialog allowing the selection of the any printer connected 
to the network. The default Windows printer is the one set in SBClient session setup.

Note
SBClient version 4 is required for the third option (Display Windows Print Setup Screen) to be 
enabled. If no SBClient 4 is detected or the user is using dumb terminal this option behaves like Y 
option, ie. the user is prompted for the output details.

Selection of the printer and stationery at the run-time

When the report is run and auxiliary output selected, the setting of the user flag is checked and 
appropriate action taken.

The user flag setting of N uses the current session settings for the auxiliary printer, it does not dis-
play Print Selection screen,.
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Auxiliary Printing
The setting of Y invokes the AUX.SELECT process and allows selection of Printer and Stationery:

Function keys

F5 - Print Options - this key invokes 'Print Options' option of the SBClient's File menu. The screen 
allows users to set various print formatting parameters. For more details please consult SBClient 
documentation. 

F6 - Print Setup - here the user can select the target Windows printer. The presented screen is com-
mon Windows Print Setup screen. This option is the same one as SBClient's Print Setup option on 
the file menu.

Note
If you change any of the SBClient print settings and then save the session settings, the newly 
selected options become your default options.

Above processes (Print Options and Print Setup) require SBClient 4 to be used. If the processes are 
invoked from older version of SBClient or dumb terminal  the message "MAY ONLY BE RUN 
FROM SBCLIENT" is displayed. 
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Assignment of the auxiliary print parameters to individual 
reports

The auxiliary output parameters can be set specifically for individual reports via new 
PD.RD.ADDIT.AUX process. This process is accessed from PD.R screen, F9 - Additional Report 
Parameters, F5 - Aux Parameters. (REFERENCE)

The parameters entered here overwrite any other option set via other Print Default screens and pro-
cesses. The value of 'Disp Aux Sel Screen' flag in this case can be one of the following: 

A - Always display SB+ Print Selection Screen 

N - Never display SB+ Print Selection Screen 

W - Display Windows Print Setup Screen only 

Use of printer setup/escape sequences

Any specific printer setup sequences defined for Physical Printer and Printer Class definitions (set, 
reset, orientation, printer start and printer stop sequences) will be sent to the auxiliary output 
before/after the print job.

These sequences are normally used to select the appropriate physical printer settings like page 
length and orientation before the job is printed and to reset the printer after. 
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New Logical Printer Definition to provide full use of Windows 
print interface

For SBClient users there is new printer definition available which greatly simplifies the printer 
setup and does not require true escape sequences to be entered in Physical Printer/Printer Class 
definition screens. The Physical  Printer definition is called LOGICAL.PRINTER and it belongs to 
the class of LOGICAL.CLASS. All of the printer/font sequences for this class are translated  at 
run-time by SBClient/SBDesktop to the appropriate sequences suitable for Windows print drivers.

The idea behind this concept is that user only needs to specify LOGICAL.PRINTER as the auxil-
iary printer type and does not have to be concerned at all about setting up the appropriate class and 
escape sequences. In SBClient print options (File:Print Options from SBClient menu or F5 - Print 
Options from SB+ Print Select Screen) check the 'Use Windows Print Drivers' box. This is 
required for Logical Printer to work correctly. If that option is not checked the printer works in so 
called `pass-through~ mode, ie. all of the characters (including escape and graphic sequences) are 
sent directly to the printer.

The 'auto' stationery setting

The auxiliary print interface in SB+ has the capability to automatically determine number of lines 
(page size) when printing via SBClient. This completely eliminates need for pre-defined stationery 
in SB+ Print Manager. If the user is using Windows Print Drivers and Auxiliary Printing, the num-
ber of lines will be calculated accordingly to paper size, orientation and SBClient printer font. 

To enable this feature, the physical printer LOGICAL.PRINTER must be used when output is 
directed to Auxiliary port. Also, Windows Print Drivers option in File:Print Options must be 
selected.

This functionality is turned off by default. To enable it, edit the SB.CONTROL item in DMCONT 
file and set the value <34,6> to 1.

Note
If the report definitions contains pre-assigned stationery (via 'Addit:Aux Parameters' in 
PD.R/PD.E), the 'auto stationery' feature does not apply. In that case the number of lines will be 
determined by the stationery attached to the report process definition. 
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Logical Printer Escape Sequences

Note: ESC is used to represent CHAR(27).

ESC_P8+  Turns ON compressed mode printing. This causes a font point size to be selected that 
will allow 132 characters to be printed across a page using the full paper width. Note that the point 
size used here assumes a fixed pitch font so selecting a variable pitch font could cause the text to 
not reach the edge of the page or even run off the right edge.

ESC_P8-  Turns OFF compressed mode printing. This causes a font point size to be selected that 
will allow 80 characters to be printed across a page using the full paper width.                                           

ESC_PWnn Selects a font that will allow nn columns to be printed across a page. Note that using 
ESC_PW132 and ESC_PW80 are equivalent to ESC_P8+ and ESC_P8- respectively.                                             

ESC_PLnn Selects a font that will allow nn rows to be printed across a page.

ESC_PU+  Turns underlined printing ON. If the specified font that is being used does not support 
underline then this has no effect.

ESC_PU-  Turns underlined printing OFF.

ESC_PI+  Turns italic printing ON. If the specified font that is being used does not support italic 
then this has no effect.

ESC_PI-  Turns italic printing OFF.

ESC_PB+  Turns bold printing ON.

ESC_PB-  Turns bold printing OFF.

ESC_PV+  Turns reverse video printing ON. Reverse video is where the background is shown in 
black and the text as white.

ESC_PV-  Turns reverse video OFF.

ESC_PF"font family"  This sequence selects a font with the font family name specified between 
the double quotes "". 

ESC_PP+  Turns pass-through mode ON. Turning pass-through mode on means that all text until 
an ESC_PP- or ESC_PR is encountered is sent directly to the printer without being interpreted by 
the print program. This allows existing reports or print jobs that use some if the more complicated 
printer escape sequences to still be used.
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Note
Not all printer drivers support pass-through printing.

ESC_PP-  Turns pass-through mode OFF.

ESC_PR   Resets all printer settings.

Note
Any one escape sequence may contain a number of individual sequences. For example, the follow-
ing sequence selects a compressed bold reverse video font:

ESC_P8+ESC_PB+ESC_PV+

Use of Auxiliary Printer in User Subroutines and Processes

The program SH.PRINT.MANAGER controls all printing functions in the SB+ Print Manager. 
The calls to to SH.PRINT.MANAGER may be included in user subroutines and process, to set and 
reset auxiliary printer parameters.

The following is example of the call from user subroutines:

Program Example

PARAM = "SRPX,":REPORT.TYPE:",":PHYSICAL.PRINTER
PARAM = PARAM:",":STATIONERY:",,,"
PARAM = PARAM:PRINT.SEL.FLAG
CALL SH.PRINT.MANAGER

where:

REPORT.TYPE is the report type assigned to the report.

PHYSICAL.PRINTER is the name of the physical printer as defined in SB+.

STATIONERY is the name of the stationery attached to the printer.
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PRINT.SEL.FLAG overrides the current Display Aux Select Screen setting in the user security 
setup (or USER.FLAGS process).

The following call should be used to reset the default auxiliary printer settings to the previous 
state:

PARAM = "RX" ; CALL SH.PRINT.MANAGER

Using the EXEC command, you may call the Printer Manager from paragraphs. In  this case, you 
must use the comma delimited parameter form. The following example illustrates the method: 

Program Example

LOCAL I
EXEC "B:SH.PRINT.MANAGER,SX"
IF @RTN.FLAG THEN EXIT
CRT @TERM.DEFN<3,7>:
FOR I = 1 TO 10

CRT I
NEXT I
EXEC "B:SH.PRINT.MANAGER,RX"

Notice the use of the S parameter. This parameter displays the user defaults, if the User Security 
Setup screen display flag is set to Y. This is the non-report mode of calling SH.PRINT.MAN-
AGER. In this mode, report parameters REPORT.TYPE and PRINT.SEL.FLAG are not tested. 
You may use the syntax shown above in the User Subroutine calls as well.
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Auxiliary Print Interface Improvements

The auxiliary printing in has been improved from release 5 to automaticaly determine number of 
lines to use when printing via SBClient. This completely eliminates the need for pre-defined statio-
nery in SB+ Print Manager. If the user is using Windows Print Drivers and Auxiliary Printing, the 
number of lines will be calculated accordingly to paper size, orientation and SBClient printer font.

To enable new feature, the physical printer LOGICAL.PRINTER must be used when output is 
directed to Auxiliary port. Also, Windows Print Drivers option in File > Print Options must be 
selected.

The new functionality is turned off by default. To enable it, edit the SB.CONTROL item in 
DMCONT file and set the value <34,6> to 1.

Note that if a report has stationery pre-assigned (via 'Addit:Aux Parameters' in PD.R/PD.E), the 
'auto stationery' feature does not apply. In that case the number of lines will be determined by the 
stationery attached to the report process definition.
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Appendix C - Printer 
Management for 
uniVerse
For uniVerse installations, some Printer Manager screens differ from the default screens described 
in “Appendix B - Printer Management”. This appendix describes those Printer Manager screens 
which differ.
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Physical Printer Definition

Process /PHYSICAL.PRINTER

The Physical Printer Definition screen is accessed from the Admin > Printers & Terminals > 
Printer Management menu. It allows you to define the physical printer entity, and specify the 
physical attributes relevant to the actual printer. These attributes are:

• Printer class and stationery type/form names.

• Unix device, uniVerse print driver and lock files.

• Start and stop escape sequences.

The start and stop escape sequences are usually used to set a printer to the emulation required for 
the associated printer class, and reset if required after the completion of a job.
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The physical printer entity describes the characteristics of the actual printer in use for a given sys-
tem port or device. It is defined in SB+ with a meaningful name, which SB+ uses to refer to the 
printer. The name specified is independent of any system specific number, name or device, but may 
be any of these if desired (any alphanumeric name is acceptable). The physical printer can be 
regarded as an entity independent of the hardware it currently defines or the software that drives it.

Eg the physical printer SYSTEM describes the entity that is the main SB+ printer. The device 
defined by SYSTEM may be one of several different types of printer, running under different emula-
tions on different ports or devices.

Other parameters are maintained from subscreens:

• Location.

• Real time printer parameters.

• Report types.

If you are associating a printer class with the physical printer record then stationery types associ-
ated with a printer class must have uniVerse form names associated with them. This is not required 
if you do not need forms for your printing requirements. This may be specified using a parameter 
subscreen, discussed later.

This screen is not used to start or stop printers. The records created are definitions, which remain 
constant, irrespective of actual started printers, until changed by the Systems Administrator. Note 
that any user who has access to the Printer Management menu and/or processes may create and 
maintain a physical printer definition. Superuser or print group permissions are not required.

The physical printer definition is used, with printer class and stationery type definitions, to create 
the PRINT.DEFN COMMON variable and associated runtime items in DMSECURITY.PRINT.DEFN is 
used in conjunction with the Printer Manager throughout SB+.

Function Keys

F2 - Save

Saves the physical printer definition. If the physical printer edited is the current printer in 
PRINT.DEFN, then PRINT.DEFN is automatically updated.
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F4 - Del

Deletes the physical printer definition. If the definition is in use, deletion is prevented. The physi-
cal printer DEFAULT.PRINTER may not be deleted.

F5 - Report Type

Displays the Report Type table. This table allows you to enter report types defined by the Systems 
Administrator in the System Administration Account (SB+), and optional stationery types to be 
used if a report with the appropriate report type is being printed using the current physical printer. 

F6 - Defaults

Displays the Default Printer Characteristics subscreen. This is where defaults for realtime printer 
parameters may be entered. See “Default Printer Characteristics F6” on page 389.

F7 - Location

Allows you to maintain the current physical printer's location.

Locations for all physical printers may be maintained from the Maintain Locations screen in the 
Admin > Printers & Terminals > Printer Management menu.

F10 - Action

Displays the action bar:

Print Prints a detailed Physical Printer Definition report. Output may be redirected.

Copy Copies physical printer definitions.

Help Displays a menu of help options.

Prompts

Printer Name

The name of an existing physical printer to edit, or a suitable name to define a new physical printer. 
The Printer Manager always refers to the printer using names defined here.

Current Location

The physical location of this printer. (Display only).
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Description

A meaningful description. Eg Main System Printer (/dev/lp0).

Unix Device

The full Unix pathname to the device to which this printer will be attached. The pathname must be 
preceded with a \ character (to avoid the first / of the path being interpreted as a process call).

Driver Path

The full Unix pathname to the shell script used by uniVerse as the printer device driver. The path-
name must be preceded with a \ character.

Printer Class

The printer class is defined using the Printer Class Definition screen in the Admin > Printers & 
Terminals > Printer Management menu. The printer class contains control sequences relating to 
a class of printers. Associating a printer class with a physical printer means that the physical 
printer inherits the generic characteristics of the printer class, while it is associated with that partic-
ular printer class.

You may change the associated printer class at any time. This allows you to redefine a physical 
printer in terms of the actual printing hardware, while retaining the same identity.

Stationery Types

If this field is blank, the stationery types that were associated with the printer class specified at the 
Printer Class prompt are displayed. The field may then be edited. Stationery types not required 
for the current physical printer may be deleted. If an accidental deletion occurs or the stationery 
type list needs to be expanded, an F3 lookup is available. Only stationery types defined for the 
printer class specified may be selected.

Form Names

You must assign a uniVerse form name to the stationery type if you specify a stationery type, and 
have specified that the form name should be included in SETPTR and/or sp.config in the Physical 
Printer Definition > Default Printer Characteristics > Environment Defaults subscreen. You 
may assign any form name any number of times.
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In general, you should assign a form name which is the same as the stationery type name, to pre-
vent confusion. See the uniVerse Spooler Administration section of the uniVerse System Adminis-
tration manual for further details on form name usage.

The Printer Manager leaves form name manipulation to the operating system as much as possible. 
Eg specifying a form name that is different from that used in the started printer (See Maintain 
Printers later), and printing using that stationery type, produces a job that is held on the spooler, 
which may be manipulated as required.

Lock File Path(s) 1 & 2

The full Unix pathname of the file that will be used when sharing this printer with other Unix Pro-
cesses. See the uniVerse Spooler Administration section of the uniVerse System Administration 
manual. The pathname must be preceded with a \ character. Up to two paths may be entered.

Start Sequence

An escape sequence to be sent at the start of a print job. This is usually used to set a printer to the 
emulation mode required by the printer class associated with the physical printer entity for that 
printer.

This sequence is sent at the start of every print job, if defined.

Stop Sequence

An escape sequence to be sent at the end of a print job. This would usually be used to reset a 
printer to native or another emulation mode if required. This sequence is sent at the end of every 
print job, if defined.
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Default Printer Characteristics F6

This subscreen is displayed by pressing the F6 key from the Physical Printer Definition screen. It 
allows the definition of default characteristics for the printer which will be started using this phys-
ical printer definition. These defaults will be used at start time, unless modified using the F7-Mod-
ify Printer Parameters subscreen from the Maintain Printers screen. Any user who has access to 
the Printer Manager may enter or modify these defaults; superuser and/or print group permissions 
are not required.

Many of the parameters in this subscreen refer to serial printers. Any value entered for those 
parameters, eg Baud, Parity and so on, will be ignored for parallel devices.

Function Keys

F2 - Accept

Accepts the screen parameters.

F6 - Environment Defaults

Displays the Environment Defaults subscreen. This is where the inclusion of printer and form 
names in the uniVerse print environment is specified. See “Environment Defaults F6” on page 391. 

Prompts

Flow

The method of flow control for this printer.
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Baud

The speed at which the computer is to communicate with the printer.

Parity

The type of error checking which will be used by the computer when communicating with the 
printer.

Print

Enter Y if printing is to be enabled on this printer when the spooler is initialized (which will occur 
when the printer is started in Maintain Printers). Enter N if not.

Queue

Enter Y if queuing to this printer is to be enabled when the spooler is initialized (which will occur 
when the printer is started in Maintain Printers). Enter N if not.

CR Cnv

The uniVerse term for the type of conversion carried out on a carriage return on output. Null means 
no conversion.

Tabs

Enter Y if embedded tabs are to be expanded to eight spaces in the output. N if not.

FF

The form feed delay factor to be used. One of three values may be entered. See your uniVerse doc-
umentation for more information or press the F3 key.

LF

The line feed delay factor to be used. One of nine values may be entered. See your uniVerse docu-
mentation for more information or press the F3 key.

Wrdln

The number of bits which comprise one word of data for this printer.
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Other Opts

Enter other uniVerse spooler options, such as PTERM settings. See your uniVerse documentation 
for more information.

Environment Defaults F6

This subscreen is displayed using the F6 key from the Default Printer Characteristics subscreen. 
It allows printer and form names to be included in or excluded from the environment.

Function Key

F2 - Accept

Accepts the environment defaults.

Prompts

Include Printer Name in SETPTR

Enter Y if the printer name is to be included in SETPTR when a user logs in or uses a different 
printer/stationery type when printing. This ensures that output will go to the specified printer, 
rather than the uniVerse default printer. You should always enter Y to correctly use printers defined 
in SB+, unless you use only one printer. Enter N to prevent inclusion of the printer name.
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Include Form Name in SETPTR

Enter Y if the form name is to be included in SETPTR when a user logs in or uses a different 
printer/stationery type when printing. This ensures that output will be printed when a stationery 
type/form name combination is specified, and the actual form name on the started printer is set to 
the form name associated with the stationery type. You should always enter Y when stationery 
types are associated with a physical printer that has been started. If no stationery types are speci-
fied in the current physical printer, the response is forced to N. Enter N to prevent inclusion of the 
form name.

Create Form Name in sp.config

Enter Y if the form name is to be added as an attribute in the sp.config item in the spooler directory. 
This ensures that uniVerse will know about a form when it is specified in the SETPTR verb. If the 
Include Form Name in SETPTR prompt has a value of Y, this field will be forced to Y, or N if the 
prior value is N. This ensures that printers set up in SB+ work correctly, and unnecessary informa-
tion is not entered in sp.config.
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Printer Class Definition

Process /PRINTER.CLASS

The Printer Class Definition screen is accessed from the Admin > Printers Terminals > Printer 
Management menu.

The printer class specifies the table of graphic, color and other miscellaneous escape sequences 
used by a family or class of printers. Additionally, the stationery types for this class are specified in 
this screen.
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Eg you may define the printer class EPSON.CLASS to contain the sequences for the Epson family 
of dot matrix printers. You may associate this printer class with any physical printer whose current 
device is an Epson dot matrix printer (or any one of the many printers which have an emulation for 
this printer). You can switch the emulating printer to the Epson emulation by entering the switch-
ing sequence at the Start Sequence prompt in the Physical Printer Definition screen.

You may associate an unlimited number of stationery types with a printer class. For each stationery 
type, you may define margins, auto-spooler formatting, inter-job page advance, banner print state, 
Report Writer form feed behavior and stationery type-specific set, reset and page orientation 
sequences for printers requiring these sequences (such as laser printers).

The printer class, physical printer and stationery type definitions are used to create the PRINT.DEFN 
COMMON variable, and associated runtime items in DMSECURITY. PRINT.DEFN is used in con-
junction with the Printer Manager throughout SB+.

Function Keys

F2 - Save

Saves the printer class definition. If the printer class edited is the current printer class in 
PRINT.DEFN, then PRINT.DEFN is automatically updated.

F4 - Del

Deletes the printer class definition. If the definition is in use, deletion is prevented. The class 
DEFAULT.CLASS may not be deleted.

F5 - Color

The Printer Class Colors screen is displayed if the Color prompt is set to Y. This screen allows 
you to define foreground and background colors for a color printer. At present, the Printer Man-
ager does not support color printing; however, the table is stored in PRINT.DEFN, and may be refer-
enced in reports or user subroutines. See “Printer Management” on page 159.

F8 - Stationery

Allows you to maintain stationery type definitions. See “Printer Management” on page 159.
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F9 - Seq+

The Additional Print Sequences screen allows you define additional escape sequences for physical 
printers and stationery types, in the same manner as the Additional Terminal Sequences in Termi-
nal Definitions. These sequences are not used by SB+, but are available for user subroutines. Phys-
ical printer sequences may be accessed in PRINT.DEFN<25,x>, and stationery type sequences in 
PRINT.DEFN<26,x>, where x is the value number based on the order of entry in the subscreen. See 
“Printer Management” on page 159.

F10 - Action

Displays the action bar:

Print Prints a detailed Printer Class Definition report. Output may be redirected.

Copy Copies printer class definitions.

Help Displays a menu of help options.

Prompts

Printer Class

The name of an existing printer class to edit, or a new printer class definition.

Description

A meaningful description. Eg Epson LQ Printers.

Description (graphics)

Displays the description of the character displayed in Graphics mode.

Characters

Characters may be entered either as the printable character (where the character is printable) or as 
the decimal ASCII equivalent of the character, enclosed in parenthesis.

Graphics Mode On

An escape sequence to switch graphics mode for the printer on. Check your printer's manual to 
ascertain the correct sequence. 
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Graphics Mode Off

An escape sequence to switch graphics mode for the printer off. Check your printer's manual to 
ascertain the correct sequence. 

Stationery Type

A stationery type from the defined stationery type list. A stationery type may be associated with as 
many printer classes as desired, but may be specified only once within the same printer class.

TM

The number of blank lines that will be printed at the top of a page before the text is printed. The 
default is 3. If no value is entered, this default is used.

BM

The number of blank lines that will be printed at the bottom of a page after the text is printed. The 
default is 3. If no value is entered, this default is used.

Fmt

Enter Y if you wish the printed output to be formatted automatically by the uniVerse spooler. Enter 
N if the application will control all formatting and pagination.

Ban

Enter Y if you wish a banner to be printed before each job. Enter N if not. If Y, you will be prompted 
for a banner name.

IJA

Enter Y if you wish to suppress the eject between each completed print job. Enter N if not.

FF

Enter Y if the Report Writer should send a form feed to advance to the next page of a job. Enter N if 
not.
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Set

An escape sequence to switch the printer to the stationery type setting. This is usually required for 
memory mapped printers such as laser or inkjet devices. Check your printer's manual to ascertain 
the correct sequence. The characters may be entered either as the printable character (where the 
character is printable) or as the decimal ASCII equivalent of the character, enclosed in parenthesis.

Reset

An escape sequence to reset the printer's stationery type setting. Check your printer's manual to 
ascertain the correct sequence.

Orient

An escape sequence to set the printer's Page Orientation mode. Check your printer's manual to 
ascertain the correct sequence.

Color

Enter Y at this prompt to allow color printer escape sequences to be defined.

Standard Columns

Where a printer class has no stationery type defined (which is a valid condition), the value entered 
at this prompt is used to set the page width for printing.

Rows

Where a printer class has no stationery type defined (which is a valid condition), the value entered 
at this prompt is used to set the page depth for printing.

Condensed Columns

The Report Writer will use this value for its condensed mode width instead of the automatic calcu-
lation, if a value is entered at this prompt.

This parameter is not otherwise used by SB+, but is available for user processes. The parameter is 
located in the common variable PRINT.DEFN<5,4>.

Rows

This parameter is not used by SB+, but is available for user processes. The parameter is located in 
the common variable PRINT.DEFN<5,5>.
SB+ Server Administration Manual 397



 Appendix C - Printer Management for uniVerse 
Printer Class Definition (follow on subscreen)

You may display this subscreen using the Page Down key from the Printer Class Definition screen.

Function keys are the same as the main screen, except that there is no F9-Seq+ function key. 
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Prompts

Print Attributes

The printer class. (Display only).

Description

A description for the print attribute escape sequence. SB+ is shipped with predefined escape 
sequence descriptions, which the Printer Manager uses when printing Report Writer reports. You 
may enter new attribute descriptions and sequences, and refer to them in processes or subroutines. 
The on-sequences are stored value-delimited in attribute 3 and the off-sequences are stored value-
delimited in attribute 4 of the COMMON variable PRINT.DEFN.

On Sequence

An escape sequence to select the attribute for the printer. Check your printer's manual to ascertain 
the correct sequence. The characters may be entered either as the printable character (where the 
character is printable) or as the decimal ASCII equivalent of the character, enclosed in parenthesis. 

Off Sequence

An escape sequence to deselect the attribute for the printer. Check your printer's manual to ascer-
tain the correct sequence. 
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Maintain Printers

Process /LISTPTRS

The Maintain Printers screen is accessed from either the Admin > Printers & Terminals > 
Printer Management menu or by pressing the F9 key in the Maintain Spooled Reports screen.

The screen is used to start and stop all printers, and allows parameters entered in the physical 
printer definition used to start the printer to be modified.

To start a printer

1. On the current cursor line, enter the physical printer name. The current location will be dis-
played, if defined.

2. Modify the Unix path if required.
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3. Enter a form name. The form name should be one of the names associated with a stationery 
type associated with the physical printer. You may enter any form name; however, a warning is 
displayed if the form name is not associated with the physical printer.

If you wish to modify the default printer characteristics for the current physical printer, move back 
to the line containing the required printer and press the F7 key. The Modify Print Parameters 
subscreen allows you to modify these parameters.

If you want to stop a printer then move the cursor to the line containing the printer you wish to stop 
and delete the line, using the line delete key.

You may enter as many printers to start, or remove as many printers as required. To start and/or 
stop the printers press the F2 key. When the changes are performed, the screen will be redisplayed, 
allowing you to check the result of your action.

You may only start and stop printers, or modify the parameters and the current form if you are 
logged on as superuser. Otherwise, you may view all printer information, but you cannot modify it.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.

F5 - Toggle Pr

This option toggles the Print Enable flag on and off for the current printer. This is the same as the 
Unix level uniVerse command:

usa -p printername +/-n

Only users who are logged on as superuser or are members of a print group that contains the 
printer on the cursor line may amend this flag.

F6 - Toggle Qu

This option toggles the Queue Enable flag on and off for the current printer. This is the same as the 
Unix level uniVerse command:

usa -p printername +|-q

Only users who are logged on as superuser or are members of a print group that contains the 
printer on the cursor line may amend this flag.
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F7 - Mod Pr Params

Displays the Modify Print Parameters subscreen. This is where defaults entered in the Physical 
Printer Definition > Default Printer Characteristics screen may be amended. See the “Modify 
Print Parameters Subscreen F7” on page 403.

Only users who are logged on as superuser may amend details in this subscreen. Other users may 
access this subscreen on a display only basis.

F8 - Pr Group

Displays the Maintain Printer Groups subscreen. This is where the uniVerse file print_group may 
be maintained. See your uniVerse documentation for more information on print groups.

Only users who are logged on as superuser may access or amend details in this subscreen. See the 
“Maintain Printer Groups Subscreen F8” on page 406.

F9 - Pr Jobs

Displays the Maintain Spooled Reports screen. See “Maintain Spooled Reports” on page 408 for 
details.

Prompts

Printer Name

A physical printer name from the set of defined physical printers.

Location

Shows the location for the physical printer entered if it has been defined. (Display only).

Printer Path

This corresponds to the Unix Device Name field in the physical printer record. The default from 
the physical printer record will be displayed, and may be amended if required. The pathname must 
be preceded with a \ character. The path must be a valid path to a Unix device.
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Form Name

A form name to start the printer with. This may be any form name, but should be one of the form 
names associated with the stationery types entered in the physical printer definition. You will be 
warned if the entered form name is not one of these. The F3 key provides a list from the physical 
printer definition. The default is the value entered for the first stationery in the physical printer def-
inition. For started printers, the current form name will be shown.

This field may be amended by a member of a print group containing the printer on the current cur-
sor line, or by a user logged in as superuser. The field may only be initialized (eg when starting a 
printer) by a user logged in as superuser.

Modify Print Parameters Subscreen F7

This subscreen is displayed by pressing the F7 key from the Maintain Printers screen. It allows you 
to modify the default characteristics defined for the printer in the physical printer definition. These 
parameters may be changed at any time.

Many of the parameters in this subscreen refer to serial printers. Any value entered for those 
parameters, eg Baud, Parity and so on, will be ignored for parallel devices.

You must be logged in as superuser to be able to change any of these parameters. SB+ assumes the 
standard uniVerse setup; ie sp.config and the &DEVICE& file are created with root only permissions, 
and SB+ does not attempt to determine whether a particular user may or may not have read/write 
permissions in a particular case. All access decisions are based on user status.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Lock File Path(s) 1 & 2

The full Unix pathname of the file that will be used when sharing this printer with other Unix pro-
cesses. See the uniVerse Spooler Administration section in your uniVerse System Administration 
manual. The pathname must be preceded with a \ character. Up to two paths may be entered.

Driver Path

The full Unix pathname to the shell script used by uniVerse as the printer device driver. The path-
name must be preceded with a \ character.

Flow

The method of flow control for this printer.

Baud

The speed at which the system communicates with the printer.

Parity

The type of error checking which will be used by the system when communicating with the printer.

Print

Enter Y if printing is to be enabled on this printer when the spooler is initialized (which will occur 
when the printer is started in Maintain Printers). Enter N if not.

Queue

Enter Y if queuing to this printer is to be enabled when the spooler is initialized (which will occur 
when the printer is started in Maintain Printers). Enter N if not.
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CR Cnv

The uniVerse term for the type of conversion carried out on a carriage return on output. Null means 
no conversion.

Tabs

Enter Y if embedded tabs are to be expanded to 8 spaces in the output. Enter N if not.

FF

The form feed delay factor to be used. One of three values may be entered. See your uniVerse doc-
umentation for more information or press the F3 key.

LF

The line feed delay factor to be used. One of nine values may be entered. See your uniVerse docu-
mentation for more information or press the F3 key.

Wrdln

The number of bits which comprise one word of data for this printer.

Other Opts

Other uniVerse spooler options, such as PTERM settings. See your uniVerse documentation for 
more information.
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Maintain Printer Groups Subscreen F8

This subscreen is displayed by F8 from the Maintain Printers screen. It allows users logged in as 
superusers to maintain the print_group item in the uniVerse spooler directory from within SB+. No 
other users may access this subscreen. See your uniVerse documentation for more information.

Function Key

F2 - Accept

Accepts the details entered into this screen.

Prompts

Printer Group

The printer group name. This may be any name considered valid by the Systems Administrator.
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Member Users

The list of users in this group, comma-delimited. Eg susan,fred.

Note
These are the Unix logon names, not SB+ user ids.

Group Printers

The list of printers in this group, comma-delimited. Eg ACC1,AUD2 or all (lowercase). Press the F3 
key for a list of physical printer definitions.
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Maintain Spooled Reports

This screen is accessed from the Admin > Printers & Terminals > Printer Management menu. 
It allows you to view/maintain print jobs currently held in the spool queue. There are facilities to 
delete spooled entries or to alter the printing parameters, such as the number of copies and whether 
or not the report is to be held in the spooler even after it has been printed.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.
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F5 - View Job

Displays the current job on the terminal (the line being edited).

F9 - Printers

Invokes the screen to maintain printers.

Prompts

Printer Name

The name of the printer to which the print job is being sent.

Form Name

The form to which the print job is assigned.

Unix User

The user who created this print job. (Display only).

Entry

The entry number of the print job in the spooler. (Display only).

Co

The number of copies specified for this print job.

Status

The option to determine the action to be taken on this print job. See your OE manual.

Size

The size of the print job in bytes. (Display only).

Active Form

This displays Y if the form for this print job matches the active form on the printer, and N if the 
form for this print job does not match the active form on the printer. (Display only).
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Initialize Spooler

The Initialize Spooler screen is accessed from the Admin > Printers & Terminals > Printer 
Management menu in the System Administration Account.

You must be logged on as superuser to access this screen.

Prompts

Kill All Spooler Entries (Y/N)

Enter Y to delete all spooled print jobs. These jobs cannot be recovered. Enter N to retain all 
spooled print jobs.

Log Activity And Errors (Y/N)

Enter Y to setup spooler logging. The Enter Log Parameters subscreen is displayed. See the “Enter 
Log Parameters” on page 411. Enter N for no spooler logging.

Spool Directory

A spooler directory name. If nothing is entered, /usr/spool/uv is assumed. The pathname should be 
preceded with a \ character.

Enter ‘C’ to Confirm

Enter C to perform the spooler initialisation as defined in the previous prompts. Enter N to cancel, 
and exit the screen with no action taken.
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Enter Log Parameters

This subscreen is displayed if Y is entered at the Log Activity and Errors prompt in the Initialize 
Spooler screen. It allows error and/or activity logging of the spooler to be defined. You may select 
default error and activity logging and specify both or either separately.

Function Key

F2 - Save

Saves the log parameters.

Prompts

Use Default Activity And Error Logs (Y/N)

Enter Y to use default activity and error log files (in the spooler directory), and turn activity and 
error logging on. Enter N to specify logging individually.

Use Activity Log (Y/N)

Enter Y to turn activity logging on, using the log file specified in the next field. Enter N to skip 
activity logging.
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Activity Log Path

A valid Unix path to the activity log file you wish to use. The pathname should be preceded with a 
\ character.

Use Error Log (Y/N)

Enter Y to turn error logging on, using the log file specified in the next field. Enter N to skip error 
logging.

Error Log Path

A valid Unix path to the error log file you wish to use. The pathname should be preceded with a \ 
character.

If all options are set to N in this screen, the Log Activity And Errors field in the Initialize 
Spooler screen is set to N.
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Appendix D - Printer 
Management for 
UniData
Two versions of the SB+ Server Printer Manager are available for UniData: one for standard Uni-
Data printing, and one for sites with the UDT:Print package installed. In either case, some Printer 
Manager screens differ from the default Pick screens described in the Printer Management section 
of the manual. This appendix describes those Printer Manager screens which differ.

Note
You must have release 3.5d or later of USAM/UDT:Print (also known as SPrint) installed for cor-
rect operation under the SB+ Printer Manager. Earlier releases such as SCH:Print (also known as 
QPrint) are not guaranteed to work with SB+. The product will be referred to as UDT:Print in this 
appendix. This refers to all compatible versions under different names as described above.

Standard UniData printing uses the Unix spooler directly. Consequently, all maintenance and con-
trol of printers and spool jobs is performed using the Unix tools. 

Tool and SB+ Printer Management options that are not available are indicated in this appendix as 
� UDT:Print. Options that are available only in standard UniData are indicated as � Standard UniData.

As not all features of the SB+ Printer Manager are described in this appendix, the following is a 
list of Printer Manager menu options not available on standard UniData (they are all available with 
UDT:Print):

• Maintain Printers

• Maintain Spooled Reports

• Kill Current Job
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• Initialize Spooler

• Access UDT:Print
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Physical Printer Definition
Physical Printer Definition

Process /PHYSICAL.PRINTER

This screen is accessed from the Admin > Printers & Terminals > Printer Management menu.

The physical printer record describes the characteristics of the actual printer in use for a given sys-
tem port or device. It is defined in SB+ with a meaningful name, which SB+ uses to refer to the 
printer. The name specified is independent of any system specific number, name or device. The 
physical printer can be regarded as an entity independent of the current hardware it currently 
defines or the software that drives it.

The Physical Printer Definition screen allows you to define the physical printer entity, and spec-
ify the physical attributes relevant to the actual printer. These attributes are:

• Printer description, class and stationery type.

• Device type and form names.(UDT:Print).
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• Unix print device for each stationery type.

• Start and stop escape sequences. The start and stop escape sequences are usually used to 
set a printer to the emulation required for the associated printer class, and reset if required 
after the completion of a job.

Other parameters are maintained from subscreens:

• Location.

• Real time printer parameter defaults. (UDT:Print).

• Report types.

If you are associating a printer class with the physical printer record then stationery types associ-
ated with a printer class must have either form names, or Unix print devices associated with them.

This screen is not used to start or stop printers. The records created are definitions, which remain 
constant, irrespective of actual started printers, until changed by the Systems Administrator.

Note
Any user who has access to the Printer Management menu and/or processes may create and 
maintain a physical printer definition. Superuser permissions are not required.

Function Keys

F2 - Save

Saves the physical printer definition. If the physical printer edited is the current printer in the 
COMMON variable PRINT.DEFN, then PRINT.DEFN is automatically updated.

F4 - Del

Deletes the physical printer definition. If the definition is in use, deletion is prevented. The physi-
cal printer DEFAULT may not be deleted.
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Physical Printer Definition
F5 - Report Type

Displays the Report Type table. This table allows you to enter report types and optional stationery 
type to be used if a report with the appropriate report type is being printed using the current physi-
cal printer.

F6 - Defaults (UDT:Print)

Displays one of the Default Printer Characteristics subscreens. This is where defaults for realtime 
printer parameters may be entered. See F6-Default Printer Characteristics subscreens following.

F7 - Locations

Displays a subscreen that allows you to maintain the current physical printer's location.

Locations for all physical printers may be maintained in the Admin > Printers & Terminals > 
Printer Management > Maintain Locations screen.

F10 - Action

Displays the action bar:

Print Prints a detailed physical printer definition report. Output may be redirected.

Copy Copies physical printer definitions.

Help Displays a menu of help options.

Prompts

Printer Name

The name of an existing physical printer to edit, or a suitable name to define a new physical printer. 
The Printer Manager refers to all printers using names defined here.

Current Location

The physical location of this printer. (Display only).

Description

A meaningful description. Eg: Main System Printer (/dev/lp0)
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Device Type (UDT:Print)

The type of UDT:Print device to be defined. The types are as follows:

S Serial printer.

P Parallel printer.

T Terminal server program.

N Non-UDT:Print printer on a network node.

U UDT:Print printer on a network node.

For each different type, a different Printer Defaults subscreen is invoked using the F6 key. The 
device types are discussed in the Default Printer Characteristics subscreens section following.

Printer Class

The printer class is defined using the Printer Class Definition screen in the Admin > Printers & 
Terminals > Printer Management menu. The printer class contains control sequences relating to 
a class of printers. Associating a printer class with a physical printer means that the physical 
printer inherits the generic characteristics of the printer class, while it is associated with that partic-
ular printer class.

You may change the associated printer class at any time. This allows you to redefine a physical 
printer in terms of the actual printing hardware, but to retain the same identity.

Stationery Type

If this field is blank, the stationery types that were associated with the printer class specified at the 
Printer Class prompt are displayed. The field may then be edited. Stationery types not required 
for the current physical printer may be deleted. The F3 key is available if an accidental deletion 
occurs or the stationery type list needs to be expanded. Only stationery types defined for the printer 
class specified may be selected.

Form Name (UDT:Print)

You must assign a form name to the stationery type if you specify a stationery type. You may 
assign any form name any number of times.
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Physical Printer Definition
In general, you should assign a form name which is the same as the stationery type name, to pre-
vent confusion. The UDT:Print section in Volume Two of the Ardent USAM manual for further 
details of form usage.

The Printer Manager leaves form manipulation to the UDT:Print spooler as much as possible. Eg 
specifying a form name that is different from that used in the started printer (see Maintain Print-
ers), and printing using that stationery type produces a job that is held on the spooler, which may 
be manipulated as required.

Unix Printer (Standard UniData)

The name of a print device that has been created using the Unix print administration tools. Eg if a 
printer called HPLJII had been created, you would use that name. Do not use device pathnames, 
such as /dev/lp0, here. If a printer has been called lp0, and points to the device /dev/lp0, then you 
may use the name lp0.

Start Sequence

An escape sequence to be sent at the start of a print job. This is usually used to set a printer to the 
emulation mode required by the printer class associated with the physical printer entity for that 
printer.

This sequence is sent at the start of every print job, if defined.

Stop Sequence

An escape sequence to be sent at the end of a print job. This would usually be used to reset a 
printer to native or another emulation mode if required.

This sequence is sent at the end of every print job, if defined.

Default Printer Characteristics (UDT:Print) F6
The following describes the various Default Printer Characteristics subscreens, displayed using the 
F6 key from the Physical Printer Definition screen.

The subscreen displayed depends on the device type specified at the Device Type prompt in the 
physical printer definition for the printer on the current line:

S Serial printer.

P Parallel printer.
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T Terminal server program.

N Non UDT:Print printer on a network node.

U UDT:Print printer on a network node.

Default parameters may be entered for the current physical printer. These defaults are used in the 
Maintain Printers screen, and may be modified after a printer is started in similar subscreens 
available from that screen.

You do not modify the characteristics of a started printer from these subscreens. The default values 
only are modified.

Any user who has access to the Printer Manager may enter or modify these defaults; superuser per-
missions are not required.

The Default Printer Characteristics subscreens are as follows:

Serial Printer Characteristics (S)

This subscreen is displayed when you specify S at the Device Type prompt in the Physical Printer 
Definition screen, and press the F6 key.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Unix Device Name

The Unix device name for this printer. The input is validated so that parallel devices such as 
/dev/lp0 cannot be entered. The device name must be preceded with a \ character, if the name 
begins with a / character.

Port Setup Program

The name of a Unix program used to initialize the serial device entered at the Unix Device Name 
prompt, if that is required.

Filter Program

The name of a Unix program that will filter the output from the UDT:Print spooler. An example of 
this is a Postscript filter program.

Form Name

The default form name to be used at start up. It may be any of the form names defined for this 
physical printer. The default is the first form entered.

Row

The method of flow control for this printer.

Baud

The speed at which the computer is to communicate with the printer.

Parity

The type of error checking which will be used by the computer when communicating with the 
printer.
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WordLn

The number of bits which comprise one word of data for this printer.

Open Tmout

The length of time before the printer device is considered unopenable.

Off Tmout

The length of time before the printer device is considered to be offline.

Buffer Sz

The printer buffer size in bytes.

Parallel Printer Characteristics (P)

This screen is displayed when you specify P at the Device Type prompt in the Physical Printer 
Definition screen, and press the F6 key.

Function Key

F2 - Accept

Accepts the screen parameters.
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Physical Printer Definition
Prompts

Unix Device Name

The Unix device name for this printer. The input is validated so that serial devices such as /dev/tty0 
or /dev/tty1a cannot be entered. The device name must be preceded with a \ character, if the name 
begins with a / character.

Filter Program

The name of a Unix program that will filter the output from the UDT:Print spooler. An example of 
this is a Postscript filter program.

Form Name

The default form name to be used at start up. It may be any of the form names defined for this 
physical printer. The default is the first form entered.

Open Timeout

The length of time before the printer device is considered unopenable.

Offline Timeout

The length of time before the printer device is considered to be offline.

Buffer Size

The printer buffer size in bytes.
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Terminal Server Printer Characteristics (T)

This screen is displayed when you specify T at the Device Type prompt in the Physical Printer 
Definition screen, and press the F6 key.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Server Transfer Command

The full pathname of a Unix Terminal Server program that will print the current job to a printer 
attached to a terminal server on the Unix host.
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Physical Printer Definition
Remote UDT:Print Printer (U)

This screen is displayed when you specify U at the Device Type prompt in the Physical Printer 
Definition screen, and pressthe F6 key. It allows jobs to be printed to printers on a remote machine 
defined using UDT:Print on that machine.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Node Name

The name of the node or its Internet address (eg 192.0.0.10). If a name is entered, the name must 
exist in your local /etc/hosts file. The F3 key displays the /etc/hosts file.

Alias

An alias used for the node if specified.

Auto Start

Options are:

Y will invoke UDT:Print on the remote machine if it is not already started, and test for the 
requested printer's existence.
SB+ Server Administration Manual 425



 Appendix D - Printer Management for UniData 
N UDT:Print must be started on the remote machine before the test for the requested printer's 
existence can be carried out.

Network Printer Characteristics (N)

This screen is displayed when you specify N at the Device Type prompt in the Physical Printer 
Definition screen, and press the F6 key. It allows jobs to be printed to any printer on a remote 
machine defined using the Unix printer administration tools.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Node Name

The name of the node or its Internet address (eg 192.0.0.10). If a name is entered, the name must 
exist in your local /etc/hosts file. The F3 key displays the /etc/hosts file.

Local Remote Shell Command

The remote shell command that resides on your local machine. This is usually /bin/rsh or 
/bin/remsh.
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Remote Print Command

The command to print jobs to the spooler on the remote machine. This is usually lp or lpr. 

Remote User Id

The user id to be used to log onto the remote machine. The user id spooler is the default. 

Printer Class Definition

Process /PRINTER.CLASS
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The Printer Class Definition screen is accessed from the Admin > Printers & Terminals > 
Printer Management menu.

The printer class specifies the table of graphic, color and other miscellaneous escape sequences 
used by a family or class of printers. Additionally, the stationery types for this class are specified in 
this screen.

Eg you may define the printer class EPSON.CLASS to contain the sequences for the Epson family 
of dot matrix printers. You may associate this printer class with any physical printer whose current 
device is an Epson dot matrix printer (or any one of the many printers which have an emulation for 
this printer). You can switch the emulating printer to the Epson emulation by entering the switch-
ing sequence at the Start Sequence prompt in the Physical Printer Definition screen.

You may associate an unlimited number of stationery types with a printer class. For each stationery 
type, you may define margins, auto spooler formatting, inter job page advance, banner print state, 
Report Writer form feed behavior and stationery type-specific set, reset and page orientation 
sequences for printers requiring these sequences (such as laser printers).

The printer class, physical printer and stationery type definitions, are used to create the 
PRINT.DEFN COMMON variable, and associated runtime items in DMSECURITY. PRINT.DEFN is 
used in conjunction with the Printer Manager throughout SB+.

Function Keys

F2 - Save

Saves the printer class definition. If the printer class edited is the current printer class in the COM-
MON variable PRINT.DEFN, then PRINT.DEFN is automatically updated.

F4 - Del

Deletes the printer class definitions. If the definition is in use, deletion is prevented. The class 
DEFAULT.CLASS may not be deleted.

F5 - Color

The Printer Class Colors screen is displayed if the Color prompt is set to Y. This screen allows you 
define foreground and background colors for a color printer. At present, the Printer Manager does 
not support color printing; however, the table is stored in PRINT.DEFN, and may be referenced in 
reports or user subroutines.
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F8 - Stationery

Allows you to maintain stationery type definitions.

F9 - Seq+

The Additional Print Sequences screen allows you define additional escape sequences for physical 
printers and stationery types, in the same manner as the Additional Terminal Sequences in Termi-
nal Definitions. These sequences are not used by SB+, but are available for user subroutines. Phys-
ical printer sequences may be accessed in PRINT.DEFN<25,x>, and stationery type sequences in 
PRINT.DEFN<26,x>, where x is the position based on the order of entry in the subscreen.

F10 - Action

Displays the action bar:

Print Prints a detailed printer class definition report. Output may be redirected.

Copy Copies printer class definitions.

Help Displays a menu of help options.

Prompts

Printer Class

The name of an existing printer class to edit, or a suitable name to define a new printer class. 

Description

A meaningful description. Eg Epson LQ printers. 

Graphics Description

Displays the description of the character displayed in Graphics mode. (Display only).

Characters

Characters may be entered either as the printable character (where the character is printable) or as 
the decimal ASCII equivalent of the character, enclosed in parenthesis.
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Graphics Mode On

An escape sequence to switch graphics mode on the printer on. Check your printer's manual to 
ascertain the correct sequence. 

Graphics Mode Off

An escape sequence to switch graphics mode on the printer off. Check your printer's manual to 
ascertain the correct sequences.

Stationery Type

A stationery type from the defined stationery type list. A stationery type may be associated with as 
many printer classes as desired, but may be specified only once within the same printer class.

TM

The number of blank lines that will be printed at the top of a page before the text is printed. The 
default is 3. If no value is entered, this default is used.

BM

The number of blank lines that will be printed at the bottom of a page after the text is printed. The 
default is 3. If no value is entered, this default is used.

Fmt

Enter Y if you wish the printed output to be formatted automatically by the UniData spooler. Enter 
N if the application will control all formatting and pagination.

Ban

Enter Y if you wish a banner to be printed before each job. Enter N if not. If Y, you will be prompted 
for a banner name.

IJA

Enter Y if you wish to suppress the eject between each completed print job. Enter N if not.

FF

Enter Y if the Report Writer should send a form feed to advance to the next page of a job. Enter N if 
not.
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Set

An escape sequence to switch the printer to the stationery type setting. Check your printer's man-
ual to ascertain the correct sequence.

Reset

An escape sequence to reset the printer's stationery type setting. Check your printer's manual to 
ascertain the correct sequence.

Orient

An escape sequence to set the printer's page orientation mode. Check your printer's manual to 
ascertain the correct sequence.

Color

Enter Y at this prompt to allow color printer escape sequences to be defined.

Standard Columns

Where a printer class has no stationery type defined (which is a valid condition), the value entered 
at this prompt is used to set the page width for printing.

Rows

Where a printer class has no stationery type defined (which is a valid condition), the value entered 
at this prompt is used to set the page depth for printing.

Condensed Columns

The Report Writer will use this value for its condensed mode width instead of the automatic calcu-
lation, if a value is entered at this prompt.

This parameter is not otherwise used by SB+, but is available for user processes. The parameter is 
located in the COMMON variable PRINT.DEFN<5,4>.

Rows

This parameter is not used by SB+, but is available for user processes. The parameter is located in 
the COMMON variable PRINT.DEFN<5,5>.
SB+ Server Administration Manual 431



 Appendix D - Printer Management for UniData 
Printer Class Definition (follow on subscreen)

You may display this subscreen using the Page Down key from the main Printer Class Definition 
screen. Function keys are the same as the main screen, except that there is no F9-Seq+. 

Prompts

Print Attributes

The printer class. (Display only).
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Description

A description for the print attribute escape sequence. SB+ is shipped with predefined escape 
sequence descriptions, which the Printer Manager uses when printing Report Writer reports. You 
may enter new attribute descriptions and sequences, and refer to them in processes or subroutines. 
The on-sequences are stored value-delimited in attribute 3 and the off-sequences are stored value-
delimited in attribute 4 of the COMMON variable PRINT.DEFN.

On Sequence

An escape sequence to select the attribute for the printer. Check your printer's manual to ascertain 
the correct sequence.

Off Sequence

An escape sequence to deselect the attribute for the printer. Check your printer's manual to ascer-
tain the correct sequence.

Maintain Printers - UDT:Print

Process /LISTPTRS
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The Maintain Printers screen is accessed from either the Admin > Printers & Terminals > 
Printer Management menu or by pressing the F9 key in the Maintain Spooled Reports screen.

The Maintain Printers screen has been modified to accommodate the new Printer Manager. This 
screen was used to display currently started printers, and, if the user was superuser, to enable/dis-
able printings for the printer on the current cursor line.

The screen is now used to start and stop all printers, and allows parameters entered in the physical 
printer definition used to start the printer to be modified.

To start a printer
1. On the current cursor line, enter the physical printer name required. The current location will 

be displayed, if defined.

2. Modify the Unix path if required.

3. Enter a form name. The form name should be one of the names associated with a stationery 
type associated with the physical printer. You may enter any form name; however, a warning is 
displayed if the form name is not associated with the physical printer.

If you wish to modify the default printer characteristics for the current physical printer, move back 
to the line containing the required printer, and press the F7 key. The Modify Print Parameters sub-
screen allows you to modify these parameters. The screen displayed depends on the device type 
specified in the physical printer definition used to start the printer.

To stop a printer: move the cursor to the line containing the printer you wish to stop, and delete the 
line, using the line delete key.

You may enter as many printers to start, or remove as many printers as required. To start and/or 
stop printers, press the F2 key. When the changes are performed, the screen will be redisplayed, 
allowing you to check the result of your action.

You may only start and stop printers, or modify the parameters and the current form if you are 
logged on as superuser. Otherwise, you may view all printer information, but you cannot modify it.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.
434 SB+ Server Administration Manual



Physical Printer Definition
F5 - Start Printer

This function key attempts to restart a stopped printer. Attempting to restart from another state, 
such as error or offline, may or may not result in a printer being restarted.

F6 - Stop Printer

This function key attempts to stop a printer. Attempting to stop from other than the idle state, such 
as error, offline or printing, may or may not result in a printer being stopped.

F7 - Mod Pr Params

Displays a subscreen depending on the device type of the physical printer used to start the current 
printer. The defaults entered in the Physical Printer Definition > Default Printer Characteris-
tics subscreen may be amended here. See “Modify Print Parameters F7 (UDT:Print)” on page 436.

Only users who are logged on as a superuser may amend details in these subscreens. Other users 
may access this screen on a display only basis.

F9 - Pr Jobs

Displays the Maintain Spooled Reports screen.

Prompts

Printer Name

A physical printer name from the set of defined physical printers.

Location

The location for the physical printer entered if it has been defined. (Display only).

Path/Type

This corresponds to the Unix Device Name field in the physical printer record. The default from 
the physical printer record will be displayed, and may be amended if required. The path must be a 
valid path to a Unix device. The device name must be preceded with a \ character, if the name 
begins with a / character.
SB+ Server Administration Manual 435



 Appendix D - Printer Management for UniData 
Form

A form name to start the printer with. This may be any form name, but should be one of the form 
names associated with the stationery types entered in the physical printer definition. You will be 
warned if the entered form name is not one of these. The F3 key provides a list from the physical 
printer definition. The default is the value entered in either the Serial Printer Characteristics or 
the Parallel Printer Characteristics subscreens in the Physical Printer Definition screen, or the 
form entered for the first stationery in the physical printer definition for other device types. For 
printers already started, the current form name will be shown.

This field may be amended by any user, but will only have effect if the user is logged in as supe-
ruser.

Status

The current status of a printer in the UDT:Print system. The initial status is Unknown. Other sta-
tuses are Halted, Idle, Offline, Printing and Error. (Display only).

Modify Print Parameters F7 (UDT:Print)
The various Modify Printer Parameters subscreens are displayed by pressing the F7 key from the 
Maintain Printers screen. 

The subscreen displayed depends on the device type specified at the Device Type prompt in the 
physical printer definition for the printer on the current line:

S Serial printer.

P Parallel printer.

T Terminal server program.

N Non-UDT:Print printer on a network node.

U UDT:Print printer on a network node.

These subscreens allow the default characteristics defined for the printer in the physical printer 
definition to be modified as required. These parameters may be changed at any time as required.

You must be logged in as superuser to be able to change any of these parameters.

The Modify Print Parameters subscreens are as follows:
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Serial Printer Characteristics (S)

This screen is displayed when you specify S followed by pressing the F7 key at the Device Type 
prompt in the Maintain Printers screen.

Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Port Setup Command

The name of a Unix program used to initialize the serial device entered at the Unix Device Name 
prompt, if required.

Filter Program

The name of a Unix program that will filter the output from the UDT:Print spooler. An example of 
this is a Postscript filter program.

Flow

Choose the method of flow control for this printer.
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Baud Rate

The speed at which the system communicates with the printer.

Parity

The type of error checking which will be used by the system when communicating with the printer.

Word Lgth

The number of bits which comprise one word of data for this printer.

Open Timeout

The length of time before the printer device is considered not available.

Off Timeout

The length of time before the printer device is considered to be offline.

Buffer Size

The printer buffer size in bytes.

Parallel Printer Characteristics (P)

This screen is displayed when you specify P followed by pressing the F7 key at the Device Type 
prompt in the Maintain Printers screen.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Filter Program

The name of a Unix program that will filter the output from the UDT:Print spooler. An example of 
this is a Postscript filter program.

Open Timeout

The length of time before the printer device is considered not available.

Offline Timeout

The length of time before the printer device is considered to be offline.

Buffer Size

The printer buffer size in bytes.

Terminal Server Printer Characteristics (T)

This screen is displayed when you specify T followed by pressing the F7 key at the Device Type 
prompt in the Maintain Printers screen.
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Function Key

F2 - Accept

Accepts the screen parameters.

Prompts

Server Transfer Command

The full pathname of a Unix Terminal Server program that will print the current job to a printer 
attached to a Terminal Server on the Unix host.

Remote UDT:Print Printer (U)

This screen is displayed when you specify U followed by pressing the F7 key at the Device Type 
prompt in the Maintain Printers screen.

This allows jobs to be printed to printers on a remote machine defined using UDT:Print on that 
machine.

Function Keys

F2 - Accept

Accepts the screen parameters.
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Prompts

Node Name

The name of the node or its Internet address (eg 192.0.0.10). If a name is entered, the name must 
exist in your local /etc/hosts file. The F3 key displays the /etc/hosts file.

Alias

An alias used for the node if specified.

Auto Start

Options are:

Y will invoke UDT:Print on the remote machine if it is not already started, and test for the 
requested printer's existence.

N UDT:Print must be started on the remote machine before the test for the requested printer's 
existence can be carried out.

Network Printer Characteristics

This screen is displayed when you specify N followed by pressing the F7 key at the Device Type 
prompt in the Maintain Printers screen.

This allows jobs to be printed to any printer on a remote machine defined using the Unix printer 
administration tools.
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Function Keys

F2 - Accept

Accepts the screen parameters.

Prompts

Node Name

The name of the node or its Internet address (eg 192.0.0.10). If a name is entered, the name must 
exist in your local /etc/hosts file. The F3 key displays the /etc/hosts file.

Local Remote Shell Command

The remote shell command that resides on your local machine. This is usually /bin/rsh or 
/bin/remsh.

Remote Print Command

The command to print jobs to the spooler on the remote machine. This is usually lp or lpr.

Remote User Id

The user id to be used to log onto the remote machine. User id spooler is the default.
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Maintain Spooled Reports

Process /LISTJOBS

The Maintain Spooled Reports screen is accessed from the Admin > Printers & Terminals > 
Printer Management menu. It allows you to view/maintain print jobs currently held in the spool 
queue. There are facilities to delete spooled entries or to alter the printing parameters such as the 
number of copies and whether the report is to be held in the spooler even after it has been printed.

Function Keys

F2 - Accept

Accepts the screen parameters and performs any changes made to the screen.
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F5 - View Job

Displays the current job on the terminal (the line being edited).

F9 - Printers

Invokes the Maintain Printers screen.

Prompts

Job

The entry number of the print job in the spooler.

User

The Unix user id who created this print job. (Display only).

Description

UniData file name for this print job. (Display only).

Printer

The name of the printer to which the print job is being sent.

Form

The form to which the print job is assigned.

Co

The number of copies specified for this print job.

St

The status of the print job. For instance, H for Hold etc. See your OE manual.

Size

The size of the print job in bytes. (Display only).
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%

Percentage of print job actually printed, if job is printing now. (Display only).

Act Fm

Active form name. (Display only). 

Options are:

Y if the form for this print job matches the active form on the printer.

N if the form for this print job does not match the active form on the printer.
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Index
A
Access File Other Account, 128
Account, 88, 191
Account Name, 146, 149, 152, 298, 301
Account Name on Backup, 231
Account Name(s) (* = All), 156
Account Names, 58, 59
Account Restrictions, 87
Account to do (*=All), 141
Account to Log Into, 287
Account(s) to Delete, 303
Account(s) to Resize (*=All), 145
Accounts, 297
Accounts With No Restrictions, 85
Accounts With Restrictions, 86
Act Fm, 445
Action, 278
Action Bar Display Line, 251
Action Bar Highlight Effect Number, 251
Action Bar Option Spacing Method, 251
Active Form, 409
Activity, 318
Activity Default Flag (P_E), 332
Activity Default Priority, 334

Activity Key, 319
Activity Log Path, 412
Activity Repeat Definition, 322
Add Scrollbars to Multivalued Fields, 246
Additional System Defaults, 242
Additional Terminal Sequences, 216
Additional_Alternative Keys, 212
Admin, 23
Afternoon Appointment Char, 333
Alert Recipient(s) Immediately (Y_N), 316
Alias, 425, 441
Align Printer’s Top of Form Position, 177
Allow_Disallow, 88, 89
Alternative Delete Character, 250
Alternative Id Code, 95
Alternative Name(s), 328
American/International, 16
American_Internat'nl, 238
ANSI Mode (Y_N), 207
Appointment or To Do, 310
Appointment_ToDo_Msg, 320
Assign Options, 263
Assign Printer to a Report, 179
at, 320
Attach Media Device, 226
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Auto Extend Field Length, 98
Auto Help Display, 98
Auto Start, 425, 441
Aux Defaults, 83, 95
Aux Printer Name, 222
Aux Prt Name, 221
Average Size, 147, 149, 153

B
Background, 204
Backspace Character, 285
Backup Account(s), 58
Backup All Accounts, 60
Backup Command, 226
Backup Unix File(s), 62
Ban, 396, 430
Baud, 221, 390, 404, 421
Baud Rate, 289, 438
Baud Rate to Set, 288
Block Size, 55, 56, 56, 225
Block Size (Null=default), 227
BM, 396, 430
Buffer Size, 423, 438, 439
Buffer Sz, 422
Button Delimiter Character, 210
Button Field_Pos,Len, 210
ButtonBar Field_Pos,Len, 211

C
Calculator, 330
Call Help Character, 250
Call Process Character, 249
Can use _OH on Tool Processes, 266
Can use _OH or _MP, 266

Categories, 321
Categories & Projects, 327
Category or Project ID, 327
Category or Project Type, 328
CHANGE.PRINTER, 368
Characters, 170, 198, 395, 429
City, 335
Clear File, 119
Clear Redundant History, 157
Clear Screen & Home, 208
Clear Screen to Pattern, 208
Clear To End Of Line, 208
Clear To End Of Page, 208
Co, 190, 409, 444
Code, 248
Col and Row Separator, 207
Col Base Offset, 207
Col Increments in BCD, 207
Coldstart, 164
Color, 171, 397, 431
Color Or Monochrome (C_M), 274
Colors, 204
Column First, 207
Command Stack Per Account, 100
Company Name, 326
Company/User Name, 16
Compare Records, 138
Compared File Name, 138
Computer Serial #, 17
Condensed Columns, 171, 197, 397, 431
Condensed Rows, 172, 197
Contact, 16
Contact Company, 321
Contact ID, 325
Contact Names, 326
Contact Title, 326
Contacts, 324
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Continue with backup (Y/N), 59
conventions, 10
Copy Records, 118
Correct Device (Y/N), 56, 57
Count Records In File, 136
CR Cnv, 390, 405
Create An Account, 298
Create File, 120
Create Form Name in sp.config, 392
CUA Arrow Movement, 237
Current Location, 163, 386, 417
Cursor Definition Parameters, 206

D
Data Level Modulo, 123
Data Level Separation, 123
Data Level Type, 123
Data/Dict (0/1), 227, 228, 231
Data_Dict (0_1), 117
Data_Dict_Both (0_1_2), 121
Date, 191, 310
Date and Time Setup, 291
Day, 336
DDE Timeout, 244
Dealer Name, 17
Decimal ASCII Val, 202, 213
Decimal Value For  Key, 249
Decimal Value For  Key, 249
Default Date Conversion, 240
Default List (A_T_MA_MT), 333
Default Money Conversion, 240
Default Printer Characteristics, 389, 419
Default Terminal/Printer Specification, 221
Default Tolerance before resizing %, 155
default user account main menu, 23
Default Window Frame Type, 251

Default Window Style Code, 252
Define Media Device, 224
Deflt Menu, 204
Deflt Screen, 204
Delete An Account, 303
Delete File, 126
Delete Record, 127
Dependent On, 278
Description, 122, 197, 200, 217, 249
Description (graphics), 395
Detach Media, 67, 223
Detach Unconditionally (Y/N), 67
Detailed System Usage, 295
Determine File Sizes, 140
Device Description, 55, 56
Device Name, 55, 224
Device Number, 56, 224
Device Type, 225, 418
Device_Port No., 164
Dialog Box, 205
Diary, 307
Diary Access Code, 86, 97
Diary Configuration, 332
Diary Private Flag (P_E), 333
Dictionary Level Modulo, 123
Dictionary Level Separation, 123
Dictionary Level Type, 122
DIR Type, 125
Directory, 62
Diskette Drive (A/B), 54, 68
Disp Print Sel Screen, 182
Display Aux Select Screen, 101
Display Defaults, 250
Display Files (S/P/N), 303
Display Print Select Screen, 100
Display System Date & Time, 291
Display Where Table, 294
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Download Character Sequence, 214
Download Recovery Time (Seconds), 214
Download Sequence, 215
Driver Path, 387, 404
Durn, 311
Dynamic, 125

E
Edit Function, 202
Edit Key Delay, 237
Edit Key Function, 213
Eject, 164
Enable Multi-Language Support, 241
Ent, 190
Enter 'C' to Confirm, 192, 410
Enter Log Parameters, 411
Enter Start Time Of Save (00

00=Now), 60
Entry, 409
Environment Defaults, 391
Error B_F, 205
Error Line, 236
Error Log Path, 412
Error Text in Dialog Box, 98
Execute DownLoad when Switching Accounts, 214
Extended Error Reporting, 257

F
F, 337
Fax, 326
FF, 390, 396, 405, 430
FF Pg, 176
Field Descrip LC, 237
Field Template File, 241

Fields to Print, 133
File Creation Umask, 238
File Data Name, 146, 149, 153
File Dict Name, 146, 149, 152
File Name In Other Account, 129
File Name on Backup, 231
File Name To Edit, 116
File Name to Restore to, 230
File Size Reports, 142
Filename, 278, 280, 281
Files, 115, 273, 344
Filter Program, 421, 423, 437, 439
Fine Tune A File Resizing, 151
First Name, 96
Flow, 389, 404, 421, 437
Fmt, 396, 430
Footing, 133
for, 320
Foreground, 204
Form, 436, 444
Form Defns to Store, 244
Form Feeds At End, 183
Form Feeds At Start, 182
Form Name, 403, 409, 418, 421, 423
Form Names, 387
Form Queue, 164
Form Queue(s), 176
Format Diskette, 68, 223
FormQue, 190
Frame Size, 64, 238
Frames, 190
From, 91
From Day, 91
Full Account Path, 299
Full Refresh Of Screen, 99
Full Text, 316, 321
Full/Incrmntl/Trans Log (F/I/T), 232
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Functkey B_F, 205

G
Global Defn, 243
Global Dict Name, 241
Global Files, 261
Global Help, 243
Global Menu, 243
Global Print Mngr Proc, 264
Global Printer Defaults, 262
Global Prnt Redir Off, 265
Global Prnt Redir On, 264
Global Process, 243
Global Verbs, 261
Graphics Description, 170, 429
Graphics Mode Off, 170, 197, 396, 430
Graphics Mode On, 170, 197, 395, 430
Group Description, 83
Group Id Code, 83
Group Parent Code, 83
Group Printers, 407
Group Security Setup, 78
Growth %, 147, 149, 153
Growth % over period of days is %, 147, 149, 153
GUI CEO Defaults, 246
GUI Dialog Defaults, 246
GUI Error Defaults, 246
GUI Help Defaults, 246
GUI Lookup Defaults, 246
GUI Menu Defaults, 246
GUI Mode Enabled, 196, 245
GUI Prompt Defaults, 246
GUI Screen Defaults, 245

H
Hardware Manufacturer, 16
Hash Type, 125
Heading, 133
Help Colors, 205
Help Line, 236
HELP_STRING, 254
Hidden Attributes, 200
History Account Name (* = All Old), 157

I
Ignore Initial Form Feed On Serial Printer, 178
Ignore Tape Label (Y/N), 64
IJA, 396, 430
Include Form Name in SETPTR, 392
Include Printer Name in SETPTR, 391
Inhibit Break Key (Y_N), 84
Inhibit Logons, 109
Inhibit Shell Access (Y_R_N), 84
Inhibit Supervisor (Y_N), 84
Inhibit_Process Calls (A_C_N), 84
Initial Sys id, 302
Initialize Spooler, 191
Initialize Users Password, 104
Install At Power On (Y_N), 274
Install PC Monitor Type, 273
Item, 278
Item Names(s) (* all), 231

J
Job, 444
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K
Key Description, 202, 213
Keyboard Size (101_84), 274
Keyboard Timeout, 98
Keyboard Timeout Limit (Mins), 85
keys

clear field } Clears a field (makes it null). You 
may also use the D key repeatedly, or the clear-to-
end-of-line key (defined for your terminal). 
( must be the first character entered into the 
field.)/Allows you to call a process (if permitted 
by y, 50
escape, 29
up and down arrows, 29

Kill All Print Jobs Unconditionally, 70, 72, 74
Kill All Spooler Entries (Y_N), 192, 410
Kill Current Job, 191

L
L, 338
Language File, 249
Language Table, 248
Last Maintained, 86
Last Posted By, 261
Last Posted On, 261
Last Valid Suggestions, 141
Leadin Sequence, 207
LF, 390, 405
LFK, 254
licence, amending, 20
Limit Value of Displayable Characters, 213
Line Edit a File, 117
List Accounts, 297
List All File Names, 133
List Available Disk Space, 293

List Dictionary, 135
List Entire Record, 134
List Files Saved to Screen or Printer (S/P), 61
List Overflow Fragmentation, 296
List Port Setups, 290
List Records In File, 132
List Users Logged On, 105, 285
List View

select list style, 254
Lne, 191
Lnk, 190
Load File From Media, 228
Load Function Keys, 254
Load the Patch, 278
Local City Name, 335
Local Remote Shell Command, 426, 442
Location, 176, 186, 402, 435
Lock File Path(s) 1 & 2, 388, 404
Log Activity And Errors (Y_N), 410
Log All Users OFF Unconditionally, 70, 72, 74
Log Off At Completion Of File Save (Y/N), 60
logging on

for the first time, 14
Log-Off a Port, 286
Log-On a Port, 287
Logon Inhibited Text Message for users, 110
Logon Times, 90
Logon/Logto Subroutine, 254
Logto, 24, 342
Logto Account (or OFF), 342
Logto DOS, 73
Lookup B_F, 205

M
M, 310, 311, 313
Macro Leadin Character, 97
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Macro String, 103
Main Heading Justification, 99
Maintain Global Tuning, 155
Maintain Locations, 185
Maintain Printer Groups, 406
Maintain Printers, 175, 400, 433
Maintain Repeat Flags, 337
Maintain Report Types, 187
Maintain Resizing Parameters, 145
Maintain Spooled Reports, 189, 408, 443
Maintain Stationery Types, 183
Manually Resize A File, 145
Max Levels Warning, 237
Max Unix Filename Len, 238
Media Commands, 223, 344
Media Density, 17
Media Type, 17
Media/File, 280, 281
Member Users, 407
menu, 28
Menus, 88
Message ID, 315
Message_RE, 316
Minimum Modulo to Accept is, 154
Minutes To Warn Users Logged On, 69, 71, 74
Model Number, 17
Modify Print Parameters, 403, 436
Modulo, 125, 299, 301
Modulo Of Data, 122
Modulo Of Dict, 121
Month, 336
Morning & Afternoon Char, 333
Morning Appointment Char, 333
Mouse Double Click Interval, 252
Msg Id, 313

N
Name, 176, 321
Name for Display, 328
Name For This Account, 129
Name(s) On Backup, 64, 65
Names(s) To Restore As, 64, 65
navagation, 28
Navigation Method, 247
Network Printer Characteristics, 426, 441
New Name, 271
New Password, 104
New Size (Modulo), 147
New Size (Modulo) - Pick, 153
No of Copies, 182, 263
No of Items, 147, 149, 153
Node Name, 425, 426, 441, 442
Non Inhibit Ports, 110
Norewind Path, 225
Notes, 326
Number Of Blank Lines At Bottom Of Screen, 285
Number Of Delay Characters After Top-Of-Form, 
285
Number Of Delay Characters Output After Line-
feed, 285

O
Obj/Source, 277
OE Release, 17
OE Reset Commands, 268
OE Setup Commands, 267
OE Term Type, 196
OE Transaction Parameters, 255
OE Type, 277
OFF, 27
OFF Sequence, 200
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Off Sequence, 174, 399, 433
Off Timeout, 438
Off Tmout, 422
Office, 24
Offline Command, 226
Offline Timeout, 423, 439
Offset G.M.T., 335
OFS, 258
OH Process Scope Control, 265
On, 320
ON Sequence, 200
On Sequence, 174, 399, 433
Open Timeout, 423, 438, 439
Open Tmout, 422
Operating Environment, 17, 238
Operation Mode, 57, 225
Option Letters, 89
Options, 130

Overwrite, Delete (O, D), 119
Options (I,S,F), 135
Orient, 397, 431
Orientation, 171
Original Frame Size, 64, 229
Other Language (Y_N), 236
Other Opts, 391, 405
Output to (S_P_X_L), 139
Overwrite And Regenerate Checksums (Y_N), 294
Overwrite Existing (Y_N), 229
Overwrite Existing Items (Y/N), 231
Owner, 309, 319, 325, 328

P
P, 310
Page Length as Number of Lines, 178
Parallel Printer Characteristics, 422, 438
Parameters, 278

Parity, 390, 404, 421, 438
Parity (N_E_O), 289
Password, 97
Password (if any), 287, 288
Password Rollover Expression, 90
Patch, 281
Patch Definition Enquiry, 276
Patch No, 277
Path_Type, 435
PathName, 238
Percentage (%), 445
Perform File Resizing, 144
Perform House Keeping, 156
Phone, 326
Phys. Printer Name, 181
Physical Printer Definition, 160
Physical Printer Definition (UniData), 415
Physical Printer Definition (uniVerse), 384
Physical Printer Name, 263
Physical Printers, 186
Pointer Device Code, 210
Pointer Device Parameters, 209
Pointer Sequence Length, 210
Port, 177, 220
Port Configure, 218
Port Number To Set, 289
Port Setup, 283
Port Setup Command, 437
Port Setup Program, 421
Port To Log-Off, 286
Port To Log-On, 287
Port to Set Baud On, 288
Post/Zip Code, 16
Postal Address, 16
Posted Defns, 261
Posted Menus, 261
Posted Processes, 261
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Power Down System, 69
Present Modulo, 147, 150, 154
Present Separation, 150, 154
Present Type, 150, 154
Print, 390, 404
Print Attributes, 174, 399, 432
Print Class Definition (follow on screen), 173
Print Output Via Spooler (Y/N), 295
Printer, 444
printer

assignment, 356
definition and maintenance, 354
determining print defaults, 355
physical printer definition, 147
selection, 359
setting defaults, 361
setup guidelines, 368
starting & stopping, 357

Printer Class, 163, 170, 387, 395, 418, 429
Printer Class Definition, 165, 393, 427
Printer Class Definition (follow on subscreen), 398, 
432
Printer Group, 406
Printer Line Width, 285
Printer Lines Depth, 285
Printer Management, 159
Printer Manager

calls in user subroutines and processes, 362
hook for third party printer management, 365
new features, 358
other features, 365
scope and availability, 357
user interaction, 358
user print redirection prompt, 365

Printer Name, 163, 220, 222, 402
Printer No., 176
Printer Path, 402

Printer Support Form Feed Character (Y/N), 177
Printer Type, 177
Printers & Terminals, 159, 344
Prio, 313
Priority, 316, 320
Priv, 325
Private, 321, 328
Private Message (P_E), 316
Privilege Level, 299, 302
Proc At OE Return, 240
Proc At Set Common, 240
Proc Before '/proc', 243
Proc Before CHAINing, 240
Process After Tool Read, 243
Process Name, 181
Product Description, 17
Projects, 321
Prompt B_F, 205
Prompt Line, 236
Ptr, 191
Purge All Read Messages, 317
Purge Messages, 317
Purge Resize History, 157
Purge To and Including Date, 318
Pwd Rollover Date, 97

Q
QFiles, 273
Queue, 390, 404

R
Read, 316
Read Tape_Diskette, 223
Real Account Name, 299, 301
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Reboot System, 71
Receive Message, 311
Recipient(s), 316
Recommended Modulo, 150, 154
Recommended Separation, 150, 154
Recommended Type, 150, 154
Record Id(s) (* all), 134
Record Name(s), 138, 139
Record Name(s) (* all), 117, 127
Record Name(s) (null same), 119
Record Name(s) Or Criteria, 228, 229
Record(s) to Copy (* all), 119
Record(s) To Edit, 116
Reference File Name, 138
Remote Print Command, 427, 442
Remote UDT

Print Printer, 425, 440
Remote User Id, 427, 442
Remove Resize Suggestions, 156
Repeat Expression, 322
Repetition Type Flag, 322
Replace Original With, 270, 271
Replace String, 131
Reply, 316
Report Type, 182, 188
report types, 366

assigning to a physical printer, 367
associating with reports, 367

Reports & Enquiries, 329
Repository, 258
Reset, 171, 397, 431
Resize File Immediately (Y_N), 150
Resize File Immediately, Rather Than On Next 
Resto, 147
Resize Files, 139
Resize Growth Period Days, 155
Resize History Shows Average Growth Is %, 147, 

149
Resize History Shows Average Growth is %, 153
Restore Account(s), 63
Restore Command, 226
Restrict Shell Verbs (Y_N), 84
Retension, 55
Reuse Details, 258
Reversible, 277
Rewind Command, 226
Rewind Media, 223
Rewind Media First (Y/N), 64
Rewind Path, 225
Row Base Offset, 207
Row Increments in BCD, 208
Rows, 397, 397, 431, 431
Runtime, 23

S
S, 310, 311
SB (user id), 14
SB+ Account (Y_N_S), 299, 301
SB+ Configuration Options, 259
SB+ Control Parameters, 234
SB+ Patching System, 275
SB+ Release, 277
SB+ Release Info, 282
SB+ Runtime Code, 16
SB+ Serial Number, 16
SB+ Server Name, 258
SB+ Setup, 233, 344
SB+ Unix Group, 238
Scheduled Activity, 311
screen, 28

navagation keys, 29
Screen Accept Prompt, 236
Screen Edit a File, 116
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Screen_Printer (S_P), 133, 135
Search and Replace, 129
Search String, 131
Security, 347
Security Reports, 106
Select Media, 54
Select Media Device, 223
Selection, 130
Selection Criteria, 133, 136, 137, 229
Selective Restore, 230
Self-Contained Forms, 247
Send Message, 314
Send Stat-File Report To Printer (Y/N), 61
Sender, 313, 315
Sent, 314
Sent Date, 317
Sent Time, 317
Sep, 125
Sequence, 217
Serial Printer Characteristics, 437
Server Transfer Command, 424, 440
Set, 170, 397, 431
Set American Date Format, 292
Set Baud Rate of a Port, 288
Set International Date Format, 292
Set Port Comms Details, 289
Set System Date, 292
Set System Time, 291
Sh, 178
Shell, 24, 340

stack commands, 340
Short Name, 96
Since Date, 147, 150, 153
Size, 409, 444
Skip File Command, 226
Skip Label Search (Y/N), 232
Sort & Alt, 326

Sort Fields, 132
Source File Name, 118
Spool Directory, 410
Spooler Options, 182
SQLator DLL Path, 258
SQLator Enabled, 257
SQLator Parameters, 256
SQLator Servers, 256, 257
St, 444
Standard Columns, 171, 184, 197, 397, 431
Standard Rows, 171, 184, 197
Standard/High Density (S/H), 68
Start Account, 96
Start Options, 177
Start Sequence, 164, 388, 419
Start Sys, Menu, Opt, 97
Statements To Be Executed, 267, 268
Stationery Type, 163, 182, 184
Stationery Types, 387
Statrionery Type, 170
Status, 96, 178, 190, 320, 409, 436
Std Back_Fore, 205
Std Text, 335
Std/High Diskette/Tape (S/H/T), 54
Stop Bits (1_2), 290
Stop Sequence, 164, 388, 419
Sub Patch, 277, 281
Subroutine Name, 255
Sum A Field, 137
Sum Field Name, 137
Summary_RE, 313, 313, 320
Supp FF, 171
Support Color (Y_N), 196
Suppress Beep On Error, 100
Suppress Confirm On Screen Esc, 99
Suppress ID Listing (Y_N), 229
Suppress Lock Status (Y/N), 296
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Suppress Logon Message Delay, 100
Suppress Spooler Status (Y/N), 296
Suppress Where Status (Y/N), 295
Surname, 96
Sw, 102
Sys Id Menu Description, 302
System Default Term Def., 290
System Defaults, 239
System Enquiries, 345
System House Keeping, 283
System Id, 88, 300
System Keys, 249
System Menu Description, 300

T
T/P, 220
Tabs, 390, 405
Tape at Correct Point (Y/N), 231
Tape Label, 61
Target File Name, 119
TCL, 27
T-Dump Stat-File To End Of Tape (Y/N), 61
Telephone, 321, 326
Telephone Number, 16
Terminal Colors, 203
Terminal Definitions (screen 1), 193
Terminal Definitions (screen 2), 199
Terminal Definitions (screen 3), 201
Terminal Id, 196, 200, 202, 220, 222
Terminal Line Width in Horizontal Print Positions, 
284
Terminal Lines Depth, 284
Terminal Server Printer Characteristics, 424, 439
Terminating Sequence, 207
Term-Type Code For Terminal Code Definitions, 
285

Time, 191, 310
Time Text, 336
Time Zone Maintenance, 334
TM, 396, 430
TNS Name, 258
To, 91
To Day, 336
To Do List, 310
To Month, 336
Tolerance % Before Resizing is %, 154
Toolbar

adjust form size, 254
flat style buttons, 254

Tools, 23
Totals Only (Y_N), 133
T-VERIFY, for backup media verification, 364
Type (0_1_2), 124

U
Unconditionally (Y_N), 286
Unix Delimiter, 238
Unix Device, 387
Unix Device Name, 421, 423
Unix Name, 238
Unix Printer, 419
Unix User, 409
Unload the Patch, 280
Update An Account, 300
Update Processes, 115
Upgrade (Y/N), 17
Upgrade SB+ MD from SYSPROG, 272
Upto Day, 91
Use Activity Log (Y_N), 411
Use Default Activity And Error Logs (Y_N), 411
Use Error Log (Y_N), 412
Use Existing System File Stats (Y_N_Q), 141
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Use Grids for Multivalued Fields, 247
Use History Growth Factor (Y_N), 141
Use Tabfolders in GUI Screens, 246
User, 444
User Id, 104, 287
User Id Code, 95
User Name, 221
User Security Setup, 92
Users, 17
Users Group Code, 96
Util %, 147, 149, 153

V
Verbs 3, 273
Verify Backup OK, 66
Verify Backup With Dummy SEL_RESTORE, 58
Verify Save With Dummy SEL-RESTORE, 61
Verify System Object, 294
View File Data, 131

W
w.r.t Local, 335
Warning Message, 69, 71, 74
Windows NT Device, 226
Word Length (7_8), 290
Word Lgth, 438
WordLn, 422
Wrapping LOGTO Verb, 270
Wrapping OFF Verb, 269
Wrdln, 390, 405
Write File To Media, 227

X
X Conversion Code Method, 211
X value Field_Pos,Len, 210
X,Y Delimiter Character, 210

Y
Y Conversion Code Method, 211
Y value Field_Pos,Len, 210
Your Terminal Settings (OE), 284
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